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features of your new laser printer
Your new printer is equipped with a number of special features that improve the quality of the documents you print.
With the printer, you can:

Print with excellent quality and speed
• You can print in a full range of colors using cyan, magenta, 

yellow, and black.
• You can print with a resolution of up to 2400 x 600 dpi. See 

Software section.
• Your printer prints A4-sized paper at up to 20 ppm and 

letter-sized paper at up to 21 ppm.

Handle many different types of printable material
• The multi-purpose tray supports letterhead, envelopes, 

labels, custom-sized media, postcards, and heavy paper. 
The multi-purpose tray holds up to 100 sheets of plain 
paper.

• The 250-sheet tray 1 and 500-sheet optional tray support 
plain paper in various sizes. 

Create professional documents
• Print Watermarks. You can customize your documents with 

words, such as “Confidential”. See Software section.
• Print Posters. The text and pictures of each page of your 

document are magnified and printed across the sheet of 
paper and can then be taped together to form a poster. See 
Software section.

• You can use preprinted forms and letterhead with plain 
paper. See Software section.

Save time and money
• To save paper, you can print multiple pages on one single 

sheet of paper.
• This printer automatically conserves electricity by 

substantially reducing power consumption when not in use.
• To save paper, you can print on both sides of the paper 

(double-sided printing). See Software section.

Expand your printer’s capacity
• Your printer has an extra memory slot to expand their 

memory (see "Accessories" on page 83).
• Zoran IPS Emulation* compatible with PostScript 3 (PS) 

enables PS printing. 
.

* Zoran IPS Emulation compatible with PostScript 3
© Copyright 1995-2005, Zoran Corporation. All rights reserved. 
Zoran, the Zoran logo, IPS/PS3, and OneImage are 
trademarks of Zoran Corporation.
* 136 PS3 fonts
Contains UFST and MicroType from Monotype Imaging Inc.

Print in various environments
• You can print with Windows 2000 and Windows XP/2003/

2008/Vista as well as Linux and Macintosh systems.
• Your printer is equipped with a USB interface and a 

network interface.

Copy originals in several formats
• Your printer can print multiple image copies from the 

original document on a single page.
• There are special functions to erase catalog and 

newspaper background.
• The print quality and image size may be adjusted and 

enhanced at the same time.

Scan the originals and send it right away
• Scan in color and use the precise compressions of JPEG, 

TIFF and PDF formats.
• Quickly scan and send files to multiple destinations using 

Networks scanning.

Set a specific time to transmit a Fax
• You can specify a certain time to transmit the fax and also 

send the fax to several stored destinations. 
• After the transmission, the printer may print out the fax 

reports according to the setting.

SPECIAL FEATURES
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FEATURES BY MODEL
The printer is designed to support all of your document needs – from printing and copying, to more advanced networking solutions for your business.
Basic features of this printer include:

( : Included, O: Optional) 

ABOUT THIS USER’S GUIDE
This user’s guide provides information about basic understanding of the printer as well as detailed explanation on each step during the actual usage. Both novice 
users and professional users can refer to this guide for installing and using the printer.
Some terms in this guide are used interchangeably, as below:
• Document is synonymous with original.
• Paper is synonymous with media, or print media.
Following table offers the conventions of this guide:

FEATURES Dell 2145cn
USB 2.0

USB Memory Interface

Duplex Automatic Document Feeder (DADF)

Hard Disk (optional) O

Network Interface Enthernet 10/100 Base TX wired LAN

Duplex (2-sided) printing

FAX

CONVENTION DESCRIPTION EXAMPLE

Bold Used for texts on the display or actual prints on the printer. Start

Note Used to provide additional information or detailed specification of the printer 
function and feature.

The date format may differ from 
country to country

Caution Used to give users information to protect the printer from possible mechanical 
damage or malfunction.

Do not touch the green underside of 
the toner cartridge.

Footnote Used to provide more detailed information on certain words or a phrase. a. pages per minute

(See page 1 for more 
information)

Used to guide users to the reference page for the additional detailed information. (See page 1 for more information)
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FINDING MORE INFORMATION
You can find information for setting up and using your printer from the following resources, either as a print-out or onscreen.

Quick Install Guide Provides information on setting up your printer and this requires that you follow the instructions in the guide to prepare the printer.

Online User’s Guide Provides you with step-by-step instructions for using your printer’s full features, and contains information for maintaining your printer, 
troubleshooting, and installing accessories. 
This user’s guide also contains a Software section to provide you with information on how to print documents with your printer in 
various operating systems, and how to use the included software utilities.

You can access the user’s guide in other languages from the Manual folder on the printer software CD.

Printer Driver Help Provides you with help information on printer driver properties and instructions for setting up the properties for printing. To access a 
printer driver help screen, click Help from the printer properties dialog box.

Dell website If you have Internet access, you can get help, support, printer drivers, manuals, and order information from the Dell websites 
www.dell.com or support.dell.com.

www.dell.com
www.dell.com
http://support.dell.com
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safety information
IMPORTANT SAFETY SYMBOLS AND PRECAUTIONS

What the icons and signs in this user’s guide mean:

These warning signs are here to prevent injury to you and others. Follow them explicitly. After reading this section, keep it in a safe 
place for future reference.

WARNING

Hazards or unsafe practices that may result in severe personal injury or death.

CAUTION

Hazards or unsafe practices that may result in minor personal injury or property damage.

CAUTION

To reduce the risk of fire, explosion, electric shock, or personal injury when using your laser Multi-Function Printer (MFP), 
follow these basic safety precautions:

Do NOT attempt.

Do NOT disassemble.

Do NOT touch.

Follow directions explicitly.

Unplug the power plug from the wall socket.

Ensure the MFP is grounded to prevent electric shock.

Call the service center for help.

1. Read and understand all instructions.
2. Use common sense whenever operating electrical appliances.
3. Follow all warnings and instructions marked on the printer and in the literature accompanying the printer.

4. If an operating instruction appears to conflict with safety information, heed the safety information. You may have misunderstood the 
operating instruction. If you cannot resolve the conflict, contact your sales or service representative for assistance.

5. Unplug the printer from the AC wall socket and/or telephone jack before cleaning. Do not use liquid or aerosol cleaners. Use only a 
damp cloth for cleaning.

6. Do not place the printer on an unstable cart, stand or table. It may fall, causing serious damage.
7. Your printer should never be placed on, near or over a radiator, heater, air conditioner, or ventilation duct.
8. Do not allow anything to rest on the power. Do not place your printer where the cords will be abused by persons walking on them.

9. Do not overload wall outlets and extension cords. This can diminish performance, and may result in the risk of fire or electric shock.
10. Do not allow pets to chew on the AC power, telephone, or computer interface cords.
11. Never push objects of any kind into the printer through case or cabinet openings. They may touch dangerous voltage points, creating 

a risk of fire or shock. Never spill liquid of any kind onto or into the printer.

12. To reduce the risk of electric shock, do not disassemble the printer. Take it to a qualified service technician when repair work is 
required. Opening or removing covers may expose you to dangerous voltages or other risks. Incorrect reassembly could cause 
electric shock when the unit is subsequently used.
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13. Unplug the printer from the telephone jack, computer and AC wall outlet and refer servicing to qualified service personnel under the 
following conditions:
• When any part of the power cord, plug or connecting cable is damaged or frayed.
• If liquid has been spilled into the printer. 
• If the printer has been exposed to rain or water.
• If the printer does not operate properly after instructions have been followed.
• If the printer has been dropped, or the cabinet appears damaged.
• If the printer exhibits a sudden and distinct change in performance.

14. Adjust only those controls covered by the operating instructions. Improper adjustment of other controls may result in damage, and 
may require extensive work by a qualified service technician to restore the printer to normal operation.

15. Avoid using this printer during a lightning storm. There may be a remote risk of electric shock from lightning. If possible, unplug the 
AC power and telephone cord for the duration of the lightning storm.

16. The Power cord supplied with your printer should be used for safe operation. If you are using a cord which is longer than 2 m with 
110 V printer, then it should be 16 AWGa or bigger.

17. Use only No.26 AWG or larger telephone line cord.

18. SAVE THESE INSTRUCTIONS
19. This printer can be operated only in the country you have purchased (due to different voltage, frequency, telecommunication 

configuration and etc.).

a. AWG: American Wire Gauge
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introduction
These are the main components of your printer:

This chapter includes:
• Printer overview
• Control panel overview
• Understanding the Status LED
• Acknowledging the status of the toner cartridge

• Menu overview
• Supplied software
• Printer driver features

PRINTER OVERVIEW
Front view Rear view

1 Document width guides 12 USB connector

2 DADF 13 Paper level indicator

3 Control panel 14 Optional tray 2

4 Output support 15 Multi-purpose tray paper 
width guides

5 Front cover 16 Toner cartridge

6 Front cover handle 17 Paper transfer belt

7 Multi-purpose tray handle 18 Scanner lid

8 Multi-purpose tray 19 Scanner lock switch

9 Tray 1 20 Scanner glass

10 Document input tray 21 Scan unit

11 Document output tray

1 USB port 7 Power switch

2 Network connector 8 Power connector

3
15-pin optional tray 
connection 9 Control board cover

4 Telephone line socket 10 Rear cover

5
Extension telephone socket 
(EXT) 11 Cable organizer

6 Handle
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CONTROL PANEL OVERVIEW

1 Speed buttons
Allows you to store frequently-dialed fax 
numbers and enter them with the touch of a few 
buttons.

2 Shift Allows you to shift the speed buttons to access 
numbers 16 through 30.

3 Address Book ( )
Allows you to store frequently used fax numbers 
in memory or search for stored fax numbers or 
email addresses.

4 Resolution ( ) Adjusts the document resolution for the current 
fax job.

5 Redial/Pause ( ) In Ready mode, redials the last number, or in 
Edit mode, inserts a pause into a fax number.

6 Fax ( ) Activates Fax mode.

7 Copy ( ) Activates Copy mode.

8 Scan/Email ( ) Activates Scan mode.

9 Display Shows the current status and prompts during an 
operation.

10 Toner colors
The toner colors shown below the LCD display co-
works with the display messages (see Status LED 
with the toner cartridge messages on page 14).

11 Menu ( ) Enters Menu mode and scrolls through the 
available menus.

12 Left/right arrow 
Scroll through the options available in the 
selected menu, and increase or decrease 
values.

13 OK ( ) Confirms the selection on the screen.

14 Back ( ) Sends you back to the upper menu level.

15 Status ( ) Shows the status of your printer (see 
"Understanding the Status LED" on page 14).

16 Darkness ( ) Adjusts the document brightness for the current 
copy job (see "Darkness" on page 31).

17 Original Type ( ) Selects the document type for the current copy 
job. See "Original type" on page 31.

18 ID Copy ( )
You can copy both sides of an ID card (e.g., 
driver's license) to a single side of paper (see  
"ID card copying" on page 32).

19
Reduce/Enlarge 
( ) Makes a copy smaller or larger than the original.

20 Duplex ( ) Allows you to print documents on both sides of 
the paper. 

21 USB Print ( )
Allows you to directly print files stored on a USB 
Memory device when it is inserted into the USB 
connector on the front of your printer 
(see "About USB memory" on page 52.)

22 Number keypad
Dials a number or enters alphanumeric 
characters. See "Keypad letters and 
numbers" on page 21

23 On Hook Dial ( ) Engages the telephone line.

24 Stop/Clear ( )
Stops an operation at any time. In Ready mode, 
clears/cancels the copy options, such as the 
darkness, the document type setting, the copy 
size, and the number of copies. 

25 Color Start ( ) Starts a job in Color mode.

26 Black Start ( ) Starts a job in Black and White mode.

• All illustrations on this user’s guide may differ from your printer 
depending on its options or model.

• The surface of the output tray may become hot if you print a large 
number of pages at once. Ensure that you do not touch the 
surface, and do not allow children near it.
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UNDERSTANDING THE STATUS LED
The color of the Status ( ) LED indicates the printer's current status.

ACKNOWLEDGING THE STATUS OF THE 
TONER CARTRIDGE
The status of toner cartridges is indicated by the Status ( ) LED and 
the LCD display. If the toner cartridge is low or needs to be replaced, the 
Status ( ) LED turns red and the display shows the message. However 
the arrow mark shows which color toner is of concern or needs replacement 
with a new cartridge. 

Example: 

The above example shows the black cartridges status indicated by arrows. 
Check the message to find out what the problem is and how to solve it. See 
"Understanding display messages" on page 70 for more information on 
error messages.

STATUS DESCRIPTION

Off • The printer is powered off-line.
• The printer is in power save mode. When data is 

received, or any button is pressed, it switches to 
on-line automatically.

Green Blinking • When the green LED blinks slowly, the printer is 
receiving data from the computer.

• When the green LED blinks rapidly, the printer is 
printing data.  

On • The printer is powered on and can be used.

Red Blinking • A minor error has occurred and the printer is 
waiting for the error to be cleared. Check the 
display message, and solve the problem referring 
to "Understanding display messages" on 
page 70. 

• The toner cartridge is low. Order a new toner 
cartridge, see "Ordering supplies and 
accessories" on page 83. You can temporarily 
improve print quality by redistributing the toner 
(see "Replacing the toner cartridge" on page 59).

On • A problem has occurred such as a paper jam, 
cover is open or no paper in the tray, so that the 
printer cannot continue the job. Check the 
message on the display, and see "Understanding 
display messages" on page 70 to solve the 
problem.

• The toner cartridge is empty, or needs to be 
changed (see "Replacing the toner cartridge" on 
page 59).

Always check the message on the display to solve the problem. The 
instruction in the Troubleshooting section will guide you to operate the 
printer properly. See "Understanding display messages" on page 70 
for more information.
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Fax Feature

Darkness
Multi Send
Delay Send
Priority Send
Forward
Secure Receive
Add Page
Cancel Job

Fax Setup

Sending
Redial Times
Redial Term
Prefix Dial
ECM Mode
Send Report
Image TCR
Dial Mode 

Receiving
Receive Mode
Ring To Answer

Fax Setup
(Continued)

Stamp RCV Name
RCV Start Code
Auto Reduction
Discard Size
Junk Fax Setup
DRPD Mode
Duplex Print

Change Default
Resolution
Darkness

Auto Report

Copy Feature

Copy Collation
2-Up
4-Up
Poster Copy
Clone Copy
Adjust Bkgd.
Book Copy
Margin Shift
Edge Erase
Gray Enhance

Copy Setup

Scan Size
Change Default

Copies
Reduce/Enlarge
Darkness
Original Type

Scan Feature

USB Memory
Scan Size
Original Type
Resolution
Scan Color
Scan Format

E-mail
Scan Size
Original Type
Resolution
Scan Color

Scan Feature
(Continued)

FTP
Scan Size
Original Type
Resolution
Scan Color

SMB
Scan Size
Original Type
Resolution
Scan Color

MENU OVERVIEW
The control panel provides access to various menus to set up the printer or use the printer’s functions. These menus can be accessed by pressing Menu ( ). 
Refer to the following diagram.

Some menus may not appear in the display depending on options or models. If so, it is not applicable to your printer. 

System Setup

Machine Setup
Machine ID
Machine Fax No
Date & Time
Clock Mode
Form Menu
Select Form
Language
Default Mode
Power Save
Scan PWR Save
Timeout
Job Timeout
Altitude Adj.
Auto Continue
Import Setting
Export Setting

Paper Setup
Paper Size
Paper Type
Paper Source
Wide A4

Sound/Volume
Key Sound
Alarm Sound
Speaker
Ringer

System Setup
(Continued)

Report
All Report
Configuration
Supplies Info
Address Book
Send Report
Sent Report
Fax RCV Report
Schedule Jobs
JunkFax Report
Network Info.
NetScan Report
User Auth List
PCL Font List
PS3 Font List
Stored Job
Completed Job
Net Auth Log

Maintenance
Supplies Life
Color
Serial Number
Toner Low Alert

System Setup
(Continued)

Clear Setting
All Settings
Fax Setup
Copy Setup
Scan Setup
System Setup
Network Setup
Address Book
Sent Report
Fax RCV Report
NetScan Report

Job Manage
Active Job
Store Job
File Policy

ImageOverwrite
Immediate
On Demand

Network

TCP/IP
Ethernet Speed
Clear Setting
Network Info

Scan Setup

Change Default
USB Memory
E-mail
FTP
SMB

Send Report
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SUPPLIED SOFTWARE
You must install the printer and scanner software using the supplied Drivers 
and Utiltiies CD after you have set up your printer and connected it to your 
computer. The CD provides you with the following software.

PRINTER DRIVER FEATURES
Your printer drivers support the following standard features:
• Paper orientation, size, source and media type selection
• Number of copies
In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer 
drivers:

Printer driver
 

PostScript driver

CD CONTENTS

Printer 
software CD

Windows • Printer driver: Use this driver to take full 
advantage of your printer’s features.

• Postscript Printer Description (PPD) file: 
Use the PostScript driver to print documents 
with complex fonts and graphics in the PS 
language.

• Scanner driver: TWAIN and Windows 
Image Acquisition (WIA) drivers are 
available for scanning documents on your 
printer.

• Scan Manager: You can find out about 
Scan Manager program information and 
installed scan driver's condition.

• Dell Toner Management SystemTM: 
Displays the status of the printer and the 
name of the job when send a job to print. 
The Dell Toner Management SystemTM 
window also displays the level of toner 
remaining and allows you to order 
replacement toner cartridges.

• Status Monitor: This program allows you to 
monitor the printer’s status and alerts you 
when an error occurs during printing.

• SmarThru Officea: This is the 
accompanying Windows-based software for 
your multifunctional printer. 

• Printer Setting Utility: This program allows 
you to set up printer’s other options from 
your computer desktop.

• Firmware Update Utility: This program 
helps you to update printer’s firmware.

• SetIP: Use this program to set your printer’s 
TCP/IP addresses.

a. Allows you to edit a scanned image in many ways using a powerful image 
editor and to send the image by email. You can also open another image 
editor program, like Adobe® Photoshop®, from SmarThru. For details, refer 
to the onscreen help supplied on the SmarThru program.

Linux • Postscript Printer Description (PPD) 
file: Use this file to run your printer from a 
Linux computer and print documents.

• SANE: Use this driver to scan documents.
• Printer Setting Utility: This program allows 

you to set up printer’s other options from 
your computer desktop.

Macintosh • Printer driver: Use this driver to take full 
advantage of your printer’s features.

• Postscript Printer Description (PPD) 
file: Use this file to run your printer from a 
Macintosh computer and print documents.

• Scanner driver: TWAIN driver is 
available for scanning documents on your 
printer.

• Printer Setting Utility: This program allows 
you to set up printer’s other options from 
your computer desktop.

FEATURE WINDOWS LINUX MACINTOSH

Color mode O O O

Printer quality option O O O

Poster printing O X X

Multiple pages per sheet 
(N-up)

O O (2, 4) O 

Fit to page printing O X Oa

a.This feature is not supported MAC OS X 10.3.

Scale printing O X O

Different source for first 
page

O X O

Watermark O X X

Overlay O X X

Duplex O X O

FEATURE WINDOWS LINUX MACINTOSH

Color mode O O O

Printer quality option O O O

Poster printing X X X

Multiple pages per sheet 
(N-up)

O O (2, 4) O

Fit to page printing O X Oa

a.This feature is not supported MAC OS X 10.3.

Scale printing O X O

Different source for first 
page

X X O

Watermark X X X

Overlay X X X

Duplex O X O
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getting started
This chapter gives you step-by-step instructions for setting up the printer.

This chapter includes:
• Setting up the hardware
• Printing a demo page
• Setting up the network

• System requirements
• Installing the software
• Printer's basic settings

SETTING UP THE HARDWARE
This section shows the steps to set up the hardware which is explained in 
the Quick Install Guide. Ensure you read Quick Install Guide and complete 
following steps.
1. Select a stable location. 

Select a level, stable place with adequate space for air circulation. Allow 
extra space to open covers and trays. 
The area should be well-ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the printer close to the 
edge of your desk or table.

 

Printing is suitable for altitudes under 1,000 m (3,281 ft). Refer to the 
altitude setting to optimize your printing. See "Altitude adjustment" on 
page 20 for more information.

Select a flat, stable surface that is not inclined greater than 2 mm (0.08 
inch). Otherwise, printing quality may be affected. 

2. Unpack the printer and check all the enclosed items.

3. Remove the tape that is holding the printer tightly.
4. Install the toner cartridge.
5. Load paper (see "Loading paper" on page 27).
6. Ensure that all the cables are connected to the printer. 
7. Turn the printer on. 

PRINTING A DEMO PAGE
Print a demo page to ensure that the printer is operating correctly.
To print a demo page:
In Ready mode, press and hold the OK button for about 2 seconds.

SETTING UP THE NETWORK
You need to set up the network protocols on the printer to use it as your 
network printer. You can set up the basic network settings through the 
printer's control panel.

Supported operating environments
The following table shows the network environments supported by the 
printer:

When you move the printer, do not tilt or turn it upside down. 
Otherwise, the inside of the printer may be contaminated by toner, 
which can damage the printer or result in bad print quality.

ITEM REQUIREMENTS

Network interface • Ethernet 10/100 Base-TX

Network operating system • Windows 2000/XP/2003/2008/Vista
• Various Linux OS
• Mac OS X 10.3 ~ 10.5

Network protocols • TCP/IP on Windows 
• IPP
• SNMP
• DHCP
• BOOTP

If you want to set up DHCP network protocol, go to http://
developer.apple.com/networking/bonjour/download/, select the 
Bonjour program that is appropriate for your computer operating 
system and install the program. This program will allow you to set 
network parameters automatically. Follow the instructions in the 
installation window. This program does not support Linux.

http://developer.apple.com/networking/bonjour/download/
http://developer.apple.com/networking/bonjour/download/
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Configuring network protocol via the printer
You can set up TCP/IP network parameters, follow the steps listed below. 
1. Ensure that your printer is connected to the network with an RJ-45 

Ethernet cable.
2. Ensure you have turned on the printer.
3. Press Menu ( ) on the control panel, until you see Network on the 

bottom line of the display. 
4. Press OK to access the menu.
5. Press the left/right arrow until TCP/IP appears. 
6. Press OK.
7. Press the left/right arrow until Static appears.
8. Press OK.
9. Press the left/right arrow until IP Address appears.
10. Press OK.

Enter a byte between 0 and 255 using the number keypad and press the 
left/right arrow  to move between bytes.
Repeat this to complete the address from the 1st byte to the 4th byte.

11. When you have finished, press OK.
Repeat steps 9 and 10 to configure the other TCP/IP parameters: 
subnet mask and gateway address.

Using the SetIP program
This program is for the network IP setting using the MAC address which is 
the hardware serial number of the network printer card or interface. 
Especially, it is for the network administrator to set several network IPs at 
the same time. 

Setting network values
1. Print the printer’s network configuration report to find your printer’s MAC 

address. See "Printing reports" on page 55
2. From the Windows Start menu, select All Programs → Dell → Dell 

Printers → Dell 2145cn Color Laser MFP → Dell 2145cn Color Laser 
MFP → Set IP.

3. Click  to open the TCP/IP configuration window. 
4. Enter the network card's MAC address, IP address, subnet mask, 

default gateway, and then click Apply.

5. Click OK, then the printer prints the network information. Confirm the 
settings are correct.

6. Click Exit.

SYSTEM REQUIREMENTS
Before you begin, ensure that your system meets the following 
requirements:

Microsoft® Windows®

Your printer supports the following Windows operating systems.

Macintosh

Contact the network administrator if you are not sure how to configure.

You can also set up the network settings through the network 
administration programs. 
• Embedded Web Service: Web server embedded on your network 

print server, which allows you to:
- Configure the network parameters necessary for the printer to 

connect to various network environments.
- Customize printer settings.

• SetIP: Utility program that allows you to select a network interface and 
manually configure the IP addresses for use with the TCP/IP protocol.

• You can only use the SetIP program when your printer is 
connected to a network.

• The following procedure is based on Windows XP.

When you enter the MAC address. IP address, subnet mask, 
default gateway, and then click Apply.

OPERATING 
SYSTEM

REQUIREMENT (RECOMMENDED)

CPU RAM FREE HDD 
SPACE

Windows 2000 Intel® Pentinum® II 
400 MHz (Pentium III 
933 MHz)

64 MB 
(128 MB)

600 MB

Windows XP Intel Pentium III 933 
MHz (Pentium IV 1 
GHz)

128 MB 
(256 MB)

1.5 GB

Windows Server 
2003

Intel Pentium III 933 
MHz (Pentium IV 1 
GHz)

128 MB 
(512 MB)

1.25 GB to 
2 GB

Windows Vista Intel Pentium IV 3 
GHz

512 MB 
(1024 MB)

15 GB

Windows Server 
2008

Intel Pentium IV 1 
GHz
(Intel Pentium IV 2 
GHz)

512 MB 
(2048 MB)

10 GB

• Internet Explorer 5.0 or higher is the minimum requirement for all 
Windows operating systems.

• Software installation can be only be performed by users with 
Administrator rights.

• Windows Terminal Services is compatable with this printer.

OPERATING 
SYSTEM

REQUIREMENT (RECOMMENDED)

CPU RAM FREE HDD 
SPACE

Mac OS X 
10.3 ~ 10.4

• Intel Processor
• Power PC G4/

G5

• 128 MB for a 
Power-PC based 
Mac (512 MB).

• 512 MB for an 
Intel-based Mac 
(1 GB)

1 GB

Mac OS X 10.5 • Intel Processor
• 867 MHz or 

faster Power 
PC G4 /G5

512 MB (1 GB) 1 GB
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Linux

INSTALLING THE SOFTWARE
You have to install the printer software for printing. The software includes 
drivers, applications, and other user friendly programs. 

1. Connect the network cable to your printer.
2. Ensure that the network setup for your printer is completed (see "Setting 

up the network" on page 17). All applications should be closed on your 
computer before beginning installation.

3. Insert the Drivers and Utiltiies CD into your CD drive.
The CD should automatically run, and an installation window appears. 
If the installation window does not appear, click Start → Run. Type 
X:\Setup.exe, replacing “X” with the letter which represents your CD 
drive and click OK.
If you use Windows Vista, click Start → All Programs → Accessories 
→ Run, and type X:\Setup.exe.
If the AutoPlay window appears in Windows Vista, click Run Setup.exe 
in Install or run program field, and click Continue in the User Account 
Control window.

4. Click Next.

• If necessary, select a language from the drop-down list.
5. Select Typical installation for a network printer, and then click Next.

 

6. The list of printers available on the network appears. Select the printer 
you want to install from the list and then click Next.

 

• If you do not see your printer on the list, click Update to refresh the 
list, or select Add TCP/IP Port to add your printer to the network. To 
add the printer to the network, enter the port name and the IP 
address for the printer.
To verify your printer’s IP address or the MAC address, print a 
Network Configuration page (see "Printing reports" on page 55).

• To find a shared network printer (UNC Path), select Shared Printer 
[UNC] and enter the shared name manually or find a shared printer 

ITEM REQUIREMENTS

Operating system RedHat 8.0, 9.0 (32bit)
RedHat Enterprise Linux WS 4, 5 (32/64bit)
Fedora Core 1~7 (32/64bit)
Mandrake 9.2 (32bit), 10.0, 10.1 (32/64bit)
Mandriva 2005, 2006, 2007 (32/64bit)
SuSE Linux 8.2, 9.0, 9.1 (32bit)
SuSE Linux 9.2, 9.3, 10.0, 10.1, 10.2 (32/64bit)
SuSE Linux Enterprise Desktop 9, 10 (32/64bit)
Ubuntu 6.06, 6.10, 7.04 (32/64bit)
Debian 3.1, 4.0 (32/64bit)

CPU Pentium IV 2.4GHz (IntelCore2)

RAM 512 MB (1024 MB)

Free HDD space 1 GB (2GB)

• It is necessary to claim swap partition of 300 MB or larger for 
working with large scanned images.

• The Linux scanner driver supports the optical resolution at 
maximum.

• The following procedure is applicable when the printer is being 
used as a network printer. If you want to connect a printer with a 
USB cable, see the Software section.

• The following procedure is based on the Windows XP operating 
system. The procedure and popup window which appear during 
the installation may differ depending on the operating system, the 
printer feature, or the interface in use.
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by clicking the Browse button.

7. Click Finish.

PRINTER'S BASIC SETTINGS
After installation is complete, you may want to set the printer's default 
settings. Refer to the next section if you would like to set or change values.

Altitude adjustment
The print quality is affected by atmospheric pressure, which is determined 
by the height of the printer above sea level. The following information will 
guide you on how to set your printer to the best print quality or best quality of 
print.
Before you set the altitude value, find the altitude where you are using the 
printer.

1. Ensure that you have installed the printer driver with the provided     
Drivers and Utiltiies CD.

2. Click Start → All Programs → DELL → DELL Printers → Dell 2145cn 
Color Laser MFP → Printer Setting Utility. 
You can also click Printer Setting Utility on the status bar in Mac OS X 
(or Notification Area in Linux).

3. Click Setting → Altitude Adjustment. Select the appropriate value 
from the dropdown list, and then click Apply. 

Changing the display language
To change the display language in the control panel:

1. Press Menu ( ) until System Setup appears on the bottom line of the 
display and press OK.

2. Press OK when Machine Setup appears.
3. Press the left/right arrow until Language appears and press OK.
4. Press the left/right arrow until the language you want appears and press 

OK.
5. Press Stop/Clear ( ) to return to Ready mode.   

Setting the date and time 
The current date and time are shown on the display when your printer is on 
and ready to work.
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press OK when Machine Setup appears.
3. Press the left/right arrow until Date & Time appears and press OK.
4. Enter the correct time and date using the number keypad. 

Month  = 01 to 12
Day     = 01 to 31
Year    = requires four digits
Hour    = 01 to 12 (12-hour mode) 
               00 to 23 (24-hour mode)
Minute = 00 to 59

   

You can also use the left/right arrow to move the cursor under the 
digit you want to correct and enter a new number.

5. To select AM or PM for 12-hour format, press the *or # button or any 
number button.
When the cursor is not under the AM or PM indicator, pressing the *or # 
button immediately moves the cursor to the indicator.
You can change the clock mode to 24-hour format (e.g. 01:00 PM as 
13:00). For details, see the next section.

6. Press OK to save the time and date. 
When you enter a wrong number, Out of Range appears and the printer 
does not proceed to the next step. If this happens, simply reenter the 
correct number.

7. Press Stop/Clear ( ) to return to Ready mode.

Changing the clock mode
You can set your printer to display the current time using either a 12-hour or 
24-hour format.
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press OK when Machine Setup appears.
3. Press the left/right arrow until Clock Mode appears and press OK. 
4. Press the left/right arrow  to select the other mode and press OK.
5. Press Stop/Clear ( ) to return to Ready mode.

Changing the default mode 
Your printer is preset to Fax mode. You can switch this default mode 
between Fax mode and Copy mode.

If you are not sure of the IP address, contact your network 
administrator or print network information (see "Printing 
reports" on page 55).

• If your printer does not work properly after the installation, try 
to reinstall the printer driver. See the Software section.

• During the printer driver installation process, the driver installer 
detects the location information for your operating system and 
sets the default paper size for your printer. If you use a 
different Windows location, you must change the paper size to 
match the paper you usually use. Go to printer properties to 
change the paper size after installation is complete. 

1 Normal
2 High 1
3 High 2
4 High 3 

If your printer is connected to a network, Embedded Web Service 
screen appears automatically. Click Machine Settings → Setup 
(or Machine Setup) → Altitude adj.. Select the appropriate 
altitude value, and then click Apply.

0

The date format may differ from country to country
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1. Press Menu ( ) until System Setup appears on the bottom line of the 
display and press OK.

2. Press OK when Machine Setup appears.
3. Press the left/right arrow until Default Mode appears and press OK.
4. Press the left/right arrow until the default mode you want appears and 

press OK.
5. Press Stop/Clear ( ) to return to Ready mode.

Setting sounds
You can control the following sounds:
• Key Sound: Turns the key sound on or off. With this option set to On, a 

tone sounds each time a key is pressed. 
• Alarm Sound: Turns the alarm sound on or off. With this option set to 

On, an alarm tone sounds when an error occurs or fax communication 
ends.

• Speaker: Turns on or off the sounds from the telephone line through 
the speaker, such as a dial tone or a fax tone. With this option set to 
Comm. which means “Common,” the speaker is on until the remote 
printer answers. 

• Ringer: Adjusts the ringer volume. For the ringer volume, you can 
select Off, Low, Mid, and High. 

Speaker, ringer, key sound, and alarm sound
1. Press Menu ( ) until System Setup appears on the bottom line of 

the display and press OK.
2. Press the left/right arrow until Sound/Volume appears and press 

OK.
3. Press the left/right arrow until the sound option you want appears 

and press OK.
4. Press the left/right arrow until the desired status or volume for the 

sound you have selected appears and press OK.
5. If necessary, repeat steps 3 through 5 to set other sounds.
6. Press Stop/Clear ( ) to return to Ready mode.

Speaker volume
1. Press On Hook Dial ( ). A dial tone sounds from the speaker.
2. Press the left/right arrow until you hear the volume you want.
3. Press Stop/Clear ( ) to save the change and return to Ready 

mode.

Entering characters using the number keypad
As you perform various tasks, you may need to enter names and numbers. 
For example, when you set up your printer, you enter your name or your 
company’s name, and the fax number. When you store fax numbers or 
email addresses in memory, you may also enter the corresponding names.

Entering alphanumeric characters
1. When you are prompted to enter a letter, locate the button labeled 

with the character you want. Press the button until the correct letter 
appears on the display.
For example, to enter the letter O, press 6, labeled with MNO.
Each time you press 6, the display shows a different letter, M, N, O, 
m, n, o and finally 6.

You can enter special characters, such as space, plus sign, and etc. 
For details, see the below section.

2. To enter additional letters, repeat step 1.
If the next letter is printed on the same button, move the cursor by 
pressing the right left/right arrow button and then press the button 
labeled with the letter you want. The cursor will move to the right and 
the next letter will appear on the display.
You can enter a space by pressing 1 twice.

3. When you have finished entering letters, press OK.

Keypad letters and numbers

Correcting numbers or names
If you make a mistake while entering a number or name, press the left 
left/right arrow button to delete the last digit or character. Then enter the 
correct number or character.

Inserting a pause
With some telephone systems, you must dial an access code (9, for 
example) and listen for a second dial tone. In such cases, you must 
insert a pause in the telephone number. You can insert a pause while 
you are setting up speed buttons or speed dial numbers.
To insert a pause, press Redial/Pause at the appropriate place while 
entering the telephone number. A - appears on the display at the 
corresponding location.

Using the save modes
Power Save mode
Power Save mode allows your printer to reduce power consumption 
when it is not in actual use. You can turn this mode on and select a 
length of time for which the printer waits after a job is printed before it 
switches to a reduced power state.
1. Press Menu ( ) until System Setup appears on the bottom line of 

the display and press OK.
2. Press OK when Machine Setup appears.
3. Press the left/right arrow until Power Save appears and press OK.
4. Press the left/right arrow until the time setting you want appears and 

press OK.
5. Press Stop/Clear ( ) to return to Ready mode.

You can adjust the volume level using On Hook Dial ( ).

You can adjust the speaker volume only when the telephone line is 
connected.

KEY ASSIGNED NUMBERS, LETTERS, OR CHARACTERS

1  1    Space   

2  A    B    C    a    b    c    2

3  D    E    F    d    e    f    3

4  G    H    I     g    h    i    4

5   J    K    L    j    k    l    5

6  M    N    O    m    n    o    6 

7   P    Q    R    S    p    q    r    s    7

8   T    U    V    t    u    v    8 

9   W    X    Y    Z    w    x    y    z    9

0   +     -     ,    .      ‘    /    *    #    &    @    0
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Scan power save mode
Scan Power Save mode allows you to save power by turning off the 
scan lamp. The scan lamp under the scanner glass automatically turns 
off when it is not in actual use to reduce power consumption and 
extends the life of the lamp. The lamp automatically wakes up after 
some warm-up time when you start scanning.
You can set the length of time for which the scan lamp waits after a scan 
job is completed before it switches to the power save mode. 
1. Press Menu ( ) until System Setup appears on the bottom line of 

the display and press OK.
2. Press OK when Machine Setup appears.
3. Press the left/right arrow until Scan PWR Save appears and press 

OK.
4. Press the left/right arrow until the time setting you want appears and 

press OK.
5. Press Stop/Clear ( ) to return to Ready mode.

Setting print job timeout
You can set the amount of time a single print job is active before it must 
print.The printer handles incoming data as a single job if it comes in within 
the specified time. When an error occurs while processing data from the 
computer and the data flow stops, the printer waits the specified time and 
then cancels printing if data flow does not resume.
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press OK when Machine Setup appears.
3. Press the left/right arrow until Job Timeout appears and press OK.
4. Press the left/right arrow until the time setting you want appears and 

press OK.
5. Press Stop/Clear ( ) to return to Ready mode.

Auto continue
This is the option to set the printer to continue printing or not, in case the 
paper size you have set and the paper within the tray mismatches. 
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press OK when Machine Setup appears.
3. Press the left/right arrow until Auto Continue appears and press OK.
4. Press the left/right arrow until the binding option you want appears.

• On: Automatically prints after set time passes, when the paper size 
mismatches the tray paper size.

• Off: Waits until you press Black Start ( )  or Color Start ( ) on 
the control panel, when the paper size mismatches the tray paper 
size.

5. Press OK to save your selection.
6. Press Stop/Clear ( ) to return to Ready mode.

Changing the font setting 
Your printer has preset the font for your region or country. 
If you want to change the font or set the font for special condition such as 
the DOS environment, you can change the font setting as follows:
1. Ensure that you have installed the printer driver from the provided 

Drivers and Utiltiies CD.
2. Click Start → All Programs → DELL → DELL Printers → Dell 2145cn 

Color Laser MFP → Printer Setting Utility. 

You can also click Printer Setting Utility on the status bar in Mac OS X 
(or Notification Area in Linux).

3. Click Printer Setting Utility.
4. Click Emulation.
5. Confirm if PCL is selected in Emulation Setting.
6. Click Setting.
7. Select your preferred font in the Symbol set list.
8. Click Apply.

Following information shows the proper font list for corresponding 
languages.
• Russian: CP866, ISO 8859/5 Latin Cyrillic
• Hebrew: Hebrew 15Q, Hebrew-8, Hebrew-7 (Israel only)
• Greek: ISO 8859/7 Latin Greek, PC-8 Latin/Greek
• Arabic & Farsi: HP Arabic-8, Windows Arabic, Code Page 864, 

Farsi, ISO 8859/6 Latin Arabic
• OCR : OCR-A, OCR-B
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loading originals and print media
This chapter introduces you how to load originals and print media into your printer.

This chapter includes:
• Loading originals
• Selecting print media
• Changing the size of the paper in the paper tray

• Loading paper
• Adjusting the output support
• Setting the paper size and type

LOADING ORIGINALS
You can use the scanner glass or DADF to load an original for copying, 
scanning, and sending a fax.

On the scanner glass
Ensure that no originals are in the DADF. If an original is detected in the 
DADF, the printer gives it priority over the original on the scanner glass. To 
get the best scan quality, especially for colored or gray-scaled images, use 
the scanner glass.
1. Lift and open the scanner lid.

2. Place the original face down on the scanner glass and align it with the 
registration guide at the top left corner of the glass.

3. Close the scanner lid.

In the DADF
Using the DADF, you can load up to 50 sheets of paper (75 g/m2, 20 lb 
bond) for one job. 
When you use the DADF:
• Do not load paper smaller than 148 x 148 mm (5.8 x 5.8 inches) or 

larger than 216 x 356 mm (8.5 x 14 inches).
• Do not attempt to load the following types of paper:

- carbon-paper or carbon-backed paper
- coated paper
- onion skin or thin paper
- wrinkled or creased paper
- curled or rolled paper
- torn paper

• Remove all staples and paper clips before loading.
• Ensure that any glue, ink, or correction fluid on the paper is completely 

dry before loading.
• Do not load originals that include different sizes or weights of paper.
• Do not load booklets, pamphlets, transparencies, or documents having 

other unusual characteristics.

Dell 2145cn has the DADF function which can let you scan on both 
sides of the original media at once. See "Scan on both sides of 
paper" on page 41

• Leaving the scanner lid open while copying may affect copy quality 
and toner consumption.

• Dust on the scanner glass may cause black spots on the printout. 
Always keep it clean.

• If you are copying a page from a book or magazine, lift the scanner 
lid until its hinges are caught by the stopper and then close the lid. 
If the book or magazine is thicker than 30 mm, start copying with 
the lid open.
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1. Flex or fan the edge of the paper stack to separate the pages before 
loading originals.

2. Load the original face up into the DADF. Ensure that the bottom of the 
original stack matches the paper size marked on the document input 
tray.

3. Adjust the document width guides to the paper size.

SELECTING PRINT MEDIA
You can print on a variety of print media, such as plain paper, envelopes, 
labels, and transparencies. Always use print media that meet the guidelines 
for use with your printer. Print media that does not meet the guidelines 
outlined in this user’s guide may cause the following problems:
• Poor print quality
• Increased paper jams
• Premature wear on the printer.
Properties, such as weight, composition, grain, and moisture content, are 
important factors that affect the printer’s performance and the output quality. 
When you choose print materials, consider the following:
• The type, size and weight of the print media for your printer are 

described later in this section.
• Desired outcome: The print media you choose should be appropriate for 

your project.
• Brightness: Some print media are whiter than others and produce 

sharper, more vibrant images.
• Surface smoothness: The smoothness of the print media affects how 

crisp the printing looks on the paper.

Dust on the DADF glass may cause black lines on the printout. Always 
keep it clean.

• Some print media may meet all of the guidelines in this section and 
still not produce satisfactory results. This may be the result of 
improper handling, unacceptable temperature and humidity levels, 
or other variables over which Dell has no control.

• Before purchasing large quantities of print media, ensure that it 
meets the requirements specified in this user’s guide. 

Using print media that does not meet these specifications may cause 
problems, requiring repairs. Such repairs are not covered by Dell’s 
warranty or service agreements.
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Specifications on print media

TYPE SIZE DIMENSIONS WEIGHTA CAPACITYB

Plain paper Letter 216 x 279 mm (8.5 x 11 inches) • 60 to 105 g/m2 (16 to 28 lb 
bond) for the tray

• 60 to 163 g/m2 (16 to 43 lb 
bond) for the multi-purpose 
tray

• 250 sheets of 75 g/m2 

(20 lb bond) paper for the 
tray

• 100 sheets of 75 g/m2 
(20 lb bond) in the multi-
purpose tray

• 500 sheets of 75 g/m2 
(20 lb bond) paper for 
optional tray

Legal 216 x 356 mm (8.5 x 14 inches)

US Folio 216 x 330 mm (8.5 x 13 inches)

A4 210 x 297 mm (8.26 x 11.69 inches)

Oficio 216 x 343 mm (8.5 x 13.5 inches)

JIS B5 182 x 257 mm (7.16 x 10.11 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 10.5 inches)

A5 148 x 210 mm (5.82 x 8.26 inches) • 60 to 105 g/m2 (16 to 28 lb 
bond) for the tray

• 60 to 163 g/m2 (16 to 43 lb 
bond) for the multi-purpose 
tray

• 150 sheets of 75 g/m2 

(20 lb bond) paper for the 
tray

• 100 sheets of 75 g/m2 
(20 lb bond) in the multi-
purpose tray

Statement 140 x 216 mm (5.5 x 8.5 inches)

A6 105 x 148 mm (4.13 x 5.82 inches)

Envelope Envelope Monarch 98 x 191 mm (3.87 x 7.5 inches) 75 to 105 g/m2 (20 to 28 lb 
bond)

10 sheets of 75 g/m2 (20 lb 
bond) in the multi-purpose 
trayEnvelope 6 3/4 92 x 165 mm (3.62 x 6.5 inches)

Envelope No. 10 105 x 241 mm (4.12 x 9.5 inches)

Envelope No. 9 98 x 225 mm (3.87 x 8.87 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.37 x 9.01 inches)

Envelope C6 114 x 162 mm (4.48 x 6.38 inches)

Labels Letter, Legal, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5, 
Statement

Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lb 
bond)

10 sheets of 75 g/m2 (20 lb 
bond) paper for the multi-
purpose tray

Card stock Letter, Legal, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5, 
Statement

Refer to the Plain paper section 90 to 163 g/m2 (24 to 43 lb 
bond)

10 sheets of 75 g/m2 (20 lb 
bond) paper for the multi-
purpose tray

Minimum size (custom) 76 x 127 mm (3 x 5 inches) 60 to 163 g/m2 (16 to43 lb bond) 

Maximum size (custom) 216 x 356 mm (8.5 x 14 inches)

a. If media weight is over 105 g/m2 (28 lb bond), use the multi-purpose tray.
b.Maximum capacity may differ depending on media weight, thickness, and environmental conditions.
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Media sizes supported in each mode

Guidelines for special print media

MODE SIZE SOURCE

Copy mode Letter, A4, Legal, 
Oficio, US Folio, 
Executive, JIS B5, A5, 
A6

• tray 1
• optional tray 2
• multi-purpose tray

Print mode All sizes supported by 
the printer

• tray 1
• optional tray 2
• multi-purpose tray

Fax mode Letter, A4, Legal • tray 1
• optional tray 2

Duplex printinga

a.75 to 105 g/m2 (20~28 lb bond) only 

Letter, A4, Legal, US 
Folio, Oficio

• tray 1
• optional tray 2
• multi-purpose tray

MEDIA TYPE GUIDELINES

Envelopes • Successful printing on envelopes depends upon the 
quality of the envelopes. When selecting envelopes, 
consider the following factors:
- Weight: The weight of the envelope paper should 

not exceed 90 g/m2 or jamming may occur.
- Construction: Prior to printing, envelopes should 

lie flat with less than 6 mm curl, and should not 
contain air.

- Condition: Envelopes should not be wrinkled, 
nicked, or otherwise damaged.

- Temperature: You should use envelopes that are 
compatible with the heat and pressure of the 
printer during operation.

• Use only well-constructed envelopes with sharp and 
well creased folds.

• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, 

coated lining, self-adhesive seals, or other synthetic 
materials.

• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope 

extends all the way to the corner of the envelope.

1 Acceptable
2 Unacceptable

• Envelopes with a peel-off adhesive strip or with 
more than one flap that folds over to seal must use 
adhesives compatible with the printer’s fusing 
temperature for 0.1 second. Check your printer’s 
specification to view the fusing temperature. See 
"Printer specifications" on page 89. The extra flaps 
and strips might cause wrinkling, creasing, or jams, 
and may even damage the fuser.

• For the best print quality, position margins no closer 
than 15 mm from the edges of the envelope.

• Avoid printing over the area where the envelope’s 
seams meet.

Labels • To avoid damaging the printer, use only labels 
designed for use in laser printers.
- When selecting labels, consider the following 

factors:
- Adhesives: The adhesive material should be 

stable at your printer’s fusing temperature. Check 
your printer’s specification to view the fusing 
temperature, see "General specifications" on 
page 88.

- Arrangement: Only use labels with no exposed 
backing between them. Labels can peel off sheets 
that have spaces between the labels, causing 
serious jams.

- Curl: Prior to printing, labels must lie flat with no 
more than 13 mm of curl in any direction.

- Condition: Do not use labels with wrinkles, 
bubbles, or other indications of separation.

• Ensure that there is no exposed adhesive material 
between labels. Exposed areas can cause labels to 
peel off during printing, which can cause paper 
jams. Exposed adhesive can also cause damage to 
printer components.

• Do not run a sheet of labels through the printer more 
than once. The adhesive backing is designed for 
only a single pass through the printer.

• Do not use labels that are separating from the 
backing sheet or are wrinkled, bubbled, or otherwise 
damaged.

Card stock or 
custom-sized 
materials

• Do not print on media smaller than 76 mm wide or 
356 mm long.

• In the software application, set margins at least 
6.4 mm away from the edges of the material.

MEDIA TYPE GUIDELINES
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CHANGING THE SIZE OF THE PAPER IN THE 
PAPER TRAY
To load longer sizes of paper, such as Legal-sized paper, you need to 
adjust the paper guides to extend the paper tray.

1. Adjust the paper length guide to the desired paper length. It is preset to 
Letter or A4 size depending on the country. 

2. After inserting paper into the tray, while pinching the paper width guide 
as shown, move it toward the stack of paper until it lightly touches the 

side of the stack. Do not press the guide too tightly to the edge of the 
paper; the guide may bend the paper. 

When you use legal-sized paper, you need to extend the length of the 
tray.

3. Press and hold the green lever on the back of the tray, when you are 
holding the lever, extend the tray to the corresponding position. 

4. Load the paper into the tray. 
5. Place the tray into the printer.
6. Set the paper size from your computer.

LOADING PAPER
Loading paper in the tray 1 or optional tray
Load the print media you use for the majority of your print jobs in the tray 1. 
The tray 1 can hold a maximum of 250 sheets of 75 g/m2 (20 lb bond) plain 
paper. 
You can purchase an optional tray and attach it below the standard tray to 
load an additional 500 sheets of paper (see "Accessories" on page 83).

Preprinted 
paper

• Letterhead must be printed with heat-resistant ink 
that will not melt, vaporize, or release hazardous 
emissions when subjected to the printer’s fusing 
temperature for 0.1 second. Check your printer’s 
specification to view the fusing temperature, see 
"General specifications" on page 88.

• Letterhead ink must be non-flammable and should 
not adversely affect printer rollers.

• Forms and letterhead should be sealed in a 
moisture-proof wrapping to prevent changes during 
storage.

• Before you load preprinted paper, such as forms 
and letterhead, verify that the ink on the paper is 
dry. During the fusing process, wet ink can come off 
preprinted paper, reducing print quality.

1 Tray extend lever
2 Paper length guide
3 Paper width guide

MEDIA TYPE GUIDELINES

• Do not push the paper width guides far enough to cause the 
materials to warp.

• If you do not adjust the paper width guides, it may cause paper 
jams.

Using photographic paper or coated paper may cause problems, 
requiring repairs. Such repairs are not covered by Dell’s warranty or 
service agreements.
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1. Pull out the tray and adjust the tray size to the media size you are 
loading.

2. Place paper with the side you want to print facing up.

3. When you print a document, set the paper source and type in the 
software application. See Software section for printing from your 
computer.

Loading paper in the multi-purpose tray
The multi-purpose tray can hold special sizes and types of print material, 
such as postcards, note cards, and envelopes. It is useful for single page 
printing on letterhead or colored paper.

Tips on using the multi-purpose tray
• Load only one size of print media at a time in the multi-purpose tray.
• To prevent paper jams, do not add paper when there is still paper in 

the multi-purpose tray. This also applies to other types of print 
media.

• Print media should be loaded face down with the top edge going into 
the multi-purpose tray first and be placed in the center of the tray.

• Always load only the specified print media to avoid paper jams and 
print quality problems (see "Selecting print media" on page 24).

• Flatten any curl on postcards, envelopes, and labels before loading 
them into the multi-purpose tray.

1. Hold the handle of multi-purpose tray and pull it down to open.

2. Load the paper.

1 Full
2 Empty

• If you experience problems with paper feed, place one sheet at a 
time in the multi-purpose tray.

• You can load previously printed paper. The printed side should be 
facing down with an uncurled edge at the front. If you experience 
problems with paper feed, turn the paper around. Note that print 
quality is not guaranteed. 

• If you want to load the used paper, place the paper with the 
printed side facing down.

• If you are using paper, flex or fan the edge of the paper stack 
to separate the pages before loading.
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3. Squeeze the multi-purpose tray paper width guides and adjust them to 
the width of the paper. Do not force too much, or the paper will be bent, 
which will result in a paper jam or skew.

4. When you print a document, set the paper source and type in the 
software application. See Software section for printing from your 
computer.

5. After printing, close the multi-purpose tray.

ADJUSTING THE OUTPUT SUPPORT
The printed pages stack on the output tray, and the output support will help 
the printed pages to align. For the output support to correctly align the 
pages, you need to pull it out appropriately depending on the paper size.

For Letter-sized paper
Pull out the output support to the location indicated LTR as shown, and 
unfold the extension.

For A4- or Legal-sized paper
Pull out the output support to the location indicated A4, LGL as shown, and 
unfold the extension.

Depending on the media type you are using, keep the following 
loading guidelines:
• Envelopes: Flap side down and with the stamp area on the 

top left side.
• Labels: Print side up and top short edge entering the printer 

first.
• Preprinted paper: Design side up with the top edge toward the 

printer.
• Card stock: Print side up and the short edge entering the 

printer first.
• Previously printed paper: Previously printed side down with 

an uncurled edge toward the printer.

The settings made from the printer driver override the settings on 
the control panel.

1 Output support
2 Extension

• If the output support is incorrectly adjusted, printed pages may be 
mis-aligned or fall.

• If you continuously print many pages, the surface of the output tray 
may become hot. Be careful not to touch the surface, and 
especially keep out of children’s reach.
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SETTING THE PAPER SIZE AND TYPE
After loading paper in the paper tray, you need to set the paper size and 
type using the control panel buttons. These settings will apply to Copy and 
Fax modes. For printing from your computer, you need to select the paper 
size and type in the application program you use on your PC.
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press the left/right arrow until Paper Setup appears and press OK.
3. Press OK when Paper Size appears.
4. Press the left/right arrow until the paper tray you want appears and 

press OK. 
5. Press the left/right arrow until the paper size you are using appears and 

press OK. 
6. Press Back ( ) to return to the upper level.
7. Press the left/right arrow until Paper Type appears and press OK.
8. Press the left/right arrow until the paper type you are using appears and 

press OK. 
9. Press Stop/Clear ( ) to return to Ready mode.

If you want to use special sized paper such as a billing paper, select 
Custom in the Paper tab in the printer propeties. See Software 
section.
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copying
This chapter gives you step-by-step instructions for copying documents.

This chapter includes:
• Selecting the paper tray
• Copying
• Changing the settings for each copy
• Changing the scan size settings
• Changing the default copy settings

• ID card copying
• Using special copy features
• Printing on both sides of paper
• Setting copy timeout

SELECTING THE PAPER TRAY
After loading the print media for copy output, you must select the paper tray 
you will use for copy jobs.
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press the left/right arrow until Paper Setup appears and press OK.
3. Press the left/right arrow until Paper Source appears and press OK.
4. Press OK when Copy Tray appears.
5. Press the left/right arrow until the paper tray you want appears and 

press OK.
6. Press Stop/Clear ( ) to return to Ready mode.

COPYING
1. Press Copy.

Ready to Copy appears on the top line of the display.
2. Load originals face up into the DADF, or place a single original face 

down on the scanner glass.
For details about loading an original, see "Loading originals" on 
page 23.

3. Enter the number of copies using the number keypad, if necessary.
4. If you want to customize the copy settings including copy size, darkness, 

and original type, by using the control panel buttons. See the next 
section.
If necessary, you can use special copy features, such as poster copying, 
2- or 4-up copying. See "ID card copying" on page 32.

5. Press Color Start ( ) to begin color copying. 
Or, press Black Start ( )  to begin black and white copying.

CHANGING THE SETTINGS FOR EACH COPY
Your printer provides default settings for copying so that you can quickly 
and easily make a copy. However, if you want to change the options for 
each copy, use the copy function buttons on the control panel.

Darkness
If you have an original containing faint markings and dark images, you can 
adjust the brightness to make a copy that is easier to read. 

To adjust the darkness of copies, press Darkness ( ). Each time you 
press the button, the following modes are available:
• Lightest: Works well with darker print.
• Light: Works well with dark print.
• Normal: Works well with standard typed or printed originals.
• Dark: Works well with light print. 
• Darkest: Works well with lighter print or faint pencil markings. 

Original type
The original type setting is used to improve the copy quality by selecting the 
document type for the current copy job. 
To select the document type, press Original Type ( ). Each time you 
press the button, the following modes are available:
• Text: Use for originals containing mostly text.
• Text/Photo: Use for originals with mixed text and photographs.
• Photo: Use when the originals are photographs.
• Magazine: Use when the originals are magazines.

Reduced or enlarged copy
By using the Reduce/Enlarge ( ) button, you can reduce or enlarge the 
size of a copied image from 25% to 400% when you copy original 
documents from the scanner glass, or from 25% to 100% from the DADF.

To select from the predefined copy sizes:
1. Press Reduce/Enlarge ( ). 
2. Press Reduce/Enlarge ( ) or the left/right arrow until the size 

setting you want appears and press OK.

To scale the copy by directly entering the scale rate:
1. Press Reduce/Enlarge ( ). 
2. Press Reduce/Enlarge ( ) or the left/right arrow until Custom 

appears and press OK.
3. Enter the scale rate and press OK to save the selection.

You can cancel the copy job during an operation. Press Stop/Clear 
( ), and the copying will stop.

If you press Stop/Clear ( ) while setting the copy options, all of the 
options you have set for the current copy job will be canceled and 
returned to their default status. Or, they will automatically return to 
their default status after the printer completes the copy in progress. 

When you make a reduced copy, black lines may appear at the 
bottom of your copy.
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CHANGING THE SCAN SIZE SETTINGS
You can adjust the scan size for the original paper. For example, if you scan 
a A4-sized original and set the scan size to A5, the printer scans only the 
area of A5 (148 x 210 mm). We recommend you to change the right scan 
size for the original paper.  After loading the print media for copy output, you 
need to set the scan size using the control panel buttons.
1. Press Copy.
2. Press Menu ( ) until Copy Setup appears on the bottom line of the 

display and press OK.
3. Press OK when Scan Size appears.
4. Press the left/right arrow until the setting you want appears and press 

OK.
5. Press Stop/Clear ( ) to return to Ready mode.

CHANGING THE DEFAULT COPY SETTINGS
The copy options, including darkness, original type, copy size, and number 
of copies, can be set to those most frequently used. When you copy a 
document, the default settings are used unless they have been changed by 
using the corresponding buttons on the control panel.
1. Press Copy.
2. Press Menu ( ) until Copy Setup appears on the bottom line of the 

display and press OK.
3. Press OK when Change Default appears.
4. Press the left/right arrow until the setup option you want appears and 

press OK.
5. Press the left/right arrow until the setting you want appears and press 

OK.
6. Repeat steps 4 through 5, as needed.
7. Press Stop/Clear ( ) to return to Ready mode.

ID CARD COPYING
Your printer can print 2-sided originals on one sheet of A4-, Letter-, Legal-, 
Folio-, Oficio-, Executive-, B5-, A5-, or A6-sized paper. 
When you copy using this feature, the printer prints one side of the original 
on the upper half of the paper and the other side on the lower half without 
reducing the size of the original. This feature is helpful for copying a small-
sized item, such as a name card. 
This copy feature is available only when you place originals on the scanner 
glass.

1. Press ID Copy ( ).
2. Place a single original face down on the scanner glass. 

For details about loading an original, see "Loading 
originals" on page 23.

3. Place Front Side and Press[Start] appears on the 
display.

4. Press Color Start ( )  or Black Start ( ) .
Your printer begins scanning the front side and shows 
Place Back Side and Press[Start]

5. Open the scanner lid and turn the original over.

6. Press Color Start ( )  to begin color copying. 
Or, press Black Start ( ) to begin black and white copying

USING SPECIAL COPY FEATURES
You can use the following copy features:

Collation
You can set the printer to sort the copy job. For example, if you make 2 
copies of a 3 page original, one complete 3 page document will print 
followed by a second complete document.
1. Press Copy.
2. Load originals face up into the DADF, or place a single 

original face down on the scanner glass.
For details about loading an original, see "Loading 
originals" on page 23.

3. Enter the number of copies using the number keypad.
4. Press Menu ( ) until Copy Feature appears on the 

bottom line of the display and press OK.
5. Press OK when Copy Collation appears.
6. Press the left/right arrow  to select the color mode you 

want.
There are two types of mode as following:
• Yes-Color: Color copy
• Yes-Mono: Black and White copy

7. Press OK to begin copying.
One complete document will print followed by the second complete 
document.

2-up or 4-up copying
Your printer can print 2 or 4 original images reduced to fit onto one sheet of 
paper.
1. Press Copy.
2. Load originals face up into the DADF, or place a single 

original face down on the scanner glass.
For details about loading an original, see "Loading 
originals" on page 23.

3. Press Menu ( ) until Copy Feature appears on the 
bottom line of the display and press OK.

4. Press the left/right arrow until 2-Up or 4-Up appears 
and press OK.

5. Press the left/right arrow  to select the color mode you 
want.
There are two types of mode as following:
• Yes-Color: Color copy
• Yes-Mono: Black and White copy

6. Press OK to begin copying.

After using this option, the printer automatically resumes to the default 
setting.

While you are setting copy options, pressing Stop/Clear ( ) cancels 
the changed settings and restores the defaults.

If you press Stop/Clear ( ) or if no buttons are pressed for 
approximately 30 seconds, the printer cancels the copy job and 
returns to Ready mode.

If the original is larger than the printable area, some portions may not 
be printed.
If you press Stop/Clear ( ) or if no buttons are pressed for 
approximately 30 seconds, the printer cancels the copy job and 
returns to Ready mode.

You cannot adjust the copy size using the Reduce/Enlarge ( ) 
button for making a 2- or 4-up copy.

1
2

1 2

3 4
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Poster copying
Your printer can print an image onto 9 sheets of paper (3x3). You can paste 
the printed pages together to make one poster-sized document.
This copy feature is available only when you place originals on the scanner 
glass.
1. Press Copy.
2. Place a single original face down on the scanner glass.

For details about loading an original, see "Loading 
originals" on page 23.

3. Press Menu ( ) until Copy Feature appears on the 
bottom line of the display and press OK.

4. Press the left/right arrow until Poster Copy appears 
and press OK.

5. Press the left/right arrow to select the color mode you 
want.
There are two types of mode as following:
• Yes-Color: Color copy
• Yes-Mono: Black and White copy

6. Press OK to begin copying.
Your original is divided into 9 portions. Each portion is 
scanned and printed one by one in the following order:

Clone copying
Your printer can print multiple image copies from the original document on a 
single page. The number of images is automatically determined by the 
original image and paper size.
This copy feature is available only when you place originals on the scanner 
glass.
1. Press Copy.
2. Place a single original face down on the scanner glass. 

For details about loading an original, see "Loading 
originals" on page 23.

3. Press Menu ( ) until Copy Feature appears on the 
bottom line of the display and press OK.

4. Press the left/right arrow until Clone Copy appears 
and press OK.

5. Press the left/right arrow to select the color mode you want.
There are two types of mode as following:
• Yes-Color: Color copy
• Yes-Mono: Black and White copy

6. Press OK to begin copying.

Adjusting background images
You can set the printer to print an image without its background. This copy 
feature removes the background color and can be helpful when copying an 
original containing color in the background, such as a newspaper or a 
catalog. 
1. Press Copy.
2. Load originals face up into the DADF, or place a single original face 

down on the scanner glass.
For details about loading an original, see "Loading originals" on 
page 23.

3. Press Menu ( ) until Copy Feature appears on the bottom line of the 
display and press OK.

4. Press the left/right arrow until Adjust Bkgd. appears and press OK.
5. Press the left/right arrow until the binding option you want appears.

• Off: Does not use this feature.
• Auto: Optimizes the background.
• Enhance Lev. 1~2: The higher the number is, the more vivid the 

background is.
• Erase Lev. 1~4: The higher the number is, the lighter the 

background is.
6. Press OK to begin copying.
7. Press Stop/Clear ( ) to return to Ready mode.

Book copying
The Book Copy feature allows you to copy an entire book. If the book is too 
thick, lift the cover until its hinges are caught by the stopper and then close 
the cover. If the book or magazine is thicker than 30 mm, start copying with 
the cover open.
1. Press Copy.
2. Place a single original face down on the scanner glass. 

For details about loading an original, see "Loading 
originals" on page 23.

3. Press Menu ( ) until Copy Feature appears on the 
bottom line of the display and press OK.

4. Press OK when Book Copy appears.
5. Press the left/right arrow until the binding option you 

want appears.
• Off: Does not use this feature.
• Left Page: Use this option to print left page of the book.
• Right Page: Use this option to print right page of the book.
• Both Page: Use this option to print both pages of the book.

6. Press the left/right arrow  to select the color mode you want.
There are two types of mode as following:
• Yes-Color: Color copy
• Yes-Mono: Black and White copy

7. Press OK to begin copying.

You cannot adjust the copy size using the Reduce/Enlarge ( ) 
button while making a clone copy.
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Margin shift
The Margin Shift feature allows you to create a binding edge for the 
document. The image can be adjusted up or down on the page and/or 
shifted to the right or left.

1. Press Copy.
2. Load originals face up into the DADF, or place a single 

original face down on the scanner glass.
For details about loading an original, see "Loading 
originals" on page 23.

3. Press Menu ( ) until Copy Feature appears on the 
bottom line of the display and press OK.

4. Press OK when Margin Shift appears.
5. Press the left/right arrow until the binding option you want appears.

• Off: This feature is disabled.
• Auto Center: Automatically copy in the center of the paper.
• Custom Margin: Enter the left, right, top, bottom margin using 

Number keypad.
6. Press the left/right arrow to select Yes.
7. Press OK to begin copying.
8. Press Stop/Clear ( ) to return to Ready mode.

Edge erase
Edge erase allows you to erase sports, drill holes, fold creases and staple 
marks along any of the four edges of a document.

1. Press Copy.
2. Load originals face up into the DADF, or place a single 

original face down on the scanner glass.
For details about loading an original, see "Loading 
originals" on page 23.

3. Press Menu ( ) until Copy Feature appears on the 
bottom line of the display and press OK.

4. Press OK when Edge Erase appears.
5. Press the left/right arrow until the binding option you want appears.

• Off: Does not set the binding option.
• Small Original: Erases the edge of the original if it is small.
• Hole Punch: Erases the marks of bookbinding holes.
• Book Center: Erases the middle part of the paper which is black 

and horizontal, when you copy a book.
• Border Erase: Erases the certain amount of the edge of the 

printout.
6. Press OK to begin copying.
7. Press Stop/Clear ( ) to return to Ready mode.

Gray enhance copying
When you copy the original in gray scale, use this feature for the better 
quality of copy-output. This feature is only for the copy in gray scale.
1. Press Copy.
2. Load originals face up into the DADF, or place a single original face 

down on the scanner glass. 
For details about loading an original, see "Loading originals" on 
page 23.

3. Press Menu ( ) until Copy Feature appears on the bottom line of the 
display and press OK.

4. Press OK when Gray Enhance appears.
5. Press the left/right arrow to select On.
6. Press OK to begin copying.
7. Press Stop/Clear ( ) to return to Ready mode.

PRINTING ON BOTH SIDES OF PAPER
By using the Duplex ( ) button on your printerprinter, you can set the 
printer to print documents on both sides of paper. 
1. Press Copy.

2. Press Duplex ( ).
3. Press the left/right arrow until the binding option you want appears.

• Off: Copys in Normal mode.
• 1->2Side Short: Copys pages to be read by flipping like a note pad.

• 1->2Side Long: Copys pages to be read like a book.

• 2 ->1Side: Copys both sides of the originals and prints each of one on 
a separate sheet.

• 2 ->2Side: Copys both sides of the original and prints on both sides 
of the paper. This function produces exactly the same print out from 
the originals.

• 2 ->1Side ROT2: Copys both sides of the original and prints each one 
on a separate sheet, but the information on the back side of the printout 
is rotated 180°.

4. Press OK to save your selection.
If the mode is enabled, the Duplex ( ) button is backlit.

The Margin Shift feature can either be used for Scan glass or DADF 
depending on the set up.
-Auto Center: Scanner glass
-Custom Margin: Scanner glass, DADF

The Edge Erase feature can either be used for scan glass or DADF 
depending on the set up.
-Small Original: Scanner glass
-Hole Punch: Scanner glass, DADF
-Book Center: Scanner glass
-Border Erase: Scanner glass, DADF



Copying | 35

SETTING COPY TIMEOUT
You can set the time the printer waits before it restores the default copy settings, 
if you do not start copying after changing them on the control panel.
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK. 
2. Press OK when Machine Setup appears.
3. Press the left/right arrow until Timeout appears and press OK.
4. Press the left/right arrow until the time setting you want appears.

Selecting Off means that the printer does not restore the default settings 
until you press Black Start ( ) or Color Start ( )  to begin copying, 
or Stop/Clear ( ) to cancel.

5. Press OK to save your selection.
6. Press Stop/Clear ( ) to return to Ready mode.
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scanning
Scanning with your printer lets you turn pictures and text into digital files that can be stored on your computer. 

This chapter includes:
• Scanning basics
• Scanning from the control panel
• Scanning by a network connection
• Changing the settings for each scan job

• Changing the default scan settings
• Setting up address book
• Scan on both sides of paper

SCANNING BASICS
You can scan the originals with your printer via an USB cable or the 
network. 
• Dell Scan Manager: You just walk to the printer with the originals and 

scan them from the control panel then, the scanned data will be stored in 
the connected computers My Documents folder. When the setup 
installation is completed, then you have installed the Dell Scan 
Manager on your computer already. This feature can be used via the 
local connection or the network connection. See next section.

• TWAIN: TWAIN is the one of preset imaging applications. Scanning an 
image launches the selected application, enabling you to control the 
scanning process. This feature can be used via the local connection or 
the network connection. See Software section.

• Dell SmarThru Office : This feature is the accompanying software for 
your printer. You can use this program to scan images or documents, 
and this feature can be used via the local connection or the network 
connection. See Software section.

• WIA: WIA stands for Windows Images Acquisition. To use this feature 
your computer must be connected directly with the printer via an USB 
cable. See Software section.

• Email: You can send the scanned image as an attachment to an email. 
See "Scanning to Email" on page 38.

• FTP: You can scan an image and upload it to an FTP server. See 
"Scanning to an FTP server" on page 39.

• SMB: You can scan an image and send it to a shared folder on an SMB 
server. See "Scanning to an SMB server" on page 39.

SCANNING FROM THE CONTROL PANEL
Your printer offers you to scan from the control panel and easily send the 
scanned document to connected computer's My Documents folder. In 
order to use this function, your printer and computer must be connect by 
USB cable or by network. 
Also, with the offered Dell Scan Manager program, scanned documents 
can be opened with the program you have setup previously. Such as 
Microsoft Paint, Email, SmarThru Office, OCR can be added to application 
program. See "Setting scan information in Dell Scan Manager." on page 36.

Scanned images can be saved as BMP, JEPG, TIFF, PDF files. 

Setting scan information in Dell Scan Manager.
You can find out about Dell Scan Manager program information and 
installed scan driver's condition. Also, you can change scan settings and 
add or delete the folders where scanned documents to computer are save in 
Dell Scan Manager program. 

1. Press Start → Control Panel → Dell Scan Manager.
Dell Scan Manager Administration appears.

2. Select the appropriate printer from the Dell Scan Manager.
3. Press Scan Property.
4. Set Scan Button allows you to change the saving destination and scan 

settings, add or delete application program and format files. 
You can change the scanning printer by using Change Port. (Local or 
Network) 

5. Press OK after setting is done.

Scanning to application programs
1. Ensure that your printer and computer are turned on and properly 

connected to each other.
2. Load originals face up into the DADF, or place a single original face 

down on the scanner glass.
For details about loading an original, see "Loading originals" on 
page 23.

3. Press Scan/Email.
Ready to Scan appears on the top line of the display.

4. Press the left/right arrow until Scan to PC appears on the bottom line of 
the display and press OK.

5. Press the left/right arrow until the option you want appears and press 
OK. 

6. Depending on the port connection, different massages appear. Check 
the following messages and move on to the next step. 
• Scan Destination: Connected by USB. Move to step 7.
• ID: Connected by Network and user is registered. Move to step 8.

The maximum resolution that can be achieved depends upon various 
factors, including computer speed, available disk space, memory, the 
size of the image being scanned, and bit depth settings. Thus, 
depending on your system and what you are scanning, you may not 
be able to scan at certain resolutions, especially using enhanced 
resolution.

Dell Scan Manager program can only be used in the Windows.
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• Local PC : Choosing USB or Network to scan. If connected by 
USB, move to step 7. If connected by Network, move to step 8. 

• Not Available: Neither connected by USB nor Network. Check the 
port connection.

7. Press the left/right arrow until the port you want appears on the display. 
8. Enter the registered user ID and PIN and click OK. 

9. From Scan Destination, press the left/right arrow until the application 
program you want appears, then press OK. 
Default setting is My Documents.

10. To scan from the default setting, press Color Start ( ) or Black Start 
( ) . Press the left/right button until the setting you want appears then 
press OK. 

11. Scanning begins. 

SCANNING BY A NETWORK CONNECTION
If you have connected your printer to a network and set up the network 
parameters correctly, you can scan and send images over the network.

Preparing for network scanning
Before using your printer’s network scanning features, you need to 
configure the following settings, depending on your scan destination:
• Register as an authorized user for scanning to email, FTP,  or SMB
• Set up the SMTP server for scanning to email
• Set up the FTP servers for scanning to FTP
• Set up the SMB servers for scanning to SMB

User authentication for network scanning
To send an email, FTP, SMB or Network, you must register authorized 
local or network users using Embedded Web Service. 
• If user authentication has been activated, only authorized local users 

or on the DB server (SMB, LDAP, Kerberos) can send scanned data 
to the network (email, FTP, SMB, Network).

• For network scanning using the authentication feature, you must 
register the network or local authentication configuration using the  
Embedded Web Service.

• User authentication has 3 options: none (Default), network 
authentication, and local authentication.

Registering local authorized users
1. Enter your printer’s IP address as the URL in a browser and click Go 

to access the web site of your printer.
2. Click Machine Settings.
3. Select Local Authentication on the General Setup of the User 

Authentication web page.
4. Click Add.

5. Select an index number corresponding to the location for storing the 
entry, from 1 to 50.

6. Enter your name, auth ID, password, e-mail address and phone 
number.
You need to enter the registered user ID and password in the printer 
when you start scanning to email from the control panel.

7. Click Apply.

Register authorized network users
1. Enter your printer’s IP address as the URL in a browser and click Go 

to access the web site of your printer.
2. Click Machine Settings. 
3. Select Network Authentication on the General Setup of User 

Authentication web page.
4. Click Apply and OK.
5. Select the Authentication Type that you prefer. 
6. Configure the values for each feature, as follows.
7. Click Apply. 

Network user authenticated by Kerberos
1. Enter the realm used for Kerberos login.
2. Select IP Address or Host Name.
3. Enter the IP address in dotted decimal notation or as a host name.
4. Enter the server port number, from 1 to 65535.

The default port number is 88.
5. You can add a backup domain as a previous step.
6. Click Apply.

Network user authorized by SMB
1. Enter the domain that is used for SMB login.
2. Select IP Address or Host Name.
3. Enter the IP address in dotted decimal notation or as a host name.
4. Enter the server port number, from 1 to 65535.

The default port number is 139.
5. You can add a backup domain as a previous step.
6. Click Apply.

Network authorized user by LDAP
1. Enter your printer’s IP address as the URL in a browser and click Go 

to access the web site of your printer.
2. Click Machine Settings and LDAP Server Setup.
3. Select IP Address or Host Name.
4. Enter the IP address in dotted decimal notation or as a host name.
5. Enter the server port number, from 1 to 65535.

The default port number is 389.
6. Enter Search Root Directory, the top search level of the LDAP 

directory tree.
7. Select Authentication method. Two options for LDAP server login.

 Anonymous:This is used to bind with null password and login ID 
(Password and login ID are grayed out in Embedded Web Service).
Simple: This is used to bind with the login ID and password in 
Embedded Web Service.

8. Check the box next to Append Root to Base DN.
9. Select Match User’s Login ID to the following LDAP attribute 

(options are CN, UID, or UserPrincipalName).

• ID is the same ID as the registered ID for Dell Scan Manager.
• PIN is the 4 digit number registered for Dell Scan Manager. 

To add or delete the folder where the scanned file is saved, add or 
delete the application program in Dell Scan Manager → Set Scan 
Button. 

• Scanned image is saved in computer's My Documents → My 
Pictures → Dell folder. 

• You can use Tawin driver to scan quickly in Dell Scan 
Manager program. 

• You can also scan by pressing Window's Start → Control 
Panel → Dell Scan Manager → Quick Scan.

User can add up to 6 alternate domains.
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10. Enter your login name, password, maximum number of search 
results and search timeout.

11. Select Serach Name Order that you desire.
12. Check the box next to  "From:" Field Security Options. 

13. Click Apply. 

Setting up an e-mail account
To scan and send an image as an email attachment, you need to set up 
network parameters using Embedded Web Service.
1. Enter your printer’s IP address as the URL in a browser and click Go 

to access the web site of your printer.
2. Click Machine Settings and E-mail Setup.
3. Select IP Address or Host Name.
4. Enter the IP address in dotted decimal notation or as a host name.
5. Enter the server port number, from 1 to 65535.

The default port number is 25.
6. Check the box next to SMTP Requires Authentication to require 

authentication.
7. Enter the SMTP server login name and password.
8. Click Apply.

Setting up an FTP server
To use an FTP server, you need to set up parameters to access the FTP 
servers using Embedded Web Service.
1. Enter your printer’s IP address as the URL in a browser and click Go 

to access the web site of your printer.
2. Click Machine Settings and FTP Setup.
3. Click Server List.
4. Click Add.
5. Select the index number, from 1 to 20.
6. Enter a name in Alias for the Setup for the corresponding Server 

List entry. This name will be displayed on your printer.
7. Select IP Address or Host Name.
8. Enter the server address in dotted decimal notation or a host name.
9. Enter the server port number, from 1 to 65535.

The default port number is 21.
10. Check the box next to Anonymous if you want the FTP server to 

permit access to unauthorized persons. It is unchecked by default.
11. Enter the login name and password.
12. Enter the Scan File Folder under FTP directory for saving the 

scanned image.
13. Click Apply.

Setting up an SMB server
To use an SMB server, you need to set up parameters for access to 
SMB servers using Embedded Web Service.
1. Enter your printer’s IP address as the URL in a browser and click Go 

to access the web site of your printer.
2. Click Machine Settings and SMB Setup.
3. Click Server List.
4. Click Add.
5. Select the index number, from 1 to 20.
6. Enter a name in Alias for the Setup for the corresponding Server 

List entry. This name will be displayed on your printer.
7. Select IP Address or Host Name.
8. Enter the server address in dotted decimal notation or a host name.
9. Enter the server port number, from 1 to 65535.

The default port number is 139.
10. Enter the Share name of the server.
11. Check the box next to Anonymous if you want to permit 

unauthorized persons to access the SMB server. This box is 
unchecked by default.

12. Enter the login name and password.
13. Enter the domain name of the SMB server.
14. Enter the Scan File Folder under shared folder for storing the 

scanned image.
15. Click Apply.

Scanning to Email
You can scan and send an image as an email attachment. You first need to 
set up your email account in Embedded Web Service. See "Setting up an e-
mail account" on page 38.
Before scanning, you can set the scan options for your scan job. See "Changing 
the settings for each scan job" on page 39.
1. Ensure that your printer is connected to a network.
2. Load originals face up into the DADF, or place a single original face 

down on the scanner glass.
For details about loading an original, see "Loading originals" on 
page 23.

3. Press Scan/Email.
4. Press the left/right arrow until Scan to Email appears on the bottom line 

of the display and press OK.
5. Enter the recipient’s email address and press OK.

If you have set up Address Book, you can use a speed button or a speed email 
or group email number to retrieve an address from memory. See "Setting up 
address book" on page 39.

6. To enter additional addresses, press OK when Yes appears and repeat 
step 5.
To continue to the next step, press the left/right arrow to select No and 
press OK. 

7. If the display asks if you want to send the email to your account, press 
the left/right arrow to select Yes or No and press OK.

8. Enter an email subject and press OK.
9. Press the left/right arrow until the file format you want appears and press 

OK or Start.
The printer begins scanning and then sends the email. 

10. If the printer asks if you want to log off your account, press the left/right 
arrow to select Yes or No and press OK.

11. Press Stop/Clear ( ) to return to Ready mode.

LDAP Referral: LDAP client will search referral server if the 
LDAP server has no data to reply to query and if the LDAP server 
has a referral server.

This option is only provided if you have selected the Network 
authentication option in the user authentication setting. You may 
check this option if you want to search for information in a default 
email address group.

If the authentication method of SMTP server is 
POP3beforeSMTP, check the box next to SMTP Requires POP3 
Before SMTP Authentication.
a. Enter the IP address in dotted decimal notation or as a host 

name. 
b. Enter the server port number, from 1 to 65535. The default 

port number is 25.

This prompt does not appear if you have activated the Send To 
Self option in the email account setup.
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Scanning to an FTP server
You can scan an image and then upload it to an FTP server. You need to 
set up parameters for access to FTP servers from Embedded Web Service. 
See "Setting up an FTP server" on page 38.
Before scanning, you can set the scan options for your scan job. See "Changing 
the settings for each scan job" on page 39.
1. Ensure that your printer is connected to a network.
2. Load originals face up into the DADF or place a single original on the 

scanner glass.
For details about loading an original, see "Loading originals" on 
page 23.

3. Press Scan/Email.
4. Press the left/right arrow until Scan to FTP appears on the bottom line 

of the display and press OK.
5. Enter the user ID and press OK.
6. Enter the password and press OK.
7. Press the left/right arrow until the FTP server you want appears and 

press OK or Start.
8. Press the left/right arrow until the file type you want appears and press 

OK or Start.
The printer begins scanning and then sends the file to the specified 
server.

Scanning to an SMB server
You can scan an image and then send it to an SMB server. You need to set 
up parameters for access to SMB servers from Embedded Web Service. 
See "Setting up an SMB server" on page 38.
Before scanning, you can set the scan options for your scan job. See 
"Changing the settings for each scan job" on page 39.
1. Ensure that your printer is connected to a network.
2. Load originals face up into the DADF or place a single original on the 

scanner glass.
For details about loading an original, see "Loading originals" on 
page 23.

3. Press Scan/Email.
4. Press the left/right arrow until Scan to SMB appears on the bottom line 

of the display and press OK.
5. Enter the user ID and press OK.
6. Enter the password and press OK.
7. Press the left/right arrow until the SMB server you want appears and 

press OK or Start.
8. Press the left/right arrow until the file format you want appears and press 

OK or Start.
The printer begins scanning and then sends the file to the specified 
server.

CHANGING THE SETTINGS FOR EACH SCAN JOB
Your printer provides you with the following setting options to allow you to 
customize your scan jobs.
• Scan Size: Sets the image size.
• Original Type: Sets the original document’s type.
• Resolution: Sets the image resolution.
• Scan Color: Sets the color mode.
• Scan Format: Sets the file format in which the image is to be saved. If 

you select TIFF or PDF, you can select to scan multiple pages. 
Depending on the selected scan type, this option may not appear.

To customize the settings before starting a scan job:

1. Press Scan/Email.
2. Press Menu ( ) until Scan Feature appears on the bottom line of the 

display and press OK.
3. Press the left/right arrow until the scan type you want appears and press 

OK.
4. Press the left/right arrow until the scan setting option you want appears 

and press OK.
5. Press the left/right arrow until the desired status appears and press OK.
6. Repeat steps 4 and 5 to set other setting options.
7. When you have finished, press Stop/Clear ( ) to return to Ready mode.

CHANGING THE DEFAULT SCAN SETTINGS
To avoid having to customize the scan settings for each job, you can set up 
default scan settings for each scan type.
1. Press Scan/Email.
2. Press Menu ( ) until Scan Setup appears on the bottom line of the 

display and press OK.
3. Press OK when Change Default appears.
4. Press the left/right arrow until the scan type you want appears and press OK.
5. Press the left/right arrow until the scan setting option you want appears 

and press OK.
6. Press the left/right arrow until the desired status appears and press OK.
7. Repeat steps 5 and 6 to change other settings.
8. To change the default settings for other scan types, press Back ( ) 

and repeat from step 4.
9. Press Stop/Clear ( ) to return to Ready mode.

PRINTING SCAN CONFIRMATION REPORT 
AUTOMATICALLY
You can set your printer to print a confirmation report showing whether a 
transmission was successful, how many pages were sent, and more. The 
report shows the job of scanning and sending it via SMB and FTP. 
1. Press Scan/Email.
2. Press Menu ( ) until Scan Setup appears on the bottom line of the 

display and press OK.
3. Press OK when Send Report appears.
4. Press the left/right arrow until the scan setting option you want appears 

and press OK.
• On-Error: Only in case of error occurrence, the printer prints the report.
• On: The report is printed whether a job successfully completed or 

failed.
• Off: No report is printed after completing a job.

5. Press Stop/Clear ( ) to return to Ready mode.

SETTING UP ADDRESS BOOK
You can set up Address Book with the email addresses you use frequently via 
Embedded Web Service and then easily and quickly enter email addresses by 
entering the location numbers assigned to them in Address Book.

Registering speed email numbers
1. Enter your printer’s IP address as the URL in a browser and click Go to 

access the web site of your printer.
2. Click Machine Settings and E-mail Setup.
3. Click Individual Address Book and Add.
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4. Select a location number and enter the user name and e-mail address 
you want.

5. Click Apply.

Configuring group email numbers
Enter your printer’s IP address as the URL in a browser and click Go to 
access the web site of your printer.
1. Click Machine Settings and E-mail Setup.
2. Click Group Address Book and Add.
3. Select a group number and enter the group name you want.
4. Select speed email numbers that will be included in the group.
5. Click Apply.

Retrieving global email addresses from the LDAP 
server
You can use not only local addresses stored in your printer's memory but 
also ones in the LDAP server. To use the global addresses, configure the 
LDAP server first via Embedded Web Service as following:
1. Enter your printer’s IP address as the URL in a browser and click Go to 

access the web site of your printer.
2. Click Machine Settings, LDAP Server Setup.
3. Select IP Address or Host Name.
4. Enter the IP address in dotted decimal notation or as a host name.
5. Enter the server port number, from 1 to 65535.

The default port number is 389.
6. Enter Search Root Directory. The top search level of the LDAP 

directory tree.
7. Select Authentication method. Method of LDAP server login.

 Anonymous: This is used to bind with NULL password and login ID 
(Password and login ID are grayed in Embedded Web Service).

Simple: This is used to bind with the login ID and password in 
Embedded Web Service.

8. Put a check mark of Append Root to Base DN for adding Base DN to 
login name.

9. Enter your login name, password, maximum number of search results 
and search timeout.

10. Select Serach Name Order that you want.
11. Put a check mark of "From:" Field Security Options.
12. Click Add.

Using address book entries
To retrieve an email address, use the following ways:

Speed email numbers
When you are prompted to enter a destination address while sending an 
email, enter the speed email number at which you stored the address 
you want.
• For a one-digit speed email location, press and hold the 

corresponding digit button from the number keypad.
• For a two- or three-digit speed email location, press the first digit 

button(s) and then hold down the last digit button.

You can also search through memory for an entry by pressing Address 
Book. See "Searching address book for an entry" on page 40.

Group email numbers
To use a group email entry, you need to search for and select it from 
memory.
When you are prompted to enter a destination address while sending an 
email, press Address Book . See "Searching address book for an 
entry" on page 40.

Global email addresses
To use a global email addresses in the LDAP server, you need to search 
for and select it from memory.
When you are prompted to enter a destination address while sending an 
email, press Address Book . See "Setting up address book" on 
page 39. 

Searching address book for an entry
There are two ways to search for an address in memory. You can either 
scan from A to Z sequentially or search by entering the first letters of the 
name associated with the address.

Searching sequentially through memory
1. If necessary, press Scan/Email.

2. Press Address Book  until Search & Send appears on the 
bottom line of the display and press OK.

3. Press the left/right arrow until the number category you want 
appears and press OK.

4. Press OK when All appears.
5. Press the left/right arrow until the name and address you want 

appears. You can search upwards or downwards through the entire 
memory in alphabetical order.

Searching with a particular first letter
1. If necessary, press Scan/Email.

2. Press Address Book  until Search & Send appears on the 
bottom line of the display and press OK.

3. Press the left/right arrow until the number category you want 
appears and press OK.

4. Press the left/right arrow until ID appears and press OK.
5. Enter the first few letters of the name you want and press OK.
6. Press the left/right arrow until the name you want appears and press 

OK.

Printing address book
You can check your Address Book  settings by printing a list.

1. Press Address Book  until Print appears on the bottom line of the 
display.

2. Press OK.
A list showing your speed button settings, and the speed/group email 
entries print out.

You can also click Import and obtain your address book from your 
computer.

LDAP Referral: LDAP client will search referral server in case 
LDAP server has no data to reply of query and LDAP server has 
any referral server.
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SCAN ON BOTH SIDES OF PAPER
By using the Duplex ( ) button on your printer, you can set the printer to 
scan on both sides of paper.

1. Press Duplex ( ).
2. Press the left/right arrow until the binding option you want appears.

• Off: Scans in Normal mode.
• 2 Side: Scans both sides of the original.
• 2 ->1Side ROT2: Scans both sides of the original and prints each one on 

a separate sheet, but the information on the back side of the printout is 
rotated 180°.

3. Press OK to save your selection.
If the mode is enabled, the Duplex ( ) button is backlit.
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basic printing
This chapter explains common printing tasks.

This chapter includes:
• Printing a document • Canceling a print job

PRINTING A DOCUMENT
Your printer allows you to print from various Windows, Macintosh, or Linux 
applications. The exact steps for printing a document may vary depending 
on the application you use.
For details about printing, see the Software section.

CANCELING A PRINT JOB
If the print job is waiting in a print queue or print spooler, such as the printer 
group in Windows, delete the job as follows:
1. Click the Windows Start menu.
2. For Windows 2000, select Settings and then Printers.

For Windows XP/2003, select Printers and Faxes.
For Windows Vista/2008, select Control Panel → Hardware and 
Sound → Printers.

3. Double-click the Dell 2145cn Color Laser MFP icon.
4. From the Document menu, select Cancel.

You can also cancel the current job by pressing Stop/Clear ( ) on the 
control panel.

You can also access this window by simply double-clicking the printer 
icon at the bottom right corner of the Windows desktop.



Faxing | 43

faxing
This chapter gives you information about using your printer as a fax printer. 

This chapter includes:
• Sending a fax
• Receiving a fax

• Other ways to fax
• Fax setup

SENDING A FAX
Setting the fax header
In some countries, you are required by law to indicate your fax number on 
any fax you send. The printer ID, containing your telephone number and 
name or company name, will be printed at the top of each page sent from 
your printer.
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press OK when Machine Setup appears.
3. Press OK when Machine ID appears.
4. Enter your name or the company name using the number keypad. You 

can enter alphanumeric characters using the number keypad, and 
include special symbols by pressing the 0 button. For details on how to 
enter alphanumeric characters. See "Entering characters using the 
number keypad" on page 21.

5. Press OK to save the ID.
6. Press the left/right arrow until Machine Fax No appears and press OK.
7. Enter your fax number using the number keypad and press OK.
8. Press Stop/Clear ( ) to return to Ready mode.

Adjusting the document settings
Before starting a fax, change the following settings according to your 
original’s status to get the best quality.

Resolution
The default document settings produce good results when using typical 
text-based originals. However, if you send originals that are of poor 
quality, or contain photographs, you can adjust the resolution to produce 
a higher quality Fax.

1. Press Resolution. 
2. Press Resolution or the left/right arrow until the option you want 

appears.
3. Press OK to save your selection.
Recommended resolution settings for different original document types 
are described in the table below:

Darkness
You can select the default contrast mode to fax your originals lighter or 
darker.
1. Press Fax.
2. Press Menu ( ), and then OK when Fax Feature appears on the 

bottom line of the display.
3. Press OK when Darkness appears.
4. Press the left/right arrow until the option you want appears and press 

OK.
5. Press Stop/Clear ( ) to return to Ready mode.

It is recommended that you use traditional analog phone services 
(PSTN: public switched telephone network) when connecting 
telephone lines to use Fax. If you use other Internet services (DSL, 
ISDN, VolP), you can improve the connection quality by using the 
Micro-filter. The Micro-filter eliminates unnecessary noise signals and 
improves connection quality or Internet quality. Since the DSL Micro-
filter is not provided with the printer, contact your Internet Service 
provider for use on DSL Micro-filter.

1 Line port
2 Micro filter
3 DSL modem / Telephone line

MODE RECOMMENDED FOR:

Standard Originals with normal sized characters.

Fine Originals containing small characters or thin 
lines or originals printed using a dot-matrix 
printer.

Super Fine Originals containing extremely fine detail. Super 
Fine mode is enabled only if the printer with 
which you are communicating also supports the 
Super Fine resolution.

• For memory transmission, Super Fine 
mode is not available. The resolution 
setting is automatically changed to 
Fine.

• When your printer is set to Super Fine 
resolution and the fax printer with which 
you are communicating does not 
support Super Fine resolution, the 
printer transmits using the highest 
resolution mode supported by the other 
fax printer.

Photo Fax Originals containing shades of gray or 
photographs.

The resolution setting is applied to the current fax job. To change the 
default setting. See "Changing the default document settings" on 
page 49.

The darkness setting is applied to the current fax job. To change 
the default setting. See "Changing the default document 
settings" on page 49.
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Sending a fax automatically
1. Press Fax.
2. Load originals face up into the DADF, or place a single original face 

down on the scanner glass. 
For details about loading an original. See "Loading originals" on 
page 23.
Ready to Fax appears on the top line of the display.

3. Adjust the resolution and the darkness to suit your fax needs.
4. Enter the receiving fax printer’s number. 

You can use speed buttons, speed dial numbers, or group dial numbers. 
For details about storing and searching for a number. See "Setting up 
address book" on page 49.

5. Press Color Start ( ) or Black Start ( ) .
6. If an original is placed on the scanner glass, select Yes to add another 

page. Load another original and press OK.
7. When you have finished, select No at the Another Page? prompt. 

After the number is dialed, the printer begins sending the fax when the 
receiving fax printer answers.

Sending a fax manually
1. Press Fax.
2. Load originals face up into the DADF, or place a single original face 

down on the scanner glass.
For details about loading an original. See "Loading originals" on 
page 23..

3. Adjust the resolution and the darkness to suit your fax needs. See 
"Adjusting the document settings" on page 43.

4. Press On Hook Dial ( ). You hear a dial tone.
5. Enter the receiving fax printer’s number.

You can use speed buttons, speed dial numbers, or group dial numbers. 
For details about storing and searching for a number. See "Setting up 
address book" on page 49..

6. Press Color Start ( ) or Black Start ( )  when you hear a high-
pitched fax signal from the remote fax printer.

Confirming a transmission 
When the last page of your original has been sent successfully, the printer 
beeps and returns to Ready mode. 
When something goes wrong while sending your fax, an error message 
appears on the display. For a list of error messages and their meanings. 
See "Understanding display messages" on page 70. If you receive an error 
message, press Stop/Clear ( ) to clear the message and try to send the 
fax again.
You can set your printer to print a confirmation report automatically each 
time sending a fax is completed. For further details,  see "Send Report" on 
page 48.

Automatic redialing
When the number you have dialed is busy or there is no answer when you 
send a fax, the printer automatically redials the number every three minutes, 
up to seven times according to the factory default settings.
When the display shows Retry Redial?, press OK to redial the number 
without waiting. To cancel the automatic redialing, press Stop/Clear ( ).
To change the time interval between redials and the number of redial 
attempts. See "Receiving options" on page 48.

Redialing the last number
To redial the number you called last:
1. Press Redial/Pause.
2. When an original is loaded in the DADF, the printer automatically begins 

to send.
If an original is placed on the scanner glass, select Yes to add another 
page. Load another original and press OK. When you have finished, 
select No at the Another Page? prompt.

Sending faxes on both sides of paper
You can set the printer to send faxes on both sides of paper.
1. Press Fax.

2. Press Duplex ( ).
3. Press the left/right arrow until the binding option you want appears.

• Off: Send faxes in Normal mode.
• 2 Side: Send faxes on both sides of the original.
• 2 ->1Side ROT2: Send faxes on both sides of the original and prints 

each one on a separate sheet, but the information on the back side 
of the printout is rotated 180°. 

4. Press OK to save your selection.
If the mode is enabled, the Duplex ( ) button is backlit.

RECEIVING A FAX
Selecting the paper tray
After loading the print media for fax output, you have to select the paper tray 
you will use for the fax reception.
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press the left/right arrow until Paper Setup appears and press OK.
3. Press the left/right arrow until Paper Source appears and press OK.
4. Press the left/right arrow until Fax Tray appears and press OK.
5. Press the left/right arrow until the paper tray you want appears and 

press OK.
6. Press Stop/Clear ( ) to return to Ready mode.

Changing receiving modes
1. Press Fax.
2. Press Menu ( ) until Fax Setup appears on the bottom line of the 

display and press OK.
3. Press the left/right arrow until Receiving appears and press OK.
4. Press OK when Receive Mode appears.
5. Press the left/right arrow until the fax reception mode you want appears.

• In Fax mode, the printer answers an incoming fax call and 

When you want to cancel a fax job, press Stop/Clear ( ) at any time 
while sending.

When you want to cancel a fax job, press Stop/Clear ( ) at any time 
while sending.
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immediately goes into the fax reception mode. 
• In Tel mode, you can receive a fax by pressing On Hook Dial ( ) 

and then Color Start ( ) or Black Start ( ) . You can also pick up 
the handset of the extension phone and then press the remote 
receive code. See "Receiving manually using an extension 
telephone" on page 45. 

• In Ans/Fax mode, an answering printer attached to your printer 
answers an incoming call, and the caller can leave a message on the 
answering printer. If the fax printer senses a fax tone on the line, the 
printer automatically switches to Fax mode to receive the fax.  See 
"Receiving automatically in Ans/Fax mode" on page 45.

• In DRPD mode, you can receive a call using the Distinctive Ring 
Pattern Detection (DRPD) feature. Distinctive Ring is a telephone 
company service which enables an user to use a single telephone 
line to answer several different telephone numbers. For further 
details. See "Receiving faxes using DRPD mode" on page 45.

6. Press OK to save your selection.
7. Press Stop/Clear ( ) to return to Ready mode.

Receiving automatically in Fax mode 
Your printer is preset to Fax mode at the factory. When you receive a fax, 
the printer answers the call on a specified number of rings and automatically 
receives the fax. 
To change the number of rings. See "Ring To Answer" on page 48.

Receiving manually in Tel mode 
You can receive a fax call by pressing On Hook Dial ( ) and then pressing 
Black Start ( ) or Color Start ( ) when you hear a fax tone from the 
remote printer.
The printer begins receiving a fax and returns to Ready mode when the 
reception is completed.

Receiving manually using an extension telephone
This features works best when you are using an extension telephone 
connected to the EXT socket on the back of your printer. You can receive a 
fax from someone you are talking to on the extension telephone without 
going to the fax printer.
When you receive a call on the extension phone and hear fax tones, press 
the keys *9* on the extension phone. The printer receives the fax.
Press the buttons slowly in sequence. If you still hear the fax tone from the 
remote printer, try pressing *9* once again.
*9* is the remote receive code preset at the factory. The first and the last 
asterisks are fixed, but you can change the middle number to whatever you 
wish. For details about changing the code. See "Rcv Start Code" on 
page 49.

Receiving automatically in Ans/Fax mode 
To use this mode, you must attach an answering printer to the EXT socket 
on the back of your printer. 
If the caller leaves a message, the answering printer stores the message as 
it would normally. If your printer detects a fax tone on the line, it 
automatically starts to receive the fax.

Receiving faxes using DRPD mode
This setting may not be available depending on your country. Distinctive 
Ring is a telephone company service which enables an user to use a single 
telephone line to answer several different telephone numbers. The 
particular number someone uses to call you is identified by different ringing 
patterns, which consist of various combinations of long and short ringing 
sounds. This feature is often used by answering services who answer 
telephones for many different clients and need to know which number 
someone is calling in on to properly answer the phone.
Using the Distinctive Ring Pattern Detection (DRPD) feature, your fax 
printer can learn the ring pattern you designate to be answered by the fax 
printer. Unless you change it, this ringing pattern will continue to be 
recognized and answered as a fax call, and all other ringing patterns will be 
forwarded to the extension telephone or answering printer plugged into the 
EXT socket. You can easily suspend or change DRPD at any time.
Before using the DRPD option, Distinctive Ring service must be installed on 
your telephone line by the telephone company. To set up DRPD, you will 
need another telephone line at your location, or someone available to dial 
your fax number from outside. 
To set up the DRPD mode:
1. Press Fax.
2. Press Menu ( ) until Fax Setup appears on the bottom line of the 

display and press OK.
3. Press the left/right arrow until Receiving appears and press OK.
4. Press the left/right arrow until DRPD Mode appears and press OK. 

Waiting Ring appears on the display.
5. Call your fax number from another telephone. It is not necessary to 

place the call from a fax printer. 
6. When your printer begins to ring, do not answer the call. The printer 

requires several rings to learn the pattern. 
When the printer completes learning, the display shows Completed 
DRPD Setup. If the DRPD setup fails, Error DRPD Ring appears. 
Press OK when DRPD Mode appears and start over from step 4.

7. Press Stop/Clear ( ) to return to Ready mode.

• When the memory is full, the printer can no longer receive any 
incoming fax. Secure free memory to resume by removing data 
stored in the memory.

• To use the Ans/Fax mode, attach an answering printer to the EXT 
socket on the back of your printer. 

• If you do not want other people to view your received documents, 
you can use secure receiving mode. In this mode, all of the 
received faxes are stored in memory. See "Receiving in secure 
receiving mode" on page 46.

• If you have set your printer to Ans/Fax mode and your answering 
printer is switched off, or no answering printer is connected to EXT 
socket, your printer automatically goes into Fax mode after a 
predefined number of rings.

• If your answering printer has a user-selectable ring counter, set the 
printer to answer incoming calls within 1 ring. 

• If you are in Tel mode (manual reception) when the answering 
printer is connected to your printer, you must switch off the 
answering printer, or the outgoing message from the answering 
printer will interrupt your phone conversation.
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Receiving in secure receiving mode
You may need to prevent your received faxes from being accessed by 
unauthorized people. You can turn on secure receiving mode to restrict 
printing of received faxes when the printer is unattended. In secure 
receiving mode, all incoming faxes go into memory. When the mode is 
deactivated, any stored faxes are printed.

Activating secure receiving mode
1. Press Fax.
2. Press Menu ( ) and then press OK when Fax Feature appears on the 

bottom line of the display.
3. Press the left/right arrow until Secure Receive appears and press OK.
4. Press the left/right arrow until On appears and press OK.
5. Enter a four-digit password you want to use and press OK.

6. Re-enter the password to confirm it and press OK.
7. Press Stop/Clear ( ) to return to Ready mode.
When a fax is received in secure receiving mode, your printer stores it in 
memory and shows Secure Receive to let you know that there is a fax 
received.

Printing received faxes
1. Access the Secure Receive menu by following steps 1 through 3 in 

“Activating secure receiving mode.”
2. Press the left/right arrow until Print appears and press OK.
3. Enter the four-digit password and press OK. 

The printer prints all of the faxes stored in memory.

Deactivating secure receiving mode
1. Access the Secure Receive menu by following steps 1 through 3 in 

“Activating secure receiving mode.”
2. Press the left/right arrow until Off appears and press OK.
3. Enter the four-digit password and press OK.

The mode is deactivated and the printer prints all faxes stored in 
memory.

4. Press Stop/Clear ( ) to return to Ready mode.

Receiving faxes in memory
Since your printer is a multi-tasking device, it can receive faxes while you 
are making copies or printing. If you receive a fax while you are copying or 
printing, your printer stores incoming faxes in its memory. Then, as soon as 
you finish copying or printing, the printer automatically prints the fax. 
Also, your printer receives faxes and stores them in its memory when there 
is no paper in the tray or no toner in the installed toner cartridge.

OTHER WAYS TO FAX
Sending a fax to multiple destinations
You can use the Multiple Send feature, which allows you to send a fax to 
multiple locations. Originals are automatically stored in memory and sent to 
a remote station. After transmission, the originals are automatically erased 
from memory. You cannot send a color fax using this feature.
1. Press Fax.
2. Load originals face up into the DADF, or place a single original face 

down on the scanner glass.
For details about loading an original, see "Loading originals" on 
page 23.

3. Adjust the document resolution and darkness to suit your fax needs. See 
"Adjusting the document settings" on page 43.

4. Press Menu ( ) until Fax Feature appears on the bottom line of the 
display and press OK.

5. Press the left/right arrow until Multi Send appears and press OK.
6. Enter the number of the first receiving fax printer and press OK.

You can use speed buttons, speed dial numbers. You can enter Group 
Dial Number using Address Book Button. For details, see "Setting up 
address book" on page 49.

7. Enter the second fax number and press OK.
The display asks you to enter another fax number to send the document.

8. To enter more fax numbers, press OK when Yes appears and repeat 
steps 6 and 7. You can add up to 10 destinations.

9. When you have finished entering fax numbers, press the left/right arrow 
to select No at the Another No.? prompt and press OK.
The original is scanned into memory before transmission. The display 
shows memory capacity and the number of pages being stored in 
memory.

10. If an original is placed on the scanner glass, select Yes to add another 
pages. Load another original and press OK.
When you have finished, select No at the Another Page? prompt.
The printer begins sending the fax to the numbers you entered in the 
order in which you entered them.

Sending a delayed fax
You can set your printer to send a fax at a later time when you will not be 
present. You cannot send a color fax using this feature.
1. Press Fax.
2. Load originals face up into the DADF, or place a single original face 

down on the scanner glass.
For details about loading an original, see "Loading originals" on 
page 23.

3. Adjust the document resolution and darkness to suit your fax needs. See 
"Adjusting the document settings" on page 43.

4. Press Menu ( ) until Fax Feature appears on the bottom line of the 
display and press OK.

5. Press the left/right arrow until Delay Send appears and press OK.
6. Enter the number of the receiving printer using the number keypad.

You can use speed buttons, speed dial numbers. You can enter Group 
Dial Number using Address Book Button.For details. See "Setting up 
address book" on page 49.

• DRPD must be set up again if you re-assign your fax number, or 
connect the printer to another telephone line.

• After DRPD has been set up, call your fax number again to verify 
that the printer answers with a fax tone. Then have a call placed to 
a different number assigned to that same line to be sure the call is 
forwarded to the extension telephone or answering printer plugged 
into the EXT socket. 

You can activate secure receiving mode without setting a 
password, but cannot protect your faxes.

Once you entered a group dial number, you cannot enter another 
group dial numbers anymore.
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7. Press OK to confirm the number. The display asks you to enter another 
fax number to which to send the document.

8. To enter more fax numbers, press OK when Yes appears and repeat 
steps 6 and 7. You can add up to 10 destinations.

9. When you have finished entering fax numbers, press the left/right arrow 
to select No at the Another No.? prompt and press OK.

10. Enter the job name you want and press OK.
For details on how to enter alphanumeric characters. See "Entering 
characters using the number keypad" on page 21.
If you do not want to assign a name, skip this step.

11. Enter the time using the number keypad and press OK, or Black Start.

The original is scanned into memory before transmission. The display 
shows memory capacity and the number of pages being stored in 
memory.

12. If an original is placed on the scanner glass, select Yes to add another 
page. Load another original and press OK.
When you have finished, select No at the Another Page? prompt.
The printer returns to Ready mode. The display reminds you that you 
are in Ready mode and that a delayed fax is set.

Adding pages to a delayed fax
You can add pages to the delayed transmissions previously reserved in 
your printer’s memory.
1. Load the originals to be added and adjust document settings.
2. Press Menu ( ) until Fax Feature appears on the bottom line of the 

display and press OK.
3. Press OK when Add Page appears.
4. Press the left/right arrow until the fax job you want appears and 

press OK.
The printer scans the original into memory and shows the total 
number of pages and the number of the added pages.

Canceling a delayed fax
1. Press Menu ( ) until Fax Feature appears on the bottom line of the 

display and press OK.
2. Press the left/right arrow until Cancel Job appears and press OK.
3. Press the left/right arrow until the fax job you want appears and 

press OK.
4. Press OK when Yes appears.

The selected fax is deleted from memory.

Sending a priority fax
Using the Priority Fax feature, a high priority fax can be sent ahead of 
reserved operations. The original is scanned into memory and immediately 
transmitted when the current operation is finished. In addition, priority 
transmission will interrupt a Multiple Send operation between stations (i.e., 
when the transmission to station A ends, before transmission to station B 
begins) or between redial attempts.
1. Press Fax.
2. Load originals face up into the DADF, or place a single original face 

down on the scanner glass.
For details about loading an original, see "Loading originals" on 
page 23.

3. Adjust the document resolution and darkness to suit your fax needs.  
See "Adjusting the document settings" on page 43.

4. Press Menu ( ) until Fax Feature appears on the bottom line of the 
display and press OK.

5. Press the left/right arrow until Priority Send appears and press OK.
6. Enter the number of the receiving printer.

You can use speed buttons, speed dial numbers, or group dial numbers. 
For details, see "Setting up address book" on page 49..

7. Press OK to confirm the number.
8. Enter the job name you want and press OK. 

The original is scanned into memory before transmission. The display 
shows memory capacity and the number of pages being stored in 
memory.

9. If an original is placed on the scanner glass, select Yes to add another 
page. Load another original and press OK.
When you have finished, select No at the Another Page? prompt.
The printer shows the number being dialed and begins sending the fax.

Forwarding faxes
You can forward your incoming and outgoing faxes to another fax printer or 
email address.

Forwarding sent faxes to another fax printer
You can set the printer to send copies of all outgoing faxes to a specified 
destination, in addition to the fax numbers you entered.
1. Press Fax.
2. Press Menu ( ) until Fax Feature appears on the bottom line of the 

display and press OK.
3. Press the left/right arrow until Forward appears and press OK.
4. Press OK when Fax appears.
5. Press the left/right arrow until Send Forward appears and press OK.
6. Press the left/right arrow to select On and press OK.
7. Enter the number of the fax printer to which faxes are to be sent and 

press OK.
8. Press Stop/Clear ( ) to return to Ready mode.

Subsequent sent faxes will be forwarded to the specified fax printer.

Forwarding sent faxes to email address
You can set the printer to send copies of all outgoing faxes to a specified 
destination, in addition to the email address you entered.
1. Press Fax.
2. Press Menu ( ) until Fax Feature appears on the bottom line of the 

display and press OK.
3. Press the left/right arrow until Forward appears and press OK.
4. Press the left/right arrow until E-mail appears and press OK.
5. Press the left/right arrow until Send Forward appears and press OK.
6. Press the left/right arrow to select On and press OK.
7. Enter your email address and press OK.
8. Enter the email address to which faxes are to be sent and press OK.
9. Press Stop/Clear ( ) to return to Ready mode.

Subsequent sent faxes will be forwarded to the specified email 
address.

Forwarding received faxes to another fax printer
You can set your printer to forward incoming faxes to another fax 
number during a specified time period. When a fax arrives at your 
printer, it is stored in memory. Then, the printer dials the fax number that 
you have specified and sends the fax.

Once you entered a group dial number, you cannot enter another 
group dial numbers anymore.

If you set a time earlier than the current time, the fax will be sent at 
that time on the following day. 
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1. Press Fax.
2. Press Menu ( ) until Fax Feature appears on the bottom line of the 

display and press OK.
3. Press the left/right arrow until Forward appears and press OK.
4. Press OK when Fax appears.
5. Press the left/right arrow until Rcv. Forward appears and press OK.
6. Press the left/right arrow until Forward appears and press OK.

To set the printer to print out a fax when fax forwarding has been 
completed, select Forward&Print.

7. Enter the number of the fax printer to which faxes are to be sent and 
press OK.

8. Enter the starting time and press OK.
9. Enter the ending time and press OK.
10. Press Stop/Clear ( ) to return to Ready mode.

Subsequent received faxes will be forwarded to the specified fax 
printer.

Forwarding received faxes to email address
You can set your printer to forward incoming faxes to the email address 
you entered.
1. Press Fax.
2. Press Menu ( ) until Fax Feature appears on the bottom line of the 

display and press OK.
3. Press the left/right arrow until Forward appears and press OK.
4. Press the left/right arrow until E-mail appears and press OK.
5. Press the left/right arrow until Rcv. Forward appears and press OK.
6. Press the left/right arrow until Forward appears and press OK.

To set the printer to print out a fax when fax forwarding has been 
completed, select Forward&Print.

7. Enter your email address and press OK.
8. Enter the email address to which faxes are to be sent and press OK.
9. Press Stop/Clear ( ) to return to Ready mode.

Subsequent sent faxes will be forwarded to the specified email 
address.

FAX SETUP
Changing the fax setup options
Your printer provides you with various user-selectable options for setting up 
the fax system. You can change the default settings for your preferences 
and needs.
To change the fax setup options:
1. Press Fax.
2. Press Menu ( ) until Fax Setup appears on the bottom line of the 

display and press OK.
3. Press the left/right arrow to select Sending or Receiving and press OK. 
4. Press the left/right arrow until the menu item you want appears and 

press OK.
5. Press the left/right arrow until the desired status appears or enter the 

value for the option you have selected, and press OK.
6. If necessary, repeat steps 4 through 5.
7. Press Stop/Clear ( ) to return to Ready mode.

Sending options

Receiving options

OPTION DESCRIPTION

Redial Times You can specify the number of redial attempts. If 
you enter 0, the printer will not redial.

Redial Term Your printer can automatically redial a remote fax 
printer if it was busy. You can set an interval 
between attempts.

Prefix Dial You can set a prefix of up to five digits. This 
number dials before any automatic dial number is 
started. It is useful for accessing a PABX 
exchange.

ECM Mode This mode helps with poor line quality and makes 
sure any faxes you send are sent smoothly to any 
other ECM-equipped fax printer. Sending a fax 
using ECM may take more time.

Send Report You can set your printer to print a confirmation 
report showing whether a transmission was 
successful, how many pages were sent, and 
more. The available options are On, Off, and On-
Error, which prints only when a transmission is 
not successful.

Image TCR This function allows users to know what fax 
messages have been sent by showing sent 
messages in the transmission report. 
The first page of the message is turned into an 
image file than is printed on the transmission 
report so the users can see what messages have 
been sent.
However, you can not use this function when 
sending fax without saving the data in the 
memory. 

Dial Mode This setting may not be available depending on 
your country. If you cannot reach this option, your 
printer does not support this feature.
You can set the dial mode for your printer to either 
tone dialling or pulse dialling. If you have a public 
telephone system or a private branch 
exchnage(PBX) system, you may need to select 
Pulse. Contact your local telephone company if 
you are not sure which dial mode to use.
If you select Pulse, some phone system features 
might not be available. It can also take longer to 
dial a fax or phone number.

OPTION DESCRIPTION

Receive Mode You can select the default fax receiving mode. For 
details on receiving faxes in each mode. See 
"Changing receiving modes" on page 44.

Ring To Answer You can specify the number of times the printer 
rings before answering an incoming call.

Stamp RCV 
Name

This option allows the printer to automatically print 
the page number, and the date and time of 
reception at the bottom of each page of a 
received fax.



Faxing | 49

Changing the default document settings
The fax options, including resolution and darkness, can be set to the most 
frequently used modes. When you send a fax, the default settings are used 
if they are not changed by using the corresponding button and menu.

1. Press Fax.
2. Press Menu ( ) until Fax Setup appears on the bottom line of the 

display and press OK.
3. Press the left/right arrow until Change Default appears and press OK.
4. Press OK when Resolution appears.
5. Press the left/right arrow until the resolution you want appears and press 

OK.
6. Press the left/right arrow until Darkness appears and press OK.
7. Press the left/right arrow until the darkness you want appears and press 

OK.
8. Press Stop/Clear ( ) to return to Ready mode.

Printing sent fax report automatically
You can set the printer to print a report with detailed information about the 
previous 50 communication operations, including time and dates.
1. Press Fax.
2. Press Menu ( ) until Fax Setup appears on the bottom line of the 

display and press OK.
3. Press the left/right arrow until Auto Report appears and press OK.
4. Press the left/right arrow until On appears and press OK.
5. Press Stop/Clear ( ) to return to Ready mode.

Setting up address book
You can set up Address Book with the fax numbers you use most 
frequently. Your printer provides you with the following features for setting 
up Address Book:
• Speed buttons
• Speed/Group dial numbers

Speed buttons
The 15 speed buttons on the control panel lets you store frequently-used 
fax numbers. You will be able to enter a fax number with the touch of a 
button. By utilizing the Shift button, you can store up to 30 numbers on 
the speed buttons.
There are two ways to assign numbers to speed buttons. Examine the 
procedures below and use the appropriate way which you prefer:

Registering after pressing a speed button
1. Press Fax.
2. Press one of the speed buttons.
3. Press OK when Yes appears.
4. Enter the name you want and press OK.

For details on how to enter alphanumeric characters. see "Entering 
characters using the number keypad" on page 21.

5. Enter the fax number you want to store and press OK.

Registering after entering a number first
1. Press Fax.
2. Enter the fax number you want to store.
3. Press one of the speed buttons.
4. Press OK when Yes appears.

5. Enter the name you want and press OK.

Rcv Start Code This code allows you to initiate fax reception from 
an extension phone plugged into the EXT socket 
on the back of the printer. If you pick up the 
extension phone and hear fax tones, enter the 
code. It is preset to *9* at the factory.

Auto Reduction When receiving a fax containing pages as long as 
or longer than the paper loaded in the paper tray, 
the printer can reduce the size of the original to fit 
the size of the paper loaded in the printer. Turn on 
this feature if you want to automatically reduce an 
incoming page. 
With this feature set to Off, the printer cannot 
reduce the original to fit onto one page. The 
original will be divided and printed in actual size 
on two or more pages.

Discard Size When receiving a fax containing pages as long as 
or longer than the paper in your printer, you can 
set the printer to discard a specific length from the 
end of the received fax. The printer will print the 
received fax on one or more sheets of paper, 
minus the data that would have been on the 
specified discard segment. 
When the received fax contains pages larger than 
the paper in your printer, and Auto Reduction 
has been turned on, the printer will reduce the fax 
to fit on the existing paper, and nothing will be 
discarded.

Junk Fax Setup This setting may not be available depending on 
your country. Using this feature, the system will 
not accept faxes sent from remote stations whose 
numbers are stored in the memory as junk fax 
numbers. This feature is useful for blocking any 
unwanted faxes.
When you turn on this feature, you can access the 
following options to set junk fax numbers.
• Add: Allows you to set up to 10 fax numbers.
• Delete: Allows you to delete the desired junk 

fax number.
• Delete All: Allows you to delete all junk fax 

numbers.

DRPD Mode This mode enables a user to use a single 
telephone line to answer several different 
telephone numbers. In this menu, you can set the 
printer to recognize which ring patterns to answer. 
For details about this feature. see "Receiving 
faxes using DRPD mode" on page 45.

Duplex Print • Long Edge: Prints pages to be read like a 
book.

• Short Edge: Prints pages to be read by 
flipping like a note pad. 

• Off: Prints received fax on one sides of a 
paper.

OPTION DESCRIPTION

Before beginning to store fax numbers, ensure that your printer is in 
Fax mode. 

If you press a speed button already assigned, the display asks if 
you want to overwrite. Press OK to confirm Yes and continue. To 
start over with another speed button, select No.



50 | Faxing

For details on how to enter alphanumeric characters. See "Entering 
characters using the number keypad" on page 21.

6. Press OK to confirm the number.

Using speed buttons
When you are prompted to enter a fax number while sending a fax:
• To retrieve a number from speed buttons 1 to 15, press the 

corresponding speed button and press OK.
• To retrieve a number from speed buttons 16 to 30, press Shift and 

then the corresponding speed button, and press OK.

Speed dial numbers
You can store up to 240 frequently-used fax numbers in speed dial 
numbers.

Registering a speed dial number
1. Press Fax.
2. Press Address Book until New & Edit appears on the bottom line of 

the display and press OK.
3. Press OK when Speed Dial appears.
4. Enter a speed dial number between 0 and 239 and press OK. 

If an entry is already stored in the number you choose, the display 
shows the name to allow you to change it. To start over with another 
speed dial number, press Back ( ).

5. Enter the name you want and press OK.
For details on how to enter alphanumeric characters. See "Entering 
characters using the number keypad" on page 21.

6. Enter the fax number you want and press OK.
7. Press Stop/Clear ( ) to return to Ready mode.

Editing speed dial numbers
1. Press Address Book until New & Edit appears on the bottom line of 

the display and press OK.
2. Press OK when Speed Dial appears.
3. Enter the speed dial number you want to edit and press OK.
4. Change the name and press OK.
5. Change the fax number and press OK.
6. Press Stop/Clear ( ) to return to Ready mode.

Using speed dial numbers
When you are prompted to enter a destination number while sending a 
fax, enter the speed dial number at which you stored the number you 
want.
• For a one-digit (0-9) speed dial number, press and hold the 

corresponding digit button on the number keypad.
• For a two- or three-digit speed dial number, press the first digit 

button(s) and then hold down the last digit button.
You can also search through memory for an entry by pressing Address 
Book. See "Searching Address Book for an entry" on page 50.

Group dial numbers
If you frequently send the same document to several destinations, you 
can group these destinations and set them under a group dial number. 
You can then use a group dial number to send a document to all of the 
destinations within the group. You can set up to 200 (0 through 199) 
group dial numbers using the destination’s existing speed dial numbers.

Registering a group dial number
1. Press Fax.
2. Press Address Book until New & Edit appears on the bottom line of 

the display and press OK.
3. Press the left/right arrow until Group Dial appears and press OK.
4. Enter a group dial number between 0 and 199 and press OK.

5. Enter a speed dial number and press OK.
6. Press OK when speed dial information appears correctly.
7. Press OK when Yes appears.
8. Repeat steps 5 and 6 to include other speed dial numbers into the 

group.
9. When you have finished, press the left/right arrow to select No at the 

Another No.? prompt and press OK.
10. Press Stop/Clear ( ) to return to Ready mode.

Editing a group dial number
You can delete a specific entry from a group or add a new number to the 
selected group.
1. Press Address Book until New & Edit appears on the bottom line of 

the display and press OK.
2. Press the left/right arrow until Group Dial appears and press OK.
3. Enter the group dial number you want to edit and press OK.
4. Enter the speed dial number you want to add or delete and press 

OK.
If you entered a new speed dial number, Add? appears.
If you enter a speed dial number stored in the group, Delete? 
appears.

5. Press OK to add or delete the number.
6. Press OK when Yes appears to add or delete more numbers and 

repeat steps 4 and 5.
7. When you have finished, press the left/right arrow to select No at the 

Another No.? prompt and press OK.
8. Press Stop/Clear ( ) to return to Ready mode.

Using group dial numbers
To use a group dial entry, you need to search for and select it from 
memory. 
When you are prompted to enter a fax number while sending a fax, 
press Address Book. See below.

Searching Address Book for an entry
There are two ways to search for a number in memory. You can either 
scan from A to Z sequentially, or you can search by entering the first 
letters of the name associated with the number.

Searching sequentially through the memory
1. If necessary, press Fax.
2. Press Address Book until Search & Dial appears on the bottom line 

of the display and press OK.
3. Press the left/right arrow until the number category you want 

appears and press OK.
4. Press OK when All appears.
5. Press the left/right arrow until the name and number you want 

appears. You can search upwards or downwards through the entire 
memory in alphabetical order.

Searching with a particular first letter
1. If necessary, press Fax.
2. Press Address Book until Search & Dial appears on the bottom line 

of the display and press OK.
3. Press the left/right arrow until the number category you want 

appears and press OK.
4. Press the left/right arrow until ID appears and press OK.
5. Enter the first few letters of the name you want and press OK.
6. Press the left/right arrow until the name you want appears and press 

OK.
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Deleting a Address Book entry
You can delete entries in Address Book one by one.
1. Press Address Book until Delete appears on the bottom line of the 

display and press OK.
2. Press the left/right arrow until the number category you want 

appears and press OK.
3. Press the left/right arrow until the searching method you want 

appears and press OK.
Select Search All to search for an entry by scanning through all 
entries in Address Book.
Select Search ID to search for an entry by the first few letters of the 
name.

4. Press the left/right arrow until the name you want appears and press 
OK.
Or, enter the first letters and press OK. Press the left/right arrow until 
the name you want appears and press OK.

5. Press OK. 
6. Press OK when Yes appears to confirm the deletion.
7. Press Stop/Clear ( ) to return to Ready mode.

Printing Address Book
1. You can check your Address Book settings by printing a list.
1. Press Address Book until Print appears on the bottom line of the 

display.
2. Press OK. A list showing your speed button settings, and speed dial 

and group dial entries prints out.
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using USB flash memory
This chapter explains how to use a USB memory device with your printer.

This chapter includes:
• About USB memory
• Plugging in a USB memory device
• Scanning to a USB memory device

• Printing from a USB memory device
• Backing up data
• Managing USB memory

ABOUT USB MEMORY
USB memory devices are available with a variety of memory capacities to 
give you more room for storing documents, presentations, downloaded 
music and videos, high resolution photographs, or whatever other files you 
want to store or move.
You can do the following on your printer using a USB memory device:
• Scan documents and save them on a USB memory device.
• Print data stored on a USB memory device.
• Back up Address Book / Phone Book entries and the system 

settings of your printer.
• Restore backup files to the printer’s memory.
• Format the USB memory device.
• Check the available memory space.

PLUGGING IN A USB MEMORY DEVICE
The USB connector on the front of your printer is designed for USB V1.1 
and USB V2.0 memory devices. Your printer supports USB memory devices 
with FAT16/ FAT32 and sector size of 512 bytes. 
Check your USB memory device’s file system from your dealer.
You must use only an authorized USB memory device with an A plug type 
connector.

Use only a metal/shielded USB memory device.

Insert a USB memory device into the USB connector on the front of your 
printer.

SCANNING TO A USB MEMORY DEVICE
You can scan a document and save the scanned image onto a USB 
memory device. There are two ways of doing this: you can scan to the 
device using the default settings, or you can customize your own scan 
settings.

Scanning
1. Insert a USB memory device into the USB connector on your printer.
2. Load originals face up into the DADF, or place a single original face 

down on the scanner glass.
For details about loading an original. See "Loading originals" on 
page 23.

3. Press Scan/Email.
4. Press OK when Scan to USB appears on the bottom line of the display.
5. Press OK, Color Start ( ) or Black Start ( ) when USB appears.

Regardless of the button you press, the color mode is decided as 
customized. See "Customizing scan to USB" on page 53.
Your printer begins scanning the original, and then asks if you want to 
scan another page.

• Do not remove the USB memory device while the printer is in 
operation, or writing to or reading from USB memory. The printer 
warranty does not cover damage caused by use’s misuse. 

• If your USB memory device has certain features, such as security 
settings and password settings, your printer may not automatically 
detect it. For details about these features, see the device’s User’s 
Guide.
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6. Press OK when Yes appears to scan more pages. Load an original and 
press Color Start ( ) or Black Start ( ). 
Regardless of the button you press, the color mode is decided as 
customized. See “Customizing scan to USB” on page 53.
Otherwise, press the left/right arrow to select No and press OK.

After scanning is complete, you can remove the USB memory device from 
the printer.

Customizing scan to USB 
You can specify image size, file format, or color mode for each scanning to 
USB job.
1. Press Scan/Email.
2. Press Menu ( ) until Scan Feature appears on the bottom line of the 

display and press OK.
3. Press OK when USB Memory appears.
4. Press the left/right arrow until the setting option you want appears and 

press OK.
You can set the following options:
• Scan Size: Sets the image size.
• Original Type: Sets the original document’s type.
• Resolution: Sets the image resolution.
• Scan Color: Sets the color mode. If you select Mono in this option, 

you cannot select JPEG in Scan Format.
• Scan Format: Sets the file format in which the image is to be saved. 

When you select TIFF or PDF, you can select to scan multiple 
pages. If you select JPEG in this option, you cannot select Mono in 
Scan Color.

5. Press the left/right arrow until the desired status appears and press OK.
6. Repeat steps 4 and 5 to set other setting options.
7. When you have finished, press Stop/Clear ( ) to return to Ready 

mode.
You can change the default scan settings. For details. See "Changing the 
default scan settings" on page 39.

PRINTING FROM A USB MEMORY DEVICE
You can directly print files stored on a USB memory device. You can print 
TIFF, BMP, JPEG, PDF, and PRN files.
Direct Print option supported file types: 
• PRN: Dell PCL 6 compatible. 
• PRN files can be created by selecting the Print to file check box when 

you print a document. The document will be saved as a PRN file, rather 
than printed on paper. Only PRN files created in this fashion can be 
printed directly from USB memory. See the Software Section to learn 
how to create a PRN file.

• BMP: BMP Uncompressed
• TIFF: TIFF 6.0 Baseline
• JPEG: JPEG Baseline
• PDF: PDF 1.4 and below

To print a document from a USB memory device:
1. Insert a USB memory device into the USB connector on your printer. If 

one has already been inserted, press USB Print ( ).
Your printer automatically detects the device and reads data stored on it.

2. Press the left/right arrow until the folder or file you want appears and 
press OK.
If you see D in the front of a folder name, there are one or more files or 
folders in the selected folder.

3. If you selected a file, skip to the next step.
If you selected a folder, press the left/right arrow until the file you want 
appears.

4. Press the left/right arrow to select the number of copies to be printed or 
enter the number.

5. Press OK, Color Start ( ) or Black Start ( ) to start printing the 
selected file. 
There are two types of mode as following:
•  OK or Color Start ( ) : Color print
•  Black Start ( ) : Black and White print
After printing the file, the display asks if you want to print another job.

6. Press OK when Yes appears to print another job, and repeat from step 2. 
Otherwise, press the left/right arrow  to select No and press OK.

7. Press Stop/Clear ( ) to return to Ready mode.

BACKING UP DATA 
Data in the printer’s memory can be accidentally erased due to power failure 
or storage failure. Backup helps you protect your Address Book entries 
and the system settings by storing them as backup files on a USB memory 
device.

Backing up data
1. Insert the USB memory device into the USB connector on your printer.
2. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
3. Press OK when Machine Setup appears.
4. Press the left/right arrow until Export Setting appears and press OK. 
5. Press the left/right arrow until the option you want appears.

• Address Book: Backs up all Address Book entries.
• Setup Data: Backs up all system settings.

6. Press OK to begin backing up the data.
The data is backed up to the USB memory.

7. Press Stop/Clear ( ) to return to Ready mode.

Restoring data
1. Insert the USB memory device on which the backup data is stored in to 

the USB connector.
2. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
3. Press OK when Machine Setup appears.
4. Press the left/right arrow until Import Setting appears and press OK. 
5. Press the left/right arrow until the data type you want appears and press 

OK.
6. Press the left/right arrow until the file containing the data you want to 

restore appears and press OK.
7. Press OK when Yes appears to restore the backup file to the printer.
8. Press Stop/Clear ( ) to return to Ready mode.

Can choose paper size and tray when printing. See "Setting the paper 
size and type" on page 30.
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MANAGING USB MEMORY
You can delete image files stored on a USB memory device one by one or 
all at once by reformatting the device.

Deleting an image file
1. Insert the USB memory device into the USB connector on your printer.
2. Press Scan/Email.
3. Press OK when Scan to USB appears on the bottom line of the display.
4. Press the left/right arrow until File Manage appears and press OK.
5. Press OK when Delete appears. 
6. Press the left/right arrow until the folder or file you want appears and 

press OK.

If you selected a file, the display shows the size of the file for about 
2 seconds. Go to the next step.
If you selected a folder, press the left/right arrow until the file you want to 
delete appears and press OK.

7. Press OK when Yes appears to confirm your selection.
8. Press Stop/Clear ( ) to return to Ready mode.

Formatting a USB memory device
1. Insert the USB memory device into the USB connector on your printer.
2. Press Scan/Email.
3. Press OK when Scan to USB appears on the bottom line of the display. 
4. Press the left/right arrow until File Manage appears and press OK.
5. Press the left/right arrow until Format appears and press OK.
6. Press OK when Yes appears to confirm your selection.
7. Press Stop/Clear ( ) to return to Ready mode.

Viewing the USB memory status
You can check the amount of memory space available for scanning and 
saving documents.
1. Insert the USB memory device into the USB connector on your printer.
2. Press Scan/Email.
3. Press OK when Scan to USB appears on the bottom line of the display.
4. Press the left/right arrow until Check Space appears and press OK.

The available memory space appears on the display.
5. Press Stop/Clear ( ) to return to the Ready mode.

After deleting files or reformatting a USB memory device, files cannot 
be restored. Therefore, confirm that you no longer need the data 
before deleting it.

If you see D in the front of a folder name, there are one or more 
files or folders in the selected folder.
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maintenance
This chapter provides information for maintaining your printer and the toner cartridge.

This chapter includes:
• Printing reports
• Adjusting the color contrast
• Clearing memory
• Cleaning your printer
• Maintaining the cartridge

• Replacing the toner cartridge
• Replacing the paper transfer belt
• Maintenance parts
• Managing your printer from the website
• Checking the printer’s serial number

PRINTING REPORTS
Your printer can provide various reports with useful information you will 
need. The following reports are available:

Printing a report
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press the left/right arrow until Report appears and press OK.
3. Press the left/right arrow until the report or list you want to print appears 

and press OK.
To print all reports and lists, select All Report.

4. Press OK when Yes appears to confirm printing.
The selected information prints out.

ADJUSTING THE COLOR CONTRAST
Color menu allows you to adjust the color setting.
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press OK when Maintenance appears.
3. Press the left/right arrow until Color appears and press OK.
4. Press the left/right arrow until the menu you want appears on display 

and press OK.
• Custom Color: Allows you to adjust contrast color by color. Default 

optimizes color automatically. Manual Adjust allows you to 
manually adjust the color contrast for each cartridge. Default setting 
is recommended for getting best color quality.

• Auto Color Reg.: Allows you to adjust the position of print color 
texts or graphics to match the original file on your screen.

5. Press Stop/Clear ( ) to return to Ready mode.

Some reports may not appear in the display depending on options or 
models. If so, it is not applicable to your printer. 

REPORT/LIST DESCRIPTION
Configuration This list shows the status of the user-selectable 

options. You may print this list to confirm your 
changes after changing settings.

Supplies Info This list shows the current status of consumables 
in your printer.

Address Book This list shows all of the fax numbers and email 
addresses currently stored in the printer’s memory.

Send Report This report shows the fax number, the number of 
pages, the elapsed time of the job, the 
communication mode, and the communication 
results for a particular fax job.
You can set up your printer to automatically print a 
transmission confirmation report after each fax job. 
See "Sending options" on page 48

Sent Report This report shows information on the faxes and 
emails you have recently sent.
You can set the printer to automatically print this 
report every 50 communications. see "Sending 
options" on page 48

Fax RCV Report This report shows information on the faxes you 
have recently received. 

Schedule Jobs This list shows the documents currently stored for 
delayed faxes along with the starting time and type 
of each operation. 

Junk Fax Report This list shows the fax numbers specified as junk 
fax numbers. To add or delete numbers to or from 
this list, access the Junk Fax Setup menu.
See "Receiving options" on page 48

Network Info. This list shows information on your printer’s 
network connection and configuration.

NetScan Report This report shows information for the Network Scan 
records including IP address, time and date, the 
number of pages scanned, and results. This report is 
automatically printed every 50 network scan jobs.

User Auth List This list shows authorized users who are allowed to 
use the email function.

PCL Font List You can print the PCL font list.
PS3 Font List You can print the PS3 font list.

Stored Job This list shows the current status of stored job on 
HDD.

Completed Job The completed job page shows the list of 
completed print jobs. The list contains up to 50 files 
from the latest print jobs.

Net Auth Log This list shows users and their IDs who logged in 
the domain.

If you have moved the printer, it is strongly recommended to operate 
this menu manually.

REPORT/LIST DESCRIPTION
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USING TONER LOW ALERT
If toner in the cartridge has run out, a message informing user to change the 
toner cartridge appears. You can set the option for this message to appear 
or not. 
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press OK when Maintenance appears.
3. Press the left/right arrow until Toner Low Alert appears and press OK.
4. Press the left/right arrow to select Off.
5. Press OK.
6. Press Stop/Clear ( ) to return to Ready mode.

CLEARING MEMORY
You can selectively clear information stored in your printer’s memory.

1. Press Menu ( ) until System Setup appears on the bottom line of the 
display and press OK. 

2. Press the left/right arrow until Clear Setting appears and press OK.
3. Press the left/right arrow until the item you want to clear appears.

4. Press OK when Yes appears.
5. Press OK again to confirm clearing.
6. Repeat steps 3 through 5 to clear another item.
7. Press Stop/Clear ( ) to return to Ready mode.

CLEANING YOUR PRINTER
To maintain print and scan quality, follow the cleaning procedures below 
each time the toner cartridge is replaced or if print and scan quality 
problems occur.

Cleaning the outside
Clean the cabinet of the printer with a soft lint-free cloth. You can dampen 
the cloth slightly with water, but be careful not to let any water drip onto or 
into the printer.

Cleaning the inside
During the printing process, paper, toner, and dust particles can accumulate 
inside the printer. This buildup can cause print quality problems, such as 
toner specks or smearing. Cleaning the inside of the printer clears or 
reduces these problems.
1. Turn the printer off and unplug the power cord. Wait for the printer to 

cool down.
2. Using the handle, completely open the front cover.

Before clearing the memory, ensure that all fax jobs have been 
completed, or you will lose those jobs.

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your printer. 

OPTIONS DESCRIPTION

All Settings Clears all of the data stored in memory and resets all 
of your settings to the factory default.

Fax Setup Restores all of the fax options to the factory default.

Copy Setup Restores all of the copy options to the factory 
default.

Scan Setup Restores all of the scan options to the factory 
default.

System Setup Restores all of the system options to the factory 
default.

Network Restores all of the network options to the factory 
default.

Address Book Clears all of the fax number and email address 
entries stored in memory.

Sent Report Clears all records of sent faxes and emails. 

Fax RCV Report Clears all records of received faxes.

NetScan Report Clears the information on network scan sessions in 
memory.

• Cleaning the cabinet of the printer with cleaning materials 
containing large amounts of alcohol, solvent, or other strong 
substances can discolor or distort the cabinet.

• If your printer or its surrounding is contaminated with toner, we 
recommend you to use cloth or tissue dampened with water to 
clean it. If you use a vacuum cleaner, toner blown into the air may 
be harmful. 

• Do not touch the green surface, the OPC drum or the front of the 
toner cartridge, with your hands or any other material. Use the 
handle on each cartridge in order to avoid touching this area.

• Be careful not to scratch the surface of the paper transfer belt.
• If you leave the front cover open for more than a few minutes, the 

OPC drum can be exposed to light. This will cause damage to the 
OPC drum. Close the front cover should the installation need to 
be halted for any reason.
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3. Grasp the handles on the toner cartridge and pull to remove the 
cartridge from the printer.

4. Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the printer.

5. With a dry lint-free cloth, wipe away any dust and spilled toner from the 
toner cartridges area and their cavities.

6. Locate the long strip of glass (LSU) inside the cartridge compartment, 
and gently swab the glass to see if dirt turns the white cotten black.

7. Reinstall all the compartments into the printer, and close the front cover.

8. Plug in the power cord and turn the printer on.

When you open the front cover, be careful not to touch the 
underneath of the control panel (the lower part of the fuser unit). The 
temperature of the fuser unit might be high and could damage your 
skin.

When you open the front cover and work inside the printer, it is highly 
recommend that you remove the paper transfer belt first. Because the 
work you do could contaminate the paper transfer belt.

If toner gets on your clothing, wipe it off with a dry cloth and wash 
it in cold water. Hot water sets toner into fabric.

If the front cover is not completely closed, the printer will not operate.
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Cleaning the scan unit
Keeping the scan unit clean helps ensure the best possible copies. We 
suggest that you clean the scan unit at the start of each day and during the 
day, as needed.
1. Slightly dampen a soft lint-free cloth or paper towel with water.
2. Open the scanner lid.
3. Wipe the surface of the scanner glass and DADF glass until it is clean 

and dry.

4. Wipe the underside of the scanner lid and white sheet until it is clean 
and dry.

5. Close the scanner lid.

MAINTAINING THE CARTRIDGE
Toner cartridge storage
To get the most from the toner cartridge, keep the following guidelines in 
mind:
• Do not remove the toner cartridge from its package until ready for use. 
• Do not refill the toner cartridge. The printer warranty does not cover 

damage caused by using a refilled cartridge.
• Store toner cartridges in the same environment as your printer.
• To prevent damage to the toner cartridge, do not expose it to light for 

more than a few minutes.

Expected cartridge life
The life of the toner cartridge yield depends on the amount of toner that print 
jobs require. The actual number may also be different depending on the 
print density of the pages you print on, and the number of pages may be 
affected by operating environment, printing interval, media type, and media 
size. If you print a lot of graphics, you may need to change the cartridge 
more often.

Redistributing toner
When a toner is low, faded or light areas may appear. It is possible that 
colored images may be printed with incorrect colors due to flawed mixing of 
toner colors when one of the colored toner cartridges is low on toner. You 
can temporarily improve print quality by redistributing the toner.
• The toner-related message saying that the toner is low may appear on 

the display.
1. Using the handle, completely open the front cover.

1 Scanner lid
2 Scanner glass
3 White sheet
4 DADF glass

• Do not touch the green surface, the OPC drum or the front of the 
toner cartridge, with your hands or any other material. Use the 
handle on each cartridge in order to avoid touching this area.

• Be careful not to scratch the surface of the paper transfer belt.
• If you leave the front cover open for more than a few minutes, the 

OPC drum can be exposed to light. This will cause damage to the 
OPC drum. Close the front cover should the installation need to 
be halted for any reason.
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2. Grasp the handles on the toner cartridge and pull to remove the 
cartridge from the printer.

3. Holding both handles on the toner cartridge, thoroughly rock it from side 
to side to evenly distribute the toner. 

4. Slide the toner cartridge back into the printer.

5. Close the front cover. Ensure the cover is securely latched.

REPLACING THE TONER CARTRIDGE
The printer uses four colors and has a different toner cartridge for each one: 
yellow (Y), magenta (M), cyan (C), and black (K).
• The status LED and the toner-related message on the display indicates 

which each individual toner cartridge should be replaced.
• Incoming faxes are saved in memory.
At this stage, the toner cartridge needs to be replaced. Check the type of 
toner cartridge for your printer (see "Supplies" on page 83).
1. Turn the printer off, then wait a few minutes for the printer to cool.
2. Using the handle, completely open the front cover.

When you open the front cover, be careful not to touch the 
underneath of the control panel (the lower part of the fuser unit). The 
temperature of the fuser unit might be high and could damage your 
skin.

When you open the front cover and work inside the printer, it is highly 
recommend that you remove the paper transfer belt first. Because the 
work you do could contaminate the paper transfer belt.

If toner gets on your clothing, wipe it off with a dry
cloth and wash it in cold water. Hot water sets toner into
fabric.

If the front cover is not completely closed, the printer will not 
operate.

• Do not touch the green surface, the OPC drum or the front of 
each toner cartridge, with your hands or any other material. Use 
the handle on each cartridge in order to avoid touching this area.

• Be careful not to scratch the surface of the paper transfer belt.
• If you leave the front cover open for more than a few minutes, the 

OPC drum can be exposed to light. This will cause damage to the 
OPC drum. Close the front cover should the installation need to 
be halted for any reason.
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3. Grasp the handles on the toner cartridge and pull to remove the 
cartridge from the printer.

4. Take a new toner cartridge out of its package.

5. Holding both handles on the toner cartridge, thoroughly rock it from side 
to side to evenly distribute the toner.

 

6. Place the toner cartridge on a flat surface, as shown, and remove the 
paper covering the toner cartridge by removing the tape.

7. Ensure that the color of the toner cartridge matches the color slot and 
then grasp the handles on the toner cartridge. Insert the cartridge until it 
clicks into place.

8. Close the front cover. Ensure the cover is securely latched, and then 
turn the printer on.

Clearing the Toner Empty message
When the Toner Empty message appears you can configure not to see this 
message again not to disturb you.
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press the Scroll buttons until Maintenance appears and press OK.
3. Press the Scroll buttons until CLR Empty Msg. appears and press OK.
4. Press the left/right arrow until the color menu you want appears on 

display and press OK.
5. Select On and press OK.
6. Now the Toner Empty  message does not appear but the Replace 

Toner message will remain for reminding you that the new cartridge 
needs to be installed for quality.

When you open the front cover, be careful not to touch the underneath 
of the control panel (the lower part of the fuser unit). The temperature of 
the fuser unit might be high and could damage your skin.

When you open the front cover and work inside the printer, it is highly 
recommend that you remove the paper transfer belt first. Because the 
work you do could contaminate the paper transfer belt.

• Do not use sharp objects, such as a knife or scissors, to open 
the toner cartridge package. You could damage the surface of 
the toner cartridge.

• To prevent damage, do not expose the toner cartridge to light 
for more than a few minutes. Cover it with a piece of paper to 
protect it if necessary.

If toner gets on your clothing, wipe it off with a dry cloth and wash 
it in cold water. Hot water sets toner into fabric.

If the front cover is not completely closed, the printer will not 
operate.

• Once you have selected On, this setting will be permanently 
written to the memory of the toner cartridge, and this menu will be 
disappeared from the Maintenance menu.

• You can keep printing but the quality cannot be guaranteed, and 
the product support is no longer provided. 
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REPLACING THE PAPER TRANSFER BELT
The life of the paper transfer belt is approximately 50,000 black and color 
pages. After the life span of the paper transfer belt is complete, you have to 
replace it.
• The transfer belt-related message appears on the display, telling it is 

time for a replacement.
• The SmartPanel program window appears on the computer telling you 

the paper transfer belt needs to be replaced.

1. Turn the printer off, then wait a few minutes for the printer to cool.
2. Using the handle, completely open the front cover.

3. Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the printer.

4. Take a new paper transfer belt out of its package.

5. Holding the handle on the new paper transfer belt, align it with the slots 
on the inside of the front cover.

6. Lower the paper transfer belt until it is parallel with the front cover and 
firmly seated.

 

7. Close the front cover firmly.
8. Turn the printer on.

The life span of the paper transfer belt may be affected by operating 
environment, printing interval, media type, and media size.

• Do not use sharp objects, such as a knife or scissors, to open 
the paper transfer belt package. You could damage the 
surface of the paper transfer belt.

• Be careful not to scratch the surface of the paper transfer belt.
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MAINTENANCE PARTS
To avoid print quality and paper feed problems resulting from worn parts, 
and to maintain your printer in top working condition the following condition, 
the following items will need to be replaced after the specified number of 
pages, or when the life span of each item has expired. 

 

It is highly recommend that this maintenance be performed by an authorized 
service provider, dealer or the retailer where you bought the printer. The 
warranty does not cover the replacement of the maintenance parts after 
their lifespan.

Checking replaceables
If you experience frequent paper jams or printing problems, check the 
number of pages the printer has printed or scanned. Replace the 
corresponding parts, if necessary.
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press the left/right arrow until Maintenance appears and press OK.
3. Press the left/right arrow until Supplies Life appears and press OK.
4. Press the left/right arrow until the item you want appears and press OK.

• Supplies Info: Prints the supply information page.
• Total: Displays the total number of pages printed.
• ADF Scan: Displays the number of pages scanned using the ADF.
• Platen Scan: Displays the number of pages scanned using the 

scanner glass.
• Transfer Belt, Fuser, Tray1 Roller, Tray2 Roller, MP Tray 

Roller:  Displays the number of pages printed each item.
5. If you selected to print a supply information page, press OK to confirm.
6. Press Stop/Clear ( ) to return to Ready mode.

Replacing the DADF rubber pad
You will need to replace the DADF rubber pad when there seems to be a 
consistent problem with paper pickup or when its specified yield is reached.
1. Open the DADF cover.
2. Remove the DADF rubber pad from the DADF, as shown.

3. Insert a new DADF rubber pad into place.
4. Close the DADF cover.

MANAGING YOUR PRINTER FROM THE 
WEBSITE
If you have connected your printer to a network and set up TCP/IP network 
parameters correctly, you can manage the printer via Dell’s Embedded 
Web Service, an Embedded Web Service. Use Embedded Web Service 
to:
• View the printer’s device information and check its current status.
• Change TCP/IP parameters and set up other network parameters.
• Change the printer properties.
• Set the printer to send email notifications to let you know the printer’s 

status.
• Get support for using the printer.

To access Embedded Web Service:
1. Start a web browser, such as Internet Explorer, from Windows.
2. Enter the printer IP address (http://xxx.xxx.xxx.xxx) in the address field 

and press the Enter key or click Go.
Your printer’s embedded website opens.

CHECKING THE PRINTER’S SERIAL NUMBER
When you call for service or register as a user on the Dell website, the 
printer’s serial number may be required.
You can check the serial number by taking the following steps:
1. Press Menu ( ) until System Setup appears on the bottom line of the 

display and press OK.
2. Press the left/right arrow until Maintenance appears and press OK.
3. Press the left/right arrow until Serial Number appears and press OK.
4. Check your printer’s serial number.
5. Press Stop/Clear ( ) to return to Ready mode.

ITEMS YIELD (AVERAGE)

Fuser unit Approx. 100,000 pages

DADF friction pad Approx. 20,000 pages

DADF pick-up roller Approx. 80,000 pages

Pick-up roller 
(Multi-purpose tray, FCFa, Optional 
tray 2)

a. First cassette feeder (Tray1)

Approx. 70,000 pages

Friction pad 
(Multi-purpose tray, FCF, Optional 
tray 2)

Approx. 70,000 pages

1 DADF rubber 
pad
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troubleshooting
This chapter gives helpful information for what to do if you encounter an error.

This chapter includes:
• Tips for avoiding paper jams
• Clearing document jams
• Clearing paper jams

• Understanding display messages
• Solving other problems

TIPS FOR AVOIDING PAPER JAMS
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, follow the steps outlined on page (see "Tips for 
avoiding paper jams" on page 63). 
• Follow the procedures on page (see "Loading paper" on page 27). 

Ensure that the adjustable guides are positioned correctly.
• Do not overload the tray. Ensure that the paper level is below the paper 

capacity mark on the inside of the tray.
• Do not remove paper from the tray while your printer is printing.
• Flex, fan, and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media (see "Setting the paper size and 

type" on page 30).
• Ensure that the recommended side of the print media is facing up in the 

tray, or facing down in the multi-purpose tray.

CLEARING DOCUMENT JAMS
When an original jams while passing through the DADF, Document Jam 
appears on the display.

Input misfeed
1. Remove any remaining pages from the DADF.
2. Open the DADF cover.

3. Pull the jammed paper gently out of the DADF.

4. Close the DADF cover. Then load the removed pages, if any, back into 
the DADF.

1 DADF cover

To prevent document jams, use the scanner glass for thick, thin, or 
mixed paper-type originals.
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Exit misfeed
1. Remove any remaining pages from the DADF.
2. Seize the misfeed paper, and remove the paper from the document 

output tray by carefully pulling it to the right using both hands.

3. Load the removed pages back into the DADF.

Roller misfeed
1. Open the scanner lid.
2. Seize the misfeed paper, and remove the paper from the feed area by 

carefully pulling it to the right using both hands.

3. Close the scanner lid. Then load the removed pages back into the 
DADF.

CLEARING PAPER JAMS
When a paper jam occurs, the warning message appears on the display 
screen. Refer to the table below to locate and clear the paper jam.

MESSAGE LOCATION OF 
JAM GO TO

MP Tray 
Paper Jam 0

In the multi purpose 
tray

See "In the multi-purpose 
tray" on page 66.

Tray 2 
Paper jam 0

In the optional tray See "In the optional tray" on 
page 69.

Paper Jam 0
Open/Close Door

In the paper feed 
area or inside the 
printer

See "In the paper feed 
area" on page 65,  see "In 
the fuser unit area" on 
page 67.

Paper Jam 1
Open/Close Door

Inside the printer See "In the paper feed 
area" on page 65, see "In the 
fuser unit area" on page 67.

Paper Jam 2
Check Inside

Inside the printer or 
in the fuser area

See "In the paper feed 
area" on page 65, see "In the 
fuser unit area" on page 67.

Reverse Jam 0
Check Inside

In the fuser area or 
in the cover of 
reverse unit area

See "In the paper feed 
area" on page 65, see "In the 
fuser unit area" on page 67.

Reverse Jam 1 
Check Inside

In the rear cover or 
in the cover of 
reverse unit area

See "In the paper feed 
area" on page 65, see "In the 
fuser unit area" on page 67.

Remove Paper
in Rear Cover

Inside rear cover See "In the fuser unit 
area" on page 67.

Duplex Jam 0
Check Inside

Inside the printer See "In the paper feed 
area" on page 65.

Duplex Jam 1
Open/Close Door

In the paper feed 
area or inside the 
printer

See "In the paper feed 
area" on page 65, see "In the 
fuser unit area" on page 67.

Some messages may not appear in the display depending on options 
or models. 

To avoid tearing the paper, pull the jammed paper out gently and 
slowly. Follow the instructions in the following sections to clear the 
jam. 
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In the paper feed area 
If paper is jammed in the paper feed area, follow the next steps to release 
the jammed paper. 
1. Using the handle, completely open the front cover.

 

2. Carefully remove the paper by pulling in the direction as shown below. 
Go to step 7.

If you cannot find the jammed paper, or if there is any resistance 
removing the paper, stop pulling, and go to step 3.

3. Close the front cover.

4. Pull the tray open. 

5. Remove the jammed paper by gently pulling it straight out as shown 
below.

6. To replace the tray, lower the rear edge, align it with the slot, and slide it 
into the printer.

 

7. Open the front cover and close it. The printer will resume printing.

• Do not touch the green surface, the OPC drum or the front of 
each toner cartridge, with your hands or any other material. Use 
the handle on each cartridge in order to avoid touching this area.

• Be careful not to scratch the surface of the paper transfer belt.
• If you leave the front cover open for more than a few minutes, 

the OPC drum can be exposed to light. This will cause 
damage to the OPC drum. Close the front cover should the 
installation need to be halted for any reason.
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In the multi-purpose tray
When you print using the Multi-purpose Tray and the printer detects that 
there is either no paper or that the paper has been improperly loaded, follow 
the next steps to release the jammed paper.
1. Check if the paper is stuck in the feeding area, and if so, pull it out gently 

and slowly.

If you cannot find the jammed paper, or if there is any resistance 
removing the paper, stop pulling and go to step 2.

2. Close the multi-purpose tray.
3. Pull the tray out. 
4. Open the inner cover while you are pushing the lever with two hands.

5. Pull the paper out gently.

6. Replace the tray.
If you cannot find the jammed paper, or if there is any resistance 
removing the paper, stop pulling and go to step 8.

7. Using the handle, completely open the front cover.

8. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

9. Close the front cover firmly. The printer will resume printing.

• Do not touch the green surface, the OPC drum or the front of 
each toner cartridge, with your hands or any other material. Use 
the handle on each cartridge in order to avoid touching this area.

• Be careful not to scratch the surface of the paper transfer belt.
• If you leave the front cover open for more than a few minutes, the 

OPC drum can be exposed to light. This will cause damage to the 
OPC drum. Close the front cover should the installation need to 
be halted for any reason.

If the front cover is not completely closed, the printer will not 
operate.
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In the fuser unit area
If paper is jammed in the fuser unit area, follow the next steps to release the 
jammed paper.
1. Open the scan unit.

2. Open the inner cover using the handle.
 

3. Open the inner cover using the handle on it and carefully take the 
jammed paper out of the printer.

4. Pull up the paper jam lever to loose the fusing part of the fuser unit and 
carefully take the jammed paper out of the printer.

5. Press down the paper jam lever to fasten the fusing part.
6. Close the inner cover.
7. Lowering down the scan unit gently and slowly until it is completely 

closed. Ensure that it is securely latched.
Be careful not to pinch your fingers!

Do not touch the fuser inside the inner cover. It is hot and could 
cause burns! The fuser's operating temperature is 180°C (356°F). 
Take care when removing paper from the printer.

If the scan unit is not completely closed, the printer will not 
operate.
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In the paper exit area
If paper is jammed in the paper exit area, follow the next steps to release 
the jammed paper.
1. If a long portion of the paper is visible, pull it straight out. Open and close 

the front cover firmly. The printer will resume printing.

If you cannot find the jammed paper, or if there is any resistance 
removing the paper, stop pulling and go to step 2.

2. Open the scan unit.

3. Open the cover of reverse unit using the handle on it and carefully take 
the jammed paper out of the printer.

If there is any resistance removing the paper or difficulty picking up 
jammed paper, stop pulling and turn the release knob to the direction as 

shown to remove the misfed paper.

4. Close the cover of reverse unit.
5. Lowering down the scan unit gently and slowly until it is completely 

closed. Ensure that it is securely latched.
Be careful not to pinch your fingers!

If you cannot find the jammed paper, or if there is any resistance 
removing the paper, stop pulling and go to step 6.

6. Open the rear cover and carefully take the jammed paper out of the 
printer. 

7. Close the rear cover.

If the scan unit is not completely closed, the printer will not 
operate.
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In the optional tray
If paper is jammed in the optional Tray, follow the next steps to release the 
jammed paper.
1. Pull the optional Tray open. After you pull it all the way out, lift up the 

front part of the tray slightly to release the tray from the printer.

2. If you see the jammed paper, remove the paper from the printer by 
gently pulling it straight out as shown below.

3. Slide the tray back into the printer. 
4. Open the front cover. 

5. Pull the jammed paper out in the direction shown. To avoid tearing the 
paper, pull it out gently and slowly.

6. Close the front cover firmly. The printer will resume printing.
If the front cover is not completely closed, the printer will not 
operate.
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UNDERSTANDING DISPLAY MESSAGES
Messages appear on the control panel display to indicate the printer’s status 
or errors. Refer to the tables below to understand the messages’ meaning 
and correct the problem if necessary. Messages and their meanings are 
listed in alphabetical order. 

• If the message is not in the table, cycle the power and try the 
printing job again. If the problem persists, call for service.

• Some messages may not appear in the display depending on 
options or models. 

• xxx indicates the media type.
• yyy indicates the tray.

MESSAGE MEANING SUGGESTED 
SOLUTIONS

[COMM. Error] The printer has a 
communication 
problem.

Ask the sender to try 
again.

[Incompatible] The printer has 
received a fax from 
which is registered as 
a junk fax.

The received fax data 
will be deleted.
Reconfirm junk fax 
setup. See "Receiving 
options" on page 48

[Line Error] Your printer cannot 
connect with the 
receiving fax printer or 
has lost contact 
because of a problem 
with the phone line.

Try again. If the problem 
persists, wait an hour or 
so for the line to clear 
and try again.
Or, turn the ECM mode 
on. See "Sending 
options" on page 48

[No Answer] The receiving fax 
printer has not 
answered after 
several redial 
attempts.

Try again. Ensure that 
the receiving printer is 
operational.

[Stop Pressed] Stop/Clear ( ) has 
been pressed during 
an operation.

Try again.

[yyy]
Paper Empty

There is no paper in 
the tray.

Load paper in the tray.

[yyy] 
Paper Mismatch

The paper size 
specified in the printer 
properties does not 
match the paper you 
are loading.

Load the correct paper in 
the tray.

[yyy]
Cassette Out

The tray cassette is 
not properly closed.

To close the tray, lower 
the rear edge, align it 
with the slot, and slide it 
into the printer.

Adjusting...
Registration

The printer is 
adjusting the color 
registration.

Wait a few minutes.

Authentication 
Failure

The ID or password 
you entered is 
incorrect.

Enter the correct ID or 
password.

Cancel? 
 Yes  

Your printer’s memory 
has become full while 
trying to store an 
original into memory.

To cancel the fax job, 
press the OK button to 
accept Yes. 
If you want to send those 
pages that have been 
successfully stored, 
press the OK button to 
accept No. You should 
send the remaining 
pages later, when 
memory is available.

Connection Error Connection with the 
SMTP server failed.

Check the server 
settings and the network 
cable.

Connection Failed The protocol you have 
entered is not 
supported or server 
port is wrong.

Check the protocol or 
server port.

DADF Cover
Open Error

The DADF cover is 
not securely latched.

Close the DADF cover 
until it locks into place.

Data Read Fail 
Check USB Mem.

Time expired while 
reading data.

Try again.

Data Write Fail 
Check USB Mem.

Storing to the USB 
memory failed.

Check the available USB 
memory space.

Document Jam The loaded original 
has jammed in the 
DADF.

Clear the jam (see 
"Clearing document 
jams" on page 63).

Door Open/Check 
Transfer Belt

The front cover is not 
securely latched.

Close the cover until it 
locks into place.

Duplex Jam 0
Check Inside

Paper has jammed 
during duplex printing. 
This is applicable only 
to printers with this 
feature. 

Clear the jam 
(see "Clearing paper 
jams" on page 64).

Duplex Jam 1
Open/Close Door

Paper has jammed 
during duplex printing. 
This is applicable only 
to printers with this 
feature. 

Clear the jam
(see "Clearing paper 
jams" on page 64).

Enter Again You entered an 
unavailable item.

Enter the correct item 
again.

File Access
Denied

Login to the network 
server was 
successful. However, 
access to the file on 
the network server 
was denied.

Change the server 
settings.

File Format 
Not Supported

The selected file 
format is not 
supported.

Use the correct file 
format.

MESSAGE MEANING SUGGESTED 
SOLUTIONS
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File Name Exist The file name you 
have entered already 
exists.

Enter a different file 
name.

File Name 
Over Limit

The file names you 
can use are from 
doc001 to doc999. 
However, all file 
names are used 
already.

Delete unnecessary 
files.

Fuser Fan 
Locked

There is a problem in 
the cooling fan of the 
printer.

Open and then close the 
front cover.

Global Address 
Not Found

When the device is 
unable to locate the 
given address of the 
Global server.

Check the search ID.

Global Query 
Size Exceeded

This is an error 
message and displays 
when the global query 
size has been 
exceeded.

There are too many 
search results. Refine 
your search by entering 
more letters.
Contact a LDAP server 
administrator.

Global Server 
Auth Failed 

When there is a 
authentication fail 
while connecting to 
the global server this 
message displays.

Check the authentication 
account and password.

Global Server 
Not Configured

When no global server 
is configured, this 
message displays.

Check the LDAP server 
configuration settings. 

Global Server 
Not Found

When the device is 
unable to find the 
Global server.

Check the LDAP server 
address, The LDAP 
server address is 
incorrect, or the server 
has failed.

Global Server 
Query Timeout

Network Information 
Center (NIC) failed to 
get the proper 
response from the 
LDAP server within 
specified time.

Check the LDAP server 
setting, LDAP server 
setting is incorrect.

Global Server
Comm Error

This error message 
displays when there is 
a communication error 
between the global 
server and the device.

Try again.
Contact a LDAP Server 
administrator.

Group Not
Available 

You have tried to 
select a group location 
number where only a 
single location 
number can be used, 
such as when adding 
locations for a Multiple 
Send operation.

Use a speed dial number 
or dial a number 
manually using the 
number keypad.

MESSAGE MEANING SUGGESTED 
SOLUTIONS

Install 
[xxx]

The corresponding 
part of the printer is 
not installed.

Install the part into your 
printer.

Invalid 
[xxx]

The color part of the 
printer is not for your 
printer.

Install the a Dell-genuine 
part designed for your 
printer.

Install Toner The color toner 
cartridge is not 
installed.

Install the color toner 
cartridge.

Invalid Toner The color toner 
cartridge you have 
installed is not for your 
printer.

Install the a Dell-genuine 
color toner cartridge 
designed for your 
printer.

Invalid Server 
Address

The server address 
you have entered is 
invalid.

Enter the correct server 
address.

IP Conflict The network IP 
address you have set 
is being used by 
someone else.

Check the IP address 
and reset it if necessary.  
See "Setting up the 
network" on page 17.

Line Busy The receiving fax 
printer did not answer 
or the line is already 
engaged.

Try again after a few 
minutes.

Low Power The printer is in the 
previous stage of the 
power save mode.

When data is received, it 
switches to on-line 
automatically.

Mail Exceeds
Server Support

The mail size is larger 
than the supported 
size by SMTP server.

Divide your mail or 
reduce the resolution.

Main Motor
Locked

There is a problem in 
the main motor.

Open and then close the 
front cover.

Load Manually
Press Start Key

The multi-purpose 
tray is empty in 
manual feed mode.

Load paper in the multi-
purpose tray. See 
"Loading paper in the 
multi-purpose tray" on 
page 28.

Memory Full The memory is full. Delete unnecessary fax 
jobs and retransmit after 
more memory becomes 
available. Alternatively, 
split the transmission 
into more than one 
operation.

MP Tray 
Paper Jam 0

Paper has jammed in 
the feeding area of the 
multi-purpose tray.

Clear the jam. See "In 
the paper feed area" on 
page 65.

Network Error There is a problem 
with the network.

Contact your network 
administrator.

MESSAGE MEANING SUGGESTED 
SOLUTIONS
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Not Assigned The speed button or 
speed dial number 
you tried to use has 
no number assigned 
to it.

Enter the number 
manually using the 
number keypad or store 
the number or address.

Not Available
Try Again Later

Can not perform the 
task immediately 
because too many 
tasks are running at 
once. 

Try again when current 
task is completed. 

NonDELL Toner The color toner 
cartridge which the 
arrow indicates is not 
a Dell-genuine 
cartridge.
Press OK to toggle 
the message to Stop 
or Continue.

 Stop  

You can select either 
Stop or Continue with 
the left/right arrow.
If you select Stop by 
pressing OK on the 
control panel, the printer 
stops printing. If you 
select Continue, the 
printer keeps printing, 
but the quality cannot be 
guaranteed. 
 If you do not select any, 
the printer will work as 
Stop is selected. 
Replace the 
corresponding toner 
cartridge with a Dell-
genuine cartridge (see 
"Replacing the toner 
cartridge" on page 59).

One Page is 
Too Large

Single page data 
exceeds the 
configured mail size.

Reduce the resolution 
and try again.

Operation 
Not Assigned 

You are in the Add 
Page/Cancel Job 
operation, but there 
are no jobs stored.

Check the display to see 
if there are any 
scheduled jobs.

Out-Bin Full The output tray of the 
printer is full of paper.

Remove paper.

Paper Jam 0
Open/Close Door

Paper has jammed in 
the feeding area of the 
tray.

Clear the jam (see "In 
the paper feed area" on 
page 65).

Paper Jam 1
Open/Close Door

Paper has jammed 
inside the printer.

Clear the jam (see "In 
the fuser unit area" on 
page 67).

Paper Jam 2
Check Inside

Special print media 
has jammed in the 
paper exit area.

Clear the jam (see "In 
the paper exit area" on 
page 68).

Power Failure Power has turned off 
then on and the 
printer’s memory has 
not been back up.

The job which you were 
trying to do before the 
power failure must be 
completely re-done.

Remove Paper
in Rear Cover

Paper has jammed in 
the paper rear cover 
area.

Clear the jam (see "In 
the paper exit area" on 
page 68).

MESSAGE MEANING SUGGESTED 
SOLUTIONS

Refilled Toner The toner cartridge 
you have installed is 
not genuine or refilled.

The print quality may get 
poor if the refilled toner 
cartridge is installed, 
since its characteristics 
may significantly differ 
from the genuine. 
We recommend Dell-
genuine color toner 
cartridge.

Replace Toner This message 
appears between 
Toner Empty and 
Toner Low status.

Replace the toner 
cartridge with a new one. 
See "Replacing the toner 
cartridge" on page 59.

Replace 
[xxx]

The life of the part 
expires totally.

Replace the part with a 
new one. Call for 
service.

Replace 
[xxx] Soon

The life of the part 
expires soon.

See "Checking 
replaceables" on 
page 62 and call for 
service.

Retry Redial?  The printer is waiting 
for a specified time 
interval to redial a 
previously busy 
station.

You can press OK to 
immediately redial, or 
Stop/Clear ( ) to 
cancel the redial 
operation.

Reverse Jam 0
Check Inside

Paper has jammed in 
the paper fuser area 
and In the cover of 
reverse unit area.

Clear the jam (see "In 
the paper exit area" on 
page 68).

Reverse Jam 1 
Check Inside

Paper has jammed In 
the cover of reverse 
unit area or in the rear 
cover.

Clear the jam (see "In 
the fuser unit area" on 
page 67).

Scanner locked The scanner module 
is locked

Unlock the scanner and 
press Stop/Clear ( ).

Self Diagnostics 
Temperature

The engine in your 
printer is checking 
problems detected. 

Wait a few minutes.

Self Diagnostics
LSU

The LSU (Laser 
Scanning Unit) in your 
printer is checking 
problems detected. 

Wait a few minutes.

Send Error
(AUTH)

There is a problem in 
SMTP authentication.

Configure the 
authentication setting.

Send Error
(DNS)

There is a problem in 
DNS.

Configure the DNS 
setting.

Send Error
(POP3)

There is a problem in 
POP3.

Configure the POP3 
setting.

Send Error
(SMTP)

There is a problem in 
SMTP.

Change to the available 
server.

MESSAGE MEANING SUGGESTED 
SOLUTIONS
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SOLVING OTHER PROBLEMS
The following chart lists some conditions that may occur and the 
recommended solutions. Follow the suggested solutions until the problem is 
corrected. If the problem persists, call for service.

Paper feeding 

Send Error
(Wrong Config)

There is a problem on 
the network interface 
card.

Configure your network 
interface card correctly.

Toner Empty The color toner 
cartridge has run out. 
The printer stops 
printing.
Press OK to toggle 
the message to Stop, 
Continue or Black 
Only.

 Stop  

If the black 
toner cartridge 
is empty, 
Black Only 
message does 
not appear.

You can select the 
option among Stop, 
Continue or Black Only 
with the left/right arrow. 
If you select Stop by 
pressing OK on the 
control panel, the printer 
stops printing. If you 
select Continue, the 
printer keeps printing, 
but the quality cannot be 
guaranteed. 
If you select Black Only, 
the printer prints the data 
in black. In this case, the 
mono printing feature is 
preset in the printer 
properties.
When you copy, the 
Black Start button will 
be activated only with 
this condition.
If you do not select any, 
the printer will work as 
Stop is selected.
Replace the color toner 
cartridge with a new one  
(see "Replacing the 
toner cartridge" on 
page 59).

Toner Exhausted The lifespan of the 
color toner cartridge 
which the arrow 
indicates is reached.

This message appears 
when the toner is 
completely empty, and 
your printer stops 
printing. Replace the 
corresponding toner 
cartridge with a Dell-
genuine cartridge (see 
"Replacing the toner 
cartridge" on page 59).

Toner Low The corresponding 
color toner cartridge is 
almost empty.

If you do not 
want this 
message to 
appear,  see 
"Using toner 
low alert" on 
page 56.

Take out the toner 
cartridge and thoroughly 
shake it. By doing this, 
you can temporarily 
reestablish printing 
operations.

Tray 2 
Paper jam 0

Paper has jammed In 
the paper feed area.

Clear the jam (see "In 
the paper feed area" on 
page 65).

Updating Data
Please Wait...

This message 
appears when there is 
a change in the 
system setting or 
when you back up a 
data.

Do not turn the power off 
when this message is 
showing. Changes may 
not be saved and datas 
can be lost.

MESSAGE MEANING SUGGESTED 
SOLUTIONS

CONDITION SUGGESTED SOLUTIONS

Paper is jammed 
during printing.

Clear the paper jam (see "Tips for avoiding paper 
jams" on page 63).

Paper sticks 
together.

• Ensure there is not too much paper in the tray. 
The tray can hold up to 250 sheets of paper, 
depending on the thickness of your paper.

• Ensure that you are using the correct type of 
paper (see "Setting the paper size and type" on 
page 30).

• Remove paper from the tray and flex or fan the 
paper.

• Humid conditions may cause some paper to 
stick together.

Multiple sheets of 
paper do not feed.

• Different types of paper may be stacked in the 
tray. Load paper of only one type, size, and 
weight.

• If multiple sheets have caused a paper jam, 
clear the paper jam (see "Tips for avoiding 
paper jams" on page 63).

Paper does not feed 
into the printer.

• Remove any obstructions from inside the 
printer.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the printer 
(see "Selecting print media" on page 24).

• If an original does not feed into the printer, the 
DADF rubber pad may require to be replaced 
(see "Replacing the DADF rubber pad" on 
page 62).

The paper keeps 
jamming.

• There is too much paper in the tray. Remove 
excess paper from the tray. If you are printing 
on special materials, use the multi-purpose tray.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the printer (see "Selecting print 
media" on page 24).

• There may be debris inside the printer. Open 
the front cover and remove the debris.

• If an original does not feed into the printer, the 
DADF rubber pad may require to be replaced 
(see "Replacing the DADF rubber pad" on 
page 62).

Envelopes skew or 
fail to feed correctly.

Ensure the paper guides are against both sides of 
the envelopes.
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Printing problems

CONDITION POSSIBLE 
CAUSE SUGGESTED SOLUTIONS

The printer does 
not print.

The printer is not 
receiving power.

Check the power cord 
connections. Check the 
power switch and the power 
source.

The printer is not 
selected as the 
default printer.

Select Dell 2145cn Color 
Laser MFP as your default 
printer in your Windows.

Check the printer for the following:
• The front cover is not closed. Close the cover.
• Paper is jammed. Clear the paper jam 

(see "Clearing paper jams" on page 64).
• No paper is loaded. Load paper (see "Loading 

paper" on page 27).
• The toner cartridge is not installed. Install the 

toner cartridge.
• If a system error occurs, contact your service 

representative.

The connection 
cable between the 
computer and the 
printer is not 
connected properly.

Disconnect the printer cable 
and reconnect it.

The connection 
cable between the 
computer and the 
printer is defective.

If possible, attach the cable 
to another computer that is 
working properly and print a 
job. You can also try using a 
different printer cable.

The port setting is 
incorrect.

Check the Windows printer 
setting to ensure that the 
print job is sent to the correct 
port. If the computer has 
more than one port, ensure 
that the printer is attached to 
the correct one.

The printer may be 
configured 
incorrectly. 

Check the printer properties 
to ensure that all of the print 
settings are correct. 

The printer driver 
may be incorrectly 
installed.

Reinstall the printer software. 
See the Software section.

The printer is 
malfunctioning.

Check the display message 
on the control panel to see if 
the printer is indicating a 
system error.

The document size 
is so big that the 
hard disk space of 
the computer is not 
enough to access 
the print job.

Get more hard disk space 
and print the document 
again.

The printer 
selects print 
materials from 
the wrong paper 
source.

The paper source 
selection in the 
printer properties 
may be incorrect.

For many software 
applications, the paper 
source selection is found 
under the Thin Paper tab 
within the printer properties. 
Select the correct paper 
source. See the printer driver 
help screen.

A print job is 
extremely slow.

The job may be very 
complex.

Reduce the complexity of the 
page or try adjusting the print 
quality settings.

Half the page is 
blank.

The page orientation 
setting may be 
incorrect.

Change the page orientation 
in your application. See the 
printer driver help screen.

The paper size and 
the paper size 
settings do not 
match.

Ensure that the paper size in 
the printer driver settings 
matches the paper in the 
tray.
Or, ensure that the paper 
size in the printer driver 
settings matches the paper 
selection in the software 
application settings you use.

The printer 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The printer cable is 
loose or defective.

Disconnect the printer cable 
and reconnect. Try a print job 
that you have already printed 
successfully. If possible, 
attach the cable and the 
printer to another computer 
and try a print job that you 
know works. Finally, try a 
new printer cable.

The wrong printer 
driver was selected.

Check the application’s 
printer selection menu to 
ensure that your printer is 
selected.

The software 
application is 
malfunctioning.

Try printing a job from 
another application.

The operating 
system is 
malfunctioning.

Exit Windows and reboot the 
computer. Turn the printer off 
and then back on again.

Pages print, but 
are blank.

The toner cartridge 
is defective or out of 
toner.

Redistribute the toner, if 
necessary (see 
"Redistributing toner" on 
page 58).
If necessary, replace the 
toner cartridge.

The file may have 
blank pages.

Check the file to ensure that 
it does not contain blank 
pages.

Some parts, such as 
the controller or the 
board, may be 
defective.

Contact a service 
representative.

CONDITION POSSIBLE 
CAUSE SUGGESTED SOLUTIONS
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Printing quality problems
If the inside of the printer is dirty or paper has been loaded improperly, you 
may notice a reduction in print quality. See the table below to clear the 
problem.

The printer does 
not print PDF file 
correctly. Some 
parts of 
graphics, text, or 
illustrations are 
missing.

Incompatibility 
between the PDF 
file and the Acrobat 
products.

Printing the PDF file as an 
image may solve this 
problem. Turn on Print As 
Image from the Acrobat 
printing options.

It will take longer to 
print when you print a 
PDF file as an image.

The print quality 
of photos is not 
good. Images 
are not clear.

The resolution of the 
photo is very low. 

Reduce the photo size. If you 
increase the photo size in the 
software application, the 
resolution will be reduced. 

The printer 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

If you are under the 
DOS environment, 
the font setting for 
your printer may be 
set incorrectly.

Suggested solutions: Change 
the font setting (see 
"Changing the font 
setting" on page 22).

Before printing, 
the printer emits 
vapor near the 
output tray.

Using damp paper 
can cause vapor 
during printing.

This is not a problem. Just 
keep printing.

The printer does 
not print special 
sized paper 
such as a billing 
paper.

Paper size and 
paper size setting do 
not match.

Set the correct paper size in 
the Custom in the Paper tab 
in the printer propeties. See 
Software section.

CONDITION SUGGESTED SOLUTIONS

Light or faded print If a vertical white streak or faded area appears 
on the page:
• The toner supply is low. You may be able 

to temporarily extend the toner cartridge 
life. See "Replacing the toner cartridge" on 
page 59. If this does not improve the print 
quality, install a new toner cartridge.

• The paper may not meet paper 
specifications; for example, the paper is too 
moist or too rough. See "Selecting print 
media" on page 24.

• If the entire page is light, the print 
resolution setting is too low. Adjust the print 
resolution. See the help screen of the 
printer driver.

• A combination of faded or smeared defects 
may indicate that the toner cartridge needs 
cleaning.

• The surface of the LSU part inside the 
printer may be dirty. See "Cleaning the 
inside" on page 56.

CONDITION POSSIBLE 
CAUSE SUGGESTED SOLUTIONS

Toner specks • The paper may not meet specifications; for 
example, the paper is too moist or too 
rough. See "Selecting print media" on 
page 24.

• The paper path may need cleaning. See 
"Cleaning the inside" on page 56.

Dropouts If faded areas, generally rounded, occur 
randomly on the page:
• A single sheet of paper may be defective. 

Try reprinting the job.
• The moisture content of the paper is 

uneven or the paper has moist spots on its 
surface. Try a different brand of paper. See 
"Selecting print media" on page 24.

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of 
paper.

• Change the printer option and try again. Go 
to printer properties, click Paper tab, and 
set type to Thick Paper. Refer to the 
Software section for details.

If these steps do not correct the problem, 
contact a service representative.

White Spots White spots appear on the page:
• The paper is too rough and a lot of dirt from 

the paper falls to the inner devices within 
the printer, which means the transfer belt 
may be dirty. Clean the inside of your 
printer. Contact a service representative.

• The paper path may need cleaning. 
Contact a service representative.

Vertical lines If black vertical streaks appear on the page:
• The drum inside the toner cartridge has 

probably been scratched. Remove the 
toner cartridge and install a new one. See 
"Replacing the toner cartridge" on page 59.

If white vertical streaks appear on the page:
• The surface of the LSU part inside the 

printer may be dirty. See "Cleaning the 
inside" on page 56.

If vertical streaks appear on the page:
• The surface of the scanner glass and its 

white sheet may be dirty. Clean these unit.  
See "Cleaning the scan unit" on page 58. If 
this problem persists, contact a service 
representative.

CONDITION SUGGESTED SOLUTIONS

AaBbCc
AaBbCc
AaBbCc
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Color or Black 
background

If the amount of background shading becomes 
unacceptable:
• Change to a lighter weight paper. See 

"Selecting print media" on page 24.
• Check the printer’s environment: very dry 

(low humidity) or high humidity (higher than 
80% RH) conditions can increase the 
amount of background shading.

• Remove the old toner cartridge and install 
a new one. See "Replacing the toner 
cartridge" on page 59.

Toner smear • Clean the inside of the printer. See 
"Cleaning the inside" on page 56.

• Check the paper type and quality. See 
"Selecting print media" on page 24.

• Remove the toner cartridge and install a 
new one. See "Replacing the toner 
cartridge" on page 59.

Vertical repetitive 
defects

If marks repeatedly appear on the printed side 
of the page at even intervals:
• The toner cartridge may be damaged. If a 

repetitive mark occurs on the page, print a 
cleaning sheet several times to clean the 
cartridge. After the printout, if you still have 
the same problems, remove the toner 
cartridge and install a new one. See 
"Replacing the toner cartridge" on page 59.

• Parts of the printer may have toner on 
them. If the defects occur on the back of 
the page, the problem will likely correct 
itself after a few more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

Background scatter Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing 

with a different batch of paper. Do not open 
packages of paper until necessary so that 
the paper does not absorb too much 
moisture.

• If background scatter occurs on an 
envelope, change the printing layout to 
avoid printing over areas that have 
overlapping seams on the reverse side. 
Printing on seams can cause problems.

• If background scatter covers the entire 
surface area of a printed page, adjust the 
print resolution through your software 
application or the printer properties.

CONDITION SUGGESTED SOLUTIONS

A

Misformed 
characters

• If characters are improperly formed and 
producing hollow images, the paper stock 
may be too slick. Try a different paper. See 
"Selecting print media" on page 24.

• If characters are improperly formed and 
producing a wavy effect, the scanner unit 
may need service. For service, contact a 
service representative.

Page skew • Ensure that the paper is loaded properly.
• Check the paper type and quality. See 

"Selecting print media" on page 24.
• Ensure that the paper or other material is 

loaded correctly and the guides are not too 
tight or too loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl. See "Selecting print media" on 
page 24.

• Turn over the stack of paper in the tray. Also 
try rotating the paper 180° in the tray.

Wrinkles or creases • Ensure that the paper is loaded properly.
• Check the paper type and quality. See 

"Selecting print media" on page 24.
• Turn over the stack of paper in the tray. Also 

try rotating the paper 180° in the tray.

Back of printouts 
are dirty

• Check for leaking toner. Clean the inside of 
the printer. See "Cleaning the inside" on 
page 56.

CONDITION SUGGESTED SOLUTIONS

AaBbCcAaBbCcAaBbCcAaBbCcAaBbCc
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Copying problems

Solid Color or 
Black pages

• The toner cartridge may not be installed 
properly. Remove the cartridge and reinsert 
it.

• The toner cartridge may be defective and 
need replacing. Remove the toner cartridge 
and install a new one. See "Replacing the 
toner cartridge" on page 59.

• The printer may require repair. Contact a 
service representative.

Loose toner • Clean the inside of the printer. See 
"Cleaning the inside" on page 56.

• Check the paper type and quality. See 
"Selecting print media" on page 24.

• Remove the toner cartridge and install a 
new one. See "Replacing the toner 
cartridge" on page 59.

• If the problem persists, the printer may 
require repair. Contact a service 
representative.

Character Voids Character voids are white areas within parts of 
characters that should be solid black:
• If you are using transparencies, try another 

type of transparency. Because of the 
composition of transparencies, some 
character voids are normal. 

• You may be printing on the wrong surface 
of the paper. Remove the paper and turn it 
around. 

• The paper may not meet paper 
specifications. See "Selecting print 
media" on page 24.

Horizontal stripes If horizontally aligned black streaks or smears 
appear:
• The toner cartridge may be installed 

improperly. Remove the cartridge and 
reinsert it.

• The toner cartridge may be defective. 
Remove the toner cartridge and install a 
new one. See "Replacing the toner 
cartridge" on page 59.

• If the problem persists, the printer may 
require repair. Contact a service 
representative.

Curl If the printed paper is curled or paper does not 
feed into the printer:
• Turn over the stack of paper in the tray. 

Also try rotating the paper 180° in the tray. 
• Change the printer option and try again. Go 

to printer properties, click Paper tab, and 
set type to Thin Paper. Refer to the 
Software section for details.

CONDITION SUGGESTED SOLUTIONS

A

A
AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

An unknown image 
repetitively appears 
on a next few 
sheets or loose 
toner, light print, or 
contamination 
occurs.

Your printer is probably being used at an 
altitude of 1,000 m (3,281 ft) or above.
The high altitude may affect the print quality 
such as loose toner or light imaging. You can 
set this option through Start → Programs → 
DELL → DELL Printers → your printer driver 
name → Printer Settings Utility. See "Altitude 
adjustment" on page 20. 

CONDITION SUGGESTED SOLUTIONS

Copies are too light 
or too dark.

Use Darkness ( ) to darken or lighten the 
background of the copies.

Smears, lines, 
marks, or spots 
appears on copies.

• If defects are on the original, press 
Darkness ( ) to lighten the background of 
your copies.

• If no defects are on the original, clean the 
scan unit. See "Cleaning the scan unit" on 
page 58.

Copy image is 
skewed.

• Ensure that the original is face down on the 
scanner glass or face up in the DADF.

• Check that the copy paper is loaded 
correctly.

Blank copies print 
out.

Ensure that the original is face down on the 
scanner glass or face up in the DADF.

Image rubs off the 
copy easily.

• Replace the paper in the tray with paper 
from a new package.

• In high humidity areas, do not leave paper 
in the printer for extended periods of time.

Frequent copy paper 
jams occur.

• Fan the stack of paper, then turn it over in 
the tray. Replace the paper in the tray with 
a fresh supply. Check/adjust the paper 
guides, if necessary.

• Ensure that the paper is the proper paper 
weight. 75 g/m2 (20 lb bond) paper is 
recommended.

• Check for copy paper or pieces of copy 
paper remaining in the printer after a paper 
jam has been cleared.

Toner cartridge 
produces fewer 
copies than expected 
before running out of 
toner.

• Your originals may contain pictures, solids, 
or heavy lines. For example, your originals 
may be forms, newsletters, books, or other 
documents that use more toner. 

• The printer may be turned on and off 
frequently. 

• The scanner lid may be left open while 
copies are being made.

CONDITION SUGGESTED SOLUTIONS
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Scanning problems Dell Scan Manager problems

Fax problems

CONDITION SUGGESTED SOLUTIONS

The scanner does 
not work.

• Ensure that you place the original to be 
scanned face down on the scanner glass, or 
face up in the DADF.

• There may not be enough available memory 
to hold the document you want to scan. Try 
the Prescan function to see if that works. Try 
lowering the scan resolution rate.

• Check that the USB cable is connected 
properly.

• Ensure that the USB cable is not defective. 
Switch the cable with a known good cable. If 
necessary, replace the cable.

• Check that the scanner is configured 
correctly. Check scan setting in the 
SmarThru Configuration or the application 
you want to use to make certain that the 
scanner job is being sent to the correct port.

The unit scans very 
slowly.

• Check if the printer is printing received data. 
If so, scan the document after the received 
data has been printed.

• Graphics are scanned more slowly than text.
• Communication speed slows in scan mode 

because of the large amount of memory 
required to analyze and reproduce the 
scanned image. Set your computer to the 
ECP printer mode through BIOS setting. It 
will help to increase the speed. For details 
about how to set BIOS, refer to your 
computer user’s guide.

Message appears on 
your computer 
screen:
• “Device cannot be 

set to the H/W 
mode you want.”

• “Port is being used 
by another 
program.”

• “Port is Disabled.
• “Scanner is busy 

receiving or 
printing data. 
When the current 
job is completed, 
try again.”

• “Invalid handle.”
• “Scanning has 

failed.”

• There may be a copying or printing job in 
progress. When that job is complete, try your 
job again.

• The Selected port is currently being used. 
Restart your computer and try again.

• The printer cable may be improperly 
connected or the power may be off.

• The scanner driver is not installed or the 
operating environment is not set up properly.

• Ensure that the printer is properly connected 
and the power is on, Then restart your 
computer.

• The USB cable may be improperly 
connected or the power may be off.

CONDITION SUGGESTED SOLUTIONS

I cannot use the Dell 
Scan Manager.

Check your operating system. Supporting 
operating systems are Windows 2000/XP/
2003/2008/Vista.

CONDITION SUGGESTED SOLUTIONS

The printer is not 
working, there is no 
display and the 
buttons are not 
working.

• Unplug the power cord and plug it in again. 
• Ensure that there is power to the electrical 

outlet.

No dial tone sounds. • Check that the phone line is connected 
properly.

• Check that the phone socket in the wall is 
working by plugging in another phone.

The numbers stored 
in memory do not 
dial correctly.

Ensure that the numbers are stored in memory 
correctly. Print a Phone Book list, referring to  
see "Printing Address Book" on page 51.

The original does not 
feed into the printer.

• Ensure that the paper is not wrinkled and 
you are putting it in correctly. Check that the 
original is the right size, not too thick or thin 

• Ensure that the DADF is firmly closed.
• The ADF rubber pad may need to be 

replaced. See "Replacing the DADF rubber 
pad" on page 62.

Faxes are not 
received 
automatically.

• The receiving mode should be set to Fax.
• Ensure that there is paper in the tray.
• Check to see if the display shows any error 

message. If it does, clear the problem.

The printer does not 
send.

• Ensure that the original is loaded in the 
DADF or on the scanner glass. 

• Sending should show up on the display. 
• Check the fax printer you are sending to, to 

see if it can receive your fax.

The incoming fax has 
blank spaces or is of 
poor-quality.

• The fax printer sending you the fax may be 
faulty. 

• A noisy phone line can cause line errors. 
• Check your printer by making a copy. 
• The toner cartridge may be empty. Replace 

the toner cartridge, referring to page 59. 

Some of the words 
on an incoming fax 
are stretched.

The fax printer sending you the fax had a 
temporary document jam. 

There are lines on 
the originals you 
send.

Check your scan unit for marks and clean it. 
See "Cleaning the scan unit" on page 58.



Troubleshooting | 79

Common PostScript problems
The following situations are PS language specific and may occur when 
several printer languages are being used.

Common Windows problems

The printer dials a 
number, but a 
connection with the 
other fax printer fails.

The other fax printer may be turned off, out of 
paper, or cannot answer incoming calls. Speak 
with the other printer operator and ask her/him 
to sort out the problem.

Faxes do not store in 
memory. 

There may not be enough memory space to 
store the fax. If the display shows the Memory 
Full message, delete from memory any faxes 
you no longer need and then try again to store 
the fax.

Blank areas appear 
at the bottom of each 
page or on other 
pages, with a small 
strip of text at the 
top.

You may have chosen the wrong paper 
settings in the user option setting. For details 
about paper settings. See "Selecting print 
media" on page 24.

To receive a printed or screen-displayed message when PostScript 
errors occur, open the Print Options window and click the desired 
selection next to the PostScript errors section

PROBLEM POSSIBLE 
CAUSE SOLUTION

PostScript file 
cannot be 
printed.

The PostScript 
driver may not be 
installed correctly.

• Install the PostScript 
driver, referring to 
Software section.

• Print a configuration page 
and verify that the PS 
version is available for 
printing.

• If the problem persists, 
contact a service 
representative.

“Limit Check 
Error” message 
appears.

The print job was 
too complex.

You might need to reduce the 
complexity of the page or 
install more memory.

A PostScript 
error page prints.

The print job may 
not be PostScript.

Ensure that the print job is a 
PostScript job. Check to see 
whether the software 
application expected a setup 
or PostScript header file to be 
sent to the printer.

The optional tray 
is not selected in 
the driver.

The printer driver 
has not been 
configured to 
recognize the 
optional tray.

Open the PostScript driver 
properties, select the Device 
Settings tab, and set the Tray 
option of the Installable 
Options section to Installed.

CONDITION SUGGESTED SOLUTIONS

When printing a 
document in 
Macintosh with 
Acrobat 
Reader 6.0 or 
higher, colors 
print incorrectly.

The resolution 
setting in the 
printer driver may 
not be matched 
with the one in 
Acrobat Reader.

Ensure that the resolution 
setting in your printer driver 
matches the one in Acrobat 
Reader.

CONDITION SUGGESTED SOLUTIONS

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the StartUp Group, then restart 
Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred.” messages 
appear.

These messages may appear during printing. 
Just keep waiting until the printer finishes 
printing. If the message appears in ready mode 
or after printing has been completed, check the 
connection and/or whether an error has 
occurred.

Refer to the Microsoft Windows documentation that came with your 
computer for further information on Windows error messages.

PROBLEM POSSIBLE 
CAUSE SOLUTION
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Common Linux problems

CONDITION SUGGESTED SOLUTIONS

The printer does not 
print.

• Check if the printer driver is installed in your 
system. Open Unified Driver configurator 
and switch to the Printers tab in Printers 
configuration window to look at the list of 
available printers. Ensure that your printer is 
displayed on the list. If not, invoke Add new 
printer wizard to set up your device.

• Check if the printer is started. Open Printers 
configuration and select your printer on the 
printers list. Look at the description in the 
Selected printer pane. If its status contains 
“(stopped)” string,  press the Start button. 
After that normal operation of the printer 
should be restored. The “stopped” status 
might be activated when some problems in 
printing occurred. For instance, this could be 
an attempt to print document when port is 
claimed by a scanning application.

• Check if the port is not busy. Since functional 
components of MFP (printer and scanner) 
share the same I/O interface (port), the 
situation of simultaneous access of different 
“consumer” application to the same port is 
possible. To avoid possible conflicts, only 
one of them at a time is allowed to gain 
control over the device. The other 
“consumer” will encounter “device busy” 
response. You should open ports 
configuration and select the port assigned to 
your printer. In the Selected port pane you 
can see if the port is occupied by some other 
application. If this is the case, you should 
wait for completion of the current job or 
should press Release port button, if you are 
sure that the present owner is not functioning 
properly.

• Check if your application has special print 
option such as “-oraw”. If “-oraw” is specified 
in the command line parameter then remove 
it to print properly. For Gimp front-end, select 
“print” -> “Setup printer” and edit command 
line parameter in the command item.

• The CUPS (Common Unix Printing System) 
version distributed with SuSE Linux 9.2 
(cups-1.1.21) has a problem with ipp 
(Internet Printing Protocol) printing.Use the 
socket printing instead of ipp or install later 
version of CUPS (cups-1.1.22 or higher).

Some color images 
come out all black.

This is a known bug in Ghostscript (until GNU 
Ghostscript version 7.05) when the base color 
space of the document is indexed color space 
and it is converted through CIE color space. 
Because Postscript uses CIE color space for 
Color Matching System, you should upgrade 
Ghostscript on your system to at least GNU 
Ghostscript version 7.06 or later. You can find 
recent Ghostscript versions at 
www.ghostscript.com.

Some color images 
come out in 
unexpected color.

This is a known bug in Ghostscript (until GNU 
Ghostscript version 7.xx) when the base color 
space of the document is indexed RGB color 
space and it is converted through CIE color 
space. Because Postscript uses CIE color 
space for Color Matching System, you should 
upgrade Ghostscript on your system to at least 
GNU Ghostscript version 8.xx or later. You can 
find recent Ghostscript versions at 
www.ghostscript.com.

The printer does not 
print whole pages 
and its output is half 
page printed.

It is a known problem that occurs when a color 
printer is used on version 8.51 or earlier of 
Ghostscript, 64-bit Linux OS, and reported to 
bugs.ghostscript.com as Ghostscript Bug 
688252.
The problem is solved in AFPL Ghostscript v. 
8.52 or above. Download the latest version of 
AFPL Ghostscript from http://sourceforge.net/
projects/ghostscript/ and install it to solve this 
problem.

I cannot scan via 
Gimp Front-end.

• Check if Gimp Front-end has “Xsane: Device 
dialog.” on the “Acquire” menu. If not, you 
should install Xsane plug-in for Gimp on the 
your computer. You can find Xsane plug-in 
package for Gimp on Linux distribution CD or 
Gimp home page. For the detail information, 
refer to the Help for Linux distribution CD or 
Gimp Front-end application. 

If you wish to use other kind of scan application, 
refer to the Help for application.

I encounter error 
“Cannot open port 
device file” when 
printing a document.

Avoid changing print job parameters (via LPR 
GUI, for example) while a print job is in 
progress. Known versions of CUPS server 
break the print job whenever print options are 
changed and then try to restart the job from the 
beginning. Since Unified Linux Driver locks port 
while printing, the abrupt termination of the 
driver keeps the port locked and therefore 
unavailable for subsequent print jobs. If this 
situation occurred, try to release the port. 

CONDITION SUGGESTED SOLUTIONS
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The printer does not 
appear on the 
scanners list.

• Check if your printer is attached to your 
computer. Ensure that it is connected properly 
via the USB port and is turned on.

• Check if the scanner driver for your printer is 
installed in your system. Open Unified Driver 
configurator, switch to Scanners 
configuration, then press Drivers. Ensure 
that driver with a name corresponding to 
your printer's name is listed in the window. 
Check if the port is not busy. Since functional 
components of MFP (printer and scanner) 
share the same I/O interface (port), the 
situation of simultaneous access of different 
“consumer” application to the same port is 
possible. To avoid possible conflicts, only 
one of them at a time is allowed to gain 
control over the device. The other 
“consumer” will encounter “device busy” 
response. This can usually happen while 
starting scan procedure, and appropriate 
message box appears.

• To identify the source of the problem, you 
should open ports configuration and select the 
port assigned to your scanner. port's symbol /
dev/mfp0 corresponds to LP:0 designation 
displayed in the scanners’ options, /dev/mfp1 
relates to LP:1 and so on. USB ports start at /
dev/mfp4, so scanner on USB:0 relates to /dev/
mfp4 respectively and so forth sequentially. In 
the Selected port pane you can see if the port is 
occupied by some other application. If this is 
the case, you should wait for completion of 
the current job or should press Release port 
button, if you are sure that the present port's 
owner is not functioning properly.

CONDITION SUGGESTED SOLUTIONS

The printer does not 
scan.

• Check if a document is loaded into the printer.
• Check if your printer is connected to the 

computer. Ensure if it is connected properly if I/
O error is reported while scanning.

• Check if the port is not busy. Since functional 
components of MFP (printer and scanner) 
share the same I/O interface (port), the 
situation of simultaneous access of different 
“consumer” application to the same port is 
possible. To avoid possible conflicts, only one 
of them at a time is allowed to gain control over 
the device. The other “consumer” will 
encounter “device busy” response. This can 
usually happen while starting scan procedure, 
and appropriate message box will be displayed.
To identify the source of the problem, you 
should open ports configuration and select the 
port assigned to your scanner. port’s symbol /
dev/mfp0 corresponds to LP:0 designation 
displayed in the scanners’ options, /dev/mfp1 
relates to LP:1 and so on. USB ports start at /
dev/mfp4, so scanner on USB:0 relates to /dev/
mfp4 respectively and so forth sequentially. In 
the Selected port pane you can see if the port is 
occupied by some other application. If this is 
the case, you should wait for completion of the 
current job or should press Release port 
button, if you are sure that the present port’s 
owner is not functioning properly.

Refer to Linux User’s Guide that came with your computer for further 
information on Linux error messages.

CONDITION SUGGESTED SOLUTIONS
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Common Macintosh problems

CONDITION SUGGESTED SOLUTIONS

The printer does not 
print PDF file correctly. 
Some parts of graphics, 
text, or illustrations are 
missing.

Incompatibility between the PDF file and 
the Acrobat products:
Printing the PDF file as an image may 
solve this problem. Turn on Print As 
Image from the Acrobat printing options.

It will take longer to print when 
you print a PDF file as an image.

The document has 
printed, but the print job 
has not disappeared 
from the spooler in Mac 
OS 10.3.2.

Update your Mac OS to OS 10.3.3. or 
higher.

Some letters are not 
displayed normally 
during the Cover page 
printing.

This problem is caused because Mac OS 
cannot create the font during the Cover 
page printing. English alphabet and 
numbers are displayed normally at the 
Cover page.

Refer to Mac OS User’s Guide that came with your computer for 
further information on Mac OS error messages.
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ordering supplies and accessories
This chapter provides information on purchasing cartridges and accessories available for your printer.

This chapter includes:
• Supplies
• Accessories

• How to purchase

SUPPLIES
When the toner runs out, you can order the following type of toner cartridge 
for your printer:

ACCESSORIES
You can purchase and install accessories to enhance your printer’s 
performance and capacity.

HOW TO PURCHASE
To order Dell-authorized supplies or accessories, contact your local Dell 
dealer or the retailer where you purchased your printer, or visit 
www.dell.com or support.dell.com and select your country/region to 
obtain information on calling for technical support.

The optional parts or features may differ by countries. Contact your 
sales representatives whether the part you want is available in your 
country.

TYPE AVERAGE YIELDA

a.Declared yield value in accordance with ISO/IEC 19798.

PART NUMBER

Standard yield 
toner cartridge

• Average continuous black 
cartridge yield: 2,500 
standard pages (Black)

• Average continuous 
colored cartridge yield: 
2,000 standard pages 
(Yellow/Magenta/Cyan)

T272J (Black)
P586K (Cyan)
K756K (Magenta)
M802K (Yellow)

High yield
toner cartridge

• Average continuous black 
cartridge yield: 5,500 
standard pages (Black)

• Average continuous 
colored cartridge yield: 
5,000 standard pages 
(Yellow/Magenta/Cyan)

R717J (Black)
P587K (Cyan)
K757K (Magenta)
M803K (Yellow)

Paper transfer 
belt

Approx. 50,000
When the transfer belt has 
worn out with abrasion, you 
need to change it. By this 
time you may be notified with 
the transfer belt-related 
message on the display.

U265J

When purchasing new print cartridges or other supplies, these must 
be purchased in the same country where the printer was purchased. 
Otherwise, print cartridges or other supplies will be incompatible with 
your printer, as configurations of print cartridges and other supplies 
vary, depending on the specific country.

ACCESSORY DESCRIPTION PART NUMBER

Memory module Extends your 
printer’s memory 
capacity.

KR039: 256 MB

Optional tray 2 If you are 
experiencing 
frequent paper 
supply problems, 
you can attach an 
additional 500 sheet 
tray. You can print 
documents in 
various sizes and 
types of print 
materials.

P955J

Hard Disk Allows you to 
enhance the printer’s 
capability and print in 
various ways.

N573K

Your printer may have two memory slots with a factory pre-installed 
memory module in one slot. When you are expanding the memory 
capacity, you can add a memory module to the vacant memory slot, 
according to the table above. It is strongly recommended that you 
expand a memory module in vacant memory slot only, without 
removing a pre-installed memory module. If your printer has 128 MB 
memory capacity and you want to add 256 MB, the memory capacity 
expands up to 384 MB.

http://support.dell.com
www.dell.com
www.dell.com
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installing accessories
Your printer is a full-featured model that has been optimized to meet most of your printing needs. Recognizing that each user may 
have different requirements, however, Dell makes several accessories available to enhance your printer’s capabilities.

This chapter includes:
• Precautions to take when installing accessories
• Activating the added accessories in printer properties

• Upgrading a memory module
• Using the hard disk

PRECAUTIONS TO TAKE WHEN INSTALLING 
ACCESSORIES
• Disconnect the power cord

Never remove the control board cover while the power is turned on.
To avoid the possibility of an electrical shock, always disconnect the 
power cord when installing or removing ANY internal or external 
accessories.

• Discharge static electricity
The control board and internal accessories (network interface card or 
memory module) are sensitive to static electricity. Before installing or 
removing any internal accessories, discharge static electricity from your 
body by touching something metal, such as the metal back plate on any 
device plugged into a grounded power source. If you walk around before 
finishing the installation, repeat this procedure to discharge any static 
electricity again.

• Activating the added accessories in the PS driver properties.
After installing an accessory such as an optional tray, PS driver users 
must do the additional setting. Go to the PS printer properties and set 
the added accessory activated. 

ACTIVATING THE ADDED ACCESSORIES IN 
PRINTER PROPERTIES
After installing added accessories, you need to select it in the printer 
properties of the printer driver in order to use it.
1. Install the driver (see "Installing the software" on page 19).
2. Click the Windows Start menu.

• For Windows 2000, select Settings → Printers.
• For Windows XP/2003, select Printers and Faxes.
• For Windows Vista/2008, select Control Panel → Hardware and 

Sound → Printers.
3. Select the your printer’s driver and right-click to open Properties. 

• For PS driver, select PS driver and right-click to open Properties.
4. In printer driver properties, select Device Options. 

• For PS driver, select Device Settings. 
5. In printer driver properties, set the necessary options.

• For PS driver, select the Installable Options section and set the 
necessary options.

6. Click OK. 

UPGRADING A MEMORY MODULE
Your printer has a dual in-line memory module (DIMM). Use this memory 
module slot to install additional memory.
The printer has two memory slots with a factory pre-installed memory 
module in one slot. When you are expanding the memory capacity, you can 
add a memory module to the vacant memory slot. It is strongly 
recommended that you expand a memory module in vacant memory slot 
only without removing a pre-installed memory module (see "Ordering 
supplies and accessories" on page 83).

Installing a memory module
1. Turn the printer off and unplug all cables from the printer.
2. Release the screws and remove the rear cover. 

3. Release the screws, then lift up the cover slightly and pull the cover to 
the right.

4. Take out a new memory module from the plastic bag.

When installing accessories, battery inside the printer is a service 
component. Do not change it by yourself.
Risk of explosion if battery is replaced by an incorrect type. Dispose 
used batteries according to the instructions.

1 Control board 
cover

If you want to remove an existing memory module, push the two 
latches at the ends of the module outward.
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5. Holding the memory module by the edges, align the memory module on 
the slot at about a 30-degree tilt. Ensure that the notches of the module 
and the grooves on the slot fit each other.

6. Press the memory module into the slot with care until you hear a 'click'. 

7. Replace the control board cover and fasten the cover with the screws.

8. Replace the rear cover and fasten the cover with the screw.
9. Reconnect the power cord and printer cable, and turn the printer on.

10. If you use the PS driver, you must activate the added memory in the PS 
driver properties.
See "Activating the added accessories in printer properties" on page 84.

USING THE HARD DISK
Installing the hard disk allows the data from your computer to be sent to the 
print queue of the printer hard disk. This decreases the workload of the 
computer. You can also use various print features, such as storing a job in 
the hard disk, proofing a job, and printing private documents.

Installing the hard disk
For order information, see "Accessories" on page 83. Review the 
precautions on page 84.
1. Turn the printer off and unplug all cables from the printer.
2. Release the screws and remove the rear cover.

3. Open the control board cover. Release the screws, then lift up the cover 
slightly and pull the cover to the right. 

4. Align the connector on the hard disk with the connector on the control 
board. Push the hard disk in until it is latched into place

.

The notches and grooves illustrated above may not match those 
on an actual memory module and its slot.

Do not press the memory module strongly or the module may be 
damaged. If the module does not seem to fit into the slot properly, 
carefully try the previous procedure again.

To release the memory module, pull the two tabs on the sides of 
the slot outwards, then the module springs out. 

1 control board 
cover
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5. Fasten the screws supplied with your new hard disk.

6. Replace the control board cover and fasten the cover with the screws.

7. Replace the rear cover and fasten the cover with the screw.
8. Reconnect the power cord and printer cable, and turn the printer on.
9. Print a configuration page from the control panel to check if the hard disk 

is correctly installed. See "Printing reports" on page 55.
10. If you use the PS driver, you must activate the added hard disk in the PS 

driver properties.
See "Activating the added accessories in printer properties" on page 84.

Printing with the optional hard disk
After installing the optional hard disk, you can use advanced printing 
features, such as storing or spooling a print job to the hard disk, proofing a 
job, and specifying of printing a private job in the printer properties window.
Once you have stored files in the hard disk, you can easily print or delete 
the stored files using the control panel of your printer.

Storing a job
You can store jobs in the installed hard disk.
1. Open the file you want to store.
2. Select Print from the File menu. The Print window displays.
3. Click Properties. If you see Setup, Print or Options, click the 

button instead.
4. Click the Other Options tab and click Job type.
5. Select the print mode you want from the drop-down list.

•  Normal: Prints in normal mode.
•  Proof: Prints the first file and after a pause prints the next file.
•  Confidentical: Stores the files, securing them with a password.
•  Store: Stores the file to the hard disk.
•  Spool: Spools the file into the hard disk and prints it from the hard 

disk queue.
•  Delay: Prints the file at a specified time.

6. Enter the user’s name and file name.
7. Click OK until the Print window is displayed.
8. Click OK or Print to start printing.

Printing a stored job
You can print jobs currently stored in the hard disk.
1. Press Menu ( ) until System Setup appears on the bottom line of 

the display and press OK.
2. Press the left/right arrow until Job Manage appears and press OK.
3. Press the left/right arrow until Store Job appears and press OK.
4. Press the left/right arrow until the user’s name and file name you 

want appear and press OK.
5. If the select file is a confidential print job, enter the specified 4-digit 

password. 
Press the left/right arrow to enter the first digit and press OK. The 
cursor automatically moves to the next digit position. Enter the 2nd, 
3rd, and 4th digit in the same way.

6. When Print appears, press OK.
If you enter the incorrect password, Invalid Password appears. 
Reenter the correct password.

7. Press the left/right arrow until the number of copies you want 
appears and press OK.

8. Press OK. Printing starts.

Deleting a stored job
You can delete jobs currently stored in the hard disk.
1. Press Menu ( ) until System Setup appears on the bottom line of 

the display and press OK.
2. Press the left/right arrow until Job Manage appears and press OK.
3. Press the left/right arrow until Store Job appears and press OK.
4. Press the left/right arrow until the user’s name and file name you 

want appear and press OK.
5. If the select file is a confidential print job, enter the specified 4-digit 

password. 
Press the left/right arrow to enter the first digit and press OK. The 
cursor automatically moves to the next digit position. Enter the 2nd, 
3rd, and 4th digit in the same way.

6. Press the left/right arrow until Delete appears and press OK.
If you enter the incorrect password, Invalid Password appears. 
Reenter the correct password.

7. When Yes appears, press OK.

Controlling the active job queue
All of the print jobs waiting to be printed are listed in the Active Job 
Queue in the order you sent them to the printer. You can delete a job 
from the queue before printing, or promote a job to print sooner.

To delete a file from the queue:
1. Press Menu ( ) until System Setup appears on the bottom line of 

the display and press OK.
2. Press the left/right arrow until Job Manage appears and press OK.
3. Press the left/right arrow until Active Job appears and press OK.
4. Press the left/right arrow until the user’s name and file name you 

want appear and press OK.
5. If the select file is a confidential print job, enter the specified 4-digit 

password. 
Press the left/right arrow to enter the first digit and press OK. The 
cursor automatically moves to the next digit position. Enter the 2nd, 
3rd, and 4th digit in the same way.
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6. Press the left/right arrow until Cancel appears and press OK.
If you enter the incorrect password, Invalid Password appears. 
Reenter the correct password.

7. Press the left/right arrow until Yes appears and press OK.

To promote a file from the queue:
You can select a job waiting in the Active Job Queue and change its 
print order so that it can be printed sooner.
1. Press Menu ( ) until System Setup appears on the bottom line of 

the display and press OK.
2. Press the left/right arrow until Job Manage appears and press OK.
3. Press the left/right arrow until Active Job appears and press OK.
4. Press the left/right arrow until the user’s name and file name you 

want appear and press OK.
5. If the select file is a confidential print job, enter the specified 4-digit 

password. 
Press the left/right arrow to enter the first digit and press OK. The 
cursor automatically moves to the next digit position. Enter the 2nd, 
3rd, and 4th digit in the same way.

6. Press the left/right arrow until Promote appears and press OK.
If you enter the incorrect password, Invalid Password appears. 
Reenter the correct password.

To print a file immediately:
You can print a job scheduled to be printed at a specified time 
immediately. In this case, the job currently printing is stopped and the 
selected job will be printed. This function is available when the job is 
scheduled for later printing.
1. Press Menu ( ) until System Setup appears on the bottom line of 

the display and press OK.
2. Press the left/right arrow until Job Manage appears and press OK.
3. Press the left/right arrow until Active Job appears and press OK.
4. Press the left/right arrow until the user’s name and file name you 

want appear and press OK.
5. If the select file is a confidential print job, enter the specified 4-digit 

password. 
Press the left/right arrow to enter the first digit and press OK. The 
cursor automatically moves to the next digit position. Enter the 2nd, 
3rd, and 4th digit in the same way.

6. Press the left/right arrow until Release appears and press OK. 
This option appears only when you select a Delay print job. See 
page 86.
If you enter the incorrect password, Invalid Password appears. 
Reenter the correct password.

Printing using the form files
You can store up to 10 form files in the hard disk and make them printed 
with your document. 
First, you need to create a form file using the printer driver. See the 
Software section.
1. Press Menu ( ) until System Setup appears on the bottom line of 

the display and press OK.
2. Press the left/right arrow until Form Menu appears and press OK.
3. Press the left/right arrow until the form you want appears and press OK.

•Off: Prints in normal mode.
•Single Form: Prints all page using the first form.
•Double Form: Prints the front page using the first form and the 
back page using the second form.

4. Press Back ( ) to return to the upper menu level.

5. Press the left/right arrow until Select Form appears and press OK.
6. Press OK when 1st Form appears.
7. Press the left/right arrow until the form file you want appears and 

press OK.
If you select Double Form, continue the next step.

8. Press the left/right arrow until 2nd Form appears and press OK.
9. Press the left/right arrow until the form file for the second form 

appears and press OK.

File policy
You can choose the file policy for generating file name before you proceed 
with the job through hard disk. If the hard disk memory already has the 
same name when you entered a new file name, you can rename or 
overwrite it.

1. Press Menu ( ) until System Setup appears on the bottom line of 
the display and press OK.

2. Press the left/right arrow until Job Manage appears and press OK.
3. Press the left/right arrow until File Policy appears and press OK.
4. Press the left/right arrow until the job setting you want appears and 

press OK.
• Rename: If the hard disk memory already has the same name when 

you enter a new file name, the file will be saved as a different name 
that is automatically programmed.

• Overwrite: You can set the printer to delete previous job information 
on hard disk as you store new job information.

5. Press OK.

Deleting residual image data
ImageOverwrite is a security measure for customers who are concerned 
about unauthorized access and duplication of classified or private 
document. 

1. Press Menu ( ) until System Setup appears on the bottom line of 
the display and press OK.

2. Press the left/right arrow until ImageOverwrite appears and press 
OK.

3. Press the left/right arrow until the job setting you want appears and 
press OK.

• Immediate: All residual image data from the printer will be erased 
immediately after each job has been processed.

• On Demand: This option provides an on-demand facility for a 
system administrator to erase all the real image data remained in 
hard disk after this option enabled. All existing jobs will be deleted 
regardless of their status and all job submissions will be prohibited 
for the duration of the overwrite.

4. Press the left/right arrow to move to On or Off  for Immediate.
Press the left/right arrow to move to Enable or Disable for On 
Demand.

5. Press OK.

If you selected On Demand enabled, the printer confirms if the 
overwrite feature starts now. Press the left/right arrow to select 
Yes or No. If you select Yes, On Demand overwrite starts as soon 
as you select Yes. If you select No, this feature will be enabled.
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specifications
This chapter guides you about this printer’s specifications such as various features.

This chapter include:
• General specifications
• Printer specifications
• Scanner specifications

• Copier specifications
• Facsimile specifications

GENERAL SPECIFICATIONS
The symbol * optional feature depending on printers.

ITEM DESCRIPTION

DADF Capacity Up to 50 sheets 75 g/m2 (20 lb bond) 

DADF 
document size

Width: 148 (5.8 inches) to 216 (8.5 inches) mm 
Length: 148 (5.8 inches) to 356 (14 inches) mm 

Paper input 
capacity

• Tray: 250 sheets for plain paper, 75 g/m2 (20 lb 
bond)

• Multi-purpose tray: 100 sheets for plain paper, 75 g/
m2 (20 lb bond)

• Optional tray: 500 sheets for plain paper, 75 g/m2 
(20 lb bond)

For details about paper input capacity, see 25 page.

Paper output 
capacity

Face down: 170 sheets 75 g/m2 (20 lb bond)

Power rating AC 110 - 127 V or AC 220 - 240 V
See the Rating label on the printer for the correct 
voltage, frequency (hertz) and type of current for your 
printer.

Power 
consumption

• Average operating mode: Less than 580 W
• Ready mode: Less than 82 W
• Power save mode: Less than 18 W
• Power off mode: 0 W

Noise Levela • Ready mode: Less than 32 dBA
• Printing mode: Less than 53 dBA
• Copying mode: Less than 54 dBA

Default time to 
power save 
mode from 
ready mode

20 Minutes

Boot-up time Less than 49 seconds
The boot-up time will be longer, if data volume is a lot in 
the HDD.

Operating 
environment

• Temperature: 15 to 32.5 °C (59 to 90.5 °F)
• Humidity: 20 to 80% RH

Display 16 characters x 2 lines

Toner 
cartridge lifeb

Black Average continuous black cartridge 
yield: 5,500 standard pages
(Shipped with 2,500 pages Starter 
toner cartridge.)

Color
(Yellow/
Magenta/
Cyan)

Average continuous colored cartridge 
yield: 5,000 standard pages
(Shipped with 2,000 pages Starter 
toner cartridge.)

Paper transfer 
belt

Approx. 50,000 pages (A4, Letter)

Memory 
(Expandable)*

128 MB (max. 384 MB)

External 
dimension
(W x D x H)

468 x 498 x 651 mm 
(18.4 x 19.6 x 25.6 inches) without optional tray

Weight
(Including 
consumables)

36 kg (79.37 lbs)

Package 
weight

• Paper: 5.8 Kg (12.7 lbs)
• Plastic: 1.8 Kg (3.9 lbs)

Duty cycle
(Monthly)

Up to 65,000 pages

Fusing 
temperature

180 °C (356 °F)

a.Sound Pressure Level, ISO 7779
b.Declared yield value in accordance with ISO/IEC 19798. The number of 

pages may be affected by operating environment, printing interval, 
media type, and media size.

ITEM DESCRIPTION
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PRINTER SPECIFICATIONS SCANNER SPECIFICATIONS

COPIER SPECIFICATIONS

ITEM DESCRIPTION

Printing method Color laser beam printing

Printing speeda

a.It will be affected by operating system used, computing performance, 
application software, connecting method, media type, media size and 
job complexity.

Up to 20 ppm (A4), 21 ppm (Letter)

Duplex printing 
speed

Up to 7 ipm (A4/Letter)

First print out 
time

Black & 
White

From ready: Less than 25 seconds
From coldboot: Less than 75 seconds

Color From ready: Less than 25 seconds
From coldboot: Less than 75 seconds

Print resolution Max. 2,400 x 600 dpi effective output

Printer language SPL, PostScript 3, PCL5ce and PCL6

OS compatibilityb

b.Visit www.dell.com to download the latest software version.

• Windows: 2000/XP/2003/2008/Vista
• Linux: RedHat 8.0~9.0, Mandrake 9.2~10.1, 

SuSE 8.2~9.2, Fedra Core 1~4
• Macintosh: Mac OS X 10.3~10.5, Universal Mac

Interface • High speed USB 2.0
• Ethernet 10/100 Base TX (embedded type)

ITEM DESCRIPTION

Compatibility TWAIN standard/WIA standard

Scanning method Color CCD

Resolutiona

a.Due to the applications for scanning, the maximum resolution might 
differ.

TWAIN 
standard/ 
WIA standard

• Optical: Up to 600 x 1,200 dpi
• Enhanced: Up to 4,800 x 4,800 

dpi

Scan to USB 100, 200, 300 dpi

Scan to E-
mail

100, 200, 300 dpi

Scan to PC 75, 150, 200, 300, 600 dpi

Network Scan 
File format

PDF, TIFF, JPEGb, BMP

b.JPEG is not available when you select the mono mode in scan color.

Effective 
scanning length

• Scanner glass: 289 mm (11.38 inches)
• DADF: 348 mm (13.7 inches)

Effective 
scanning width

Max. 208 mm (8.2 inches)

Color bit depth • Internal: 36 bit
• External: 24 bit

Mono bit depth • 1 bit for black & white mode
• 8 bit for gray scale

ITEM DESCRIPTION

Copy Speeda

a.Copy speed is based on Single Document Multiple Copy.

Up to 20 cpm (A4), 21 cpm (Letter)

Copy 
resolution

Text • DADF: Up to 600 x 600 dpi
• Scanner glass: Up to 600 x 600 dpi

Text/photo Up to 600 x 600 dpi

Magazine Up to 600 x 600 dpi

Photo • DADF: Up to 600 x 600 dpi
• Scanner glass: Up to 1,200 x 1,200 

dpi

Zoom range • DADF: 25% to 100%
• Scanner glass: 25% to 400%

www.dell.com
www.dell.com
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FACSIMILE SPECIFICATIONS

ITEM DESCRIPTION

Compatibility ITU-T G3

Applicable line Public Switched Telephone Network (PSTN) or 
behind PABX

Data coding MH/MR/MMR/JBIG/JPEG

Modem speed 33.6 Kbps

Transmission 
speed

Up to 3 seconds/pagea

a.Standard resolution, MMR(JBIG), Maximum modem speed, Phase ”C” 
by ITU-T No. 1 chart, Memory Tx, ECM.

Maximum 
document length

356 mm

Resolution Color 200 x 200 dpi

Black • Standard: Up to 203 x 98 dpi
• Fine: Up to 203 x 196 dpi
• Super Fine: Up to 300 x 300 dpi 

(Receiving only)

Memory 4 MB (Approx. 200 pages) 

Halftone 256 levels
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appendix
DELL TECHNICAL SUPPORT POLICY 
Technician-assisted technical support requires the cooperation and participation of the customer in the troubleshooting process and provides for restoration of the 
Operating System, application software and hardware drivers to the original default configuration as shipped from Dell, as well as the verification of appropriate 
functionality of the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical support is available at Dell 
Support. Additional technical support options may be available for purchase.

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for third-party software and peripherals is provided by 
the original manufacturer, including those purchased and/or installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration 
(CFI/DellPlus).

CONTACTING DELL 
You can access Dell Support at support.dell.com. Select your region on the WELCOME TO DELL SUPPORT page, and fill in the requested details to access help 
tools and information. 
You can contact Dell electronically using the following addresses: 
• World Wide Web 

www.dell.com/ 
www.dell.com/ap/ (Asian/Pacific countries only) 
www.dell.com/jp/ (Japan only) 
www.euro.dell.com (Europe only) 
www.dell.com/la/ (Latin American and Caribbean countries) 
www.dell.ca (Canada only) 

• Anonymous file transfer protocol (FTP) 
ftp.dell.com 
Log in as user: anonymous, and use your email address as your password. 

• Electronic Support Service 
mobile_support@us.dell.com 
support@us.dell.com 
la-techsupport@dell.com (Latin America and Caribbean countries only) 
apsupport@dell.com (Asian/Pacific countries only) 
support.jp.dell.com (Japan only) 
support.euro.dell.com (Europe only) 

• Electronic Quote Service
apmarketing@dell.com (Asian/Pacific countries only)
sale_canada@dell.com (Canada only)

WARRANTY AND RETURN POLICY
Dell Inc. (“Dell”) manufactures its hardware products from parts and components that are new or equivalent to new in accordance with industry-standard practices. 
For information about the Dell warranty for your printer, refer to the Product Information Guide.

support.dell.com
www.dell.com/ 
www.dell.com/ap/
www.dell.com/jp/
www.euro.dell.com
www.dell.com/la/
www.dell.ca
ftp.dell.com
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glossary

ADF
An Automatic Document Feeder (ADF) is a mechanism that will 
automatically feed an original sheet of paper so that the printer can scan 
some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Macintosh (1984) 
and is now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher color 
depth gives a broader range of distinct colors. As the number of bits 
increases, the number of possible colors becomes impractically large for 
a color map. 1-bit color is commonly called as monochrome or black and 
white.

BMP
A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file 
format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the bootstrap 
process of computers or operating systems running on them. The 
BOOTP servers assign the IP address from a pool of addresses to each 
client. BOOTP enables 'diskless workstation' computers to obtain an IP 
address prior to loading any advanced operating system.

CCD 
Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the printer.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in front of 
the printer. 

Coverage 
It is the printing term used for a toner usage measurement on printing. 
For example, 5% coverage means that an A4 sided paper has about 5% 
image or text on it. So, if the paper or original has complicated images or 
lots of text on it, the coverage will be higher and at the same time, a 
toner usage will be as much as the coverage.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it is 
used in Microsoft Excel, has become a pseudo standard throughout the 
industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a mechanism that will 
automatically feed and flip over an original sheet of paper so that the 
printer can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its box 
state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network. DHCP also 
provides a mechanism for allocation of IP addresses to client hosts.

DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the printer like printing data, 
received fax data.

DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks, 
such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head 
that runs back and forth on the page and prints by impact, striking an 
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD 
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line to 
answer several different telephone numbers.

Duplex
A mechanism that will automatically flip over a sheet of paper so that the 
printer can print (or scan) on both sides of the paper. A printer equipped 
with a Duplex can print double-sided of paper.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan limitation 
such as pages per year. The lifespan means the average capacity of 
print-outs, usually within the warranty period. For example, if the duty 
cycle is 48,000 pages per month assuming 20 working days, a printer 
limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built into 
Class 1 fax printers or fax modems. It automatically detects and corrects 
errors in the fax transmission process that are sometimes caused by 
telephone line noise.

Emulation
Emulation is a technique of one printer obtaining the same results as 
another.

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well 
as mentioned in this user's guide.
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An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, which is 
in contrast to simulation, which concerns an abstract model of the 
system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized 
as IEEE 802.3. It has become the most widespread LAN technology in 
use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Macintosh (1984) and is now 
deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the printer to 
allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your printer.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that melts the toner onto the print media. It 
consists of a hot roller and a back-up roller. After toner is transferred 
onto the paper, the fuser unit applies heat and pressure to ensure that 
the toner stays on the paper permanently, which is why paper is warm 
when it comes out of a laser printer.

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or a 
network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are represented 
by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of dots. 
Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.

HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded data 
on rapidly rotating platters with magnetic surfaces.

IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the advancement 
of technology related to electricity.

IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to 
a specific connector type on the end of the parallel cable that attaches to 
the peripheral (for example, a printer). 

Intranet
A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of 
an organization's information or operations with its employees. 
Sometimes the term refers only to the most visible service, the internal 
website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in 
order to identify and communicate with each other on a network utilizing 
the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a printer 
can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and so 
forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing solution 
than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international radio 
and telecommunications. Its main tasks include standardization, 
allocation of the radio spectrum, and organizing interconnection 
arrangements between different countries to allow international phone 
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 
compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is the 
format used for storing and transmitting photographs on the World Wide 
Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over TCP/
IP.
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LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates 
the status of a printer.  

MAC address
Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier usually 
written as 12 hexadecimal characters grouped in pairs (e. g., 00-00-0c-
34-11-4e). This address is usually hard-coded into a Network Interface 
Card (NIC) by its manufacturer, and used as an aid for routers trying to 
locate printers on large networks.

MFP
Multi Function Peripheral (MFP) is an office printer that includes the 
following functionality in one physical body, so as to have a printer, a 
copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax printers to 
transfer the image recommended by ITU-T T.4. MH is a codebook-
based run-length encoding scheme optimized to efficiently compress 
white space. As most faxes consist mostly of white space, this 
minimizes the transmission time of most faxes. 

MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital information, 
and also demodulates such a carrier signal to decode transmitted 
information.

MR
Modified Read (MR) is a compression method recommended by ITU-T 
T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.

NetWare
A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and it is 
usually green or gray colored and a cylinder shaped. 
An exposing unit of a drum is slowly worn away by its usage of the 
printer, and it should be replaced appropriately since it gets scratches 
from grits of a paper.

Originals
The first example of something, such as a document, photograph or text, 
etc, which is copied, reproduced or translated to produce others, but 
which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for communications. 
OSI offers a standard, modular approach to network design that divides 
the required set of complex functions into manageable, self-contained, 
functional layers. The layers are, from top to bottom, Application, 
Presentation, Session, Transport, Network, Data Link and Physical.

PABX 
A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL has 
been released in varying levels for thermal, matrix printer, and page 
printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two dimensional documents in a 
device independent and resolution independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas. - 
that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the computer 
to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can 
be used on a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for determining 
how fast a printer works, meaning the number of pages a printer can 
produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
See PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the 
world's public circuit-switched telephone networks which, on industrial 
premises, is usually routed through the switchboard.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
between nodes on a network. It also provides an authenticated Inter-
process communication mechanism.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, text-
based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-server 
protocol, where the client transmits an email message to the server.
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Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and which 
part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP); 
the set of communications protocols that implement the protocol stack 
on which the Internet and most commercial networks run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible and 
platform-independent format can be used for pictures that have been 
made by various image processing applications.

Toner Cartridge
A kind of bottle within a printer like printer which contains toner. Toner is 
a powder used in laser printers and photocopiers, which forms the text 
and images on the printed paper. Toner can be melted by the heat of the 
fuser, causing it to bind to the fibers in the paper.

TWAIN
An industry standard for scanners and software. By using a TWAIN-
compliant scanner with a TWAIN-compliant program, a scan can be 
initiated from within the program.; an image capture API for Microsoft 
Windows and Apple Macintosh operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access network 
shares in Window NT and other Microsoft products. The format of a 
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and peripherals. 
Unlike the parallel port, USB is designed to concurrently connect a 
single computer USB port to multiple peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that appears 
lighter when viewed by transmitted light. Watermarks were first 
introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is 
originally introduced in Windows Me and Windows XP. A scan can be 
initiated from within these operating systems by using a WIA-compliant 
scanner.
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1 Installing Printer 
Software in Windows
This chapter includes:

• Installing Printer Software

• Reinstalling Printer Software

• Removing Printer Software

NOTE: The following procedure is based on Microsoft® 
Windows® XP, for other operating systems, refer to the 
corresponding Windows user's guide or online help.

Installing Printer Software
You can install the printer software for local printing or network 
printing. To install the printer software on the computer, 
perform the appropriate installation procedure depending on 
the printer in use.

A printer driver is software that allows your computer to 
communicate with your printer. The procedure to install drivers 
may differ depending on the operating system you are using.

All applications should be closed on your computer before 
beginning installation. 

Installing Software for Local Printing
A local printer is a printer directly attached to your computer 
using the printer cable supplied with your printer, such as a 
USB or parallel cable. If your printer is attached to a network, 
skip this step and go to "Installing Software for Network 
Printing" on page 6.

You can install the printer software using the typical or custom 
method.

NOTE: If the “New Hardware Wizard” window appears during 
the installation procedure, click  in the upper right corner of 
the window to close the window, or click Cancel.

Typical Installation

This is recommended for most users. All components necessary 
for printer operations will be installed.

1 Ensure that the printer is connected to your computer and 
powered on.

2 Insert the Drivers and Utilities CD into your computer’s 
optical drive.

The CD should automatically run, and an installation 
window appears.
If the installation window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter which represents your drive and click OK.

If you use Windows Vista®, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista, click 
Run Setup.exe in Install or run program field, and 
click Continue in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.

4 Select Typical installation for a local printer. Click 
Next.
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NOTE: If your printer is not already connected to the 
computer, the following window will appear.

• After connecting the printer, click Next.
• If you do not want to connect the printer at this time, click 

Next, and No on the following screen. Then the installation 
will start and a test page will not be printed at the end of the 
installation.

• The installation window that appears in this User’s 
Guide may differ depending on the printer and 
interface in use.

5 After the installation is finished, a window asking you to 
print a test page appears. If you choose to print a test 
page, select the checkbox and click Next.

Otherwise, just click Next and skip to step 7.

6 If the test page prints out correctly, click Yes.

If not, click No to reprint it.
7 Click Finish.

NOTE: After setup is complete, if your printer driver does not 
work properly, reinstall the printer driver. See "Reinstalling 
Printer Software" on page 9.

Custom Installation

You can choose individual components to install.

1 Ensure that the printer is connected to your computer and 
powered on.

2 Insert the Drivers and Utilities CD into your computer’s 
optical drive.
The CD should automatically run, and an installation 
window appears.

If the installation window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter which represents your drive and click OK.

If you use Windows Vista®, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista,® click 
Run Setup.exe in Install or run program field, and 
click Continue in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.

4 Select Custom installation. Click Next.

5 Select your printer and click Next.
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NOTE: If your printer is not already connected to the 
computer, the following window will appear.

• After connecting the printer, click Next.
• If you do not want to connect the printer at this time, click 

Next, and No on the following screen. Then the installation 
will start and a test page will not be printed at the end of the 
installation.

• The installation window that appears in this User’s 
Guide may differ depending on the printer and 
interface in use.

6 Select the components to be installed and click Next.

NOTE: You can change the desired installation folder by 
clicking [Browse].

7 After the installation is finished, a window asking you to 
print a test page appears. If you choose to print a test 
page, select the checkbox and click Next.

Otherwise, just click Next and skip to step 9.

8 If the test page prints out correctly, click Yes.

If not, click No to reprint it.
9 Click Finish.

Installing Software for Network 
Printing
When you connect your printer to a network, you must first 
configure the TCP/IP settings for the printer. After you have 
assigned and verified the TCP/IP settings, you are ready to 
install the software on each computer on the network.

You can install the printer software using the typical or custom 
method.

Typical Installation

This is recommended for most users. All components necessary 
for printer operations will be installed.

1 Ensure that the printer is connected to your network and 
powered on. For details about connecting to the network, 
see the Getting started chapter.

2 Insert the Drivers and Utilities CD into your computer’s 
optical drive.
The CD should automatically run, and an installation 
window appears.

If the installation window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter which represents your drive and click OK.

If you use Windows Vista®, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista®, click 
Run Setup.exe in Install or run program field, and 
click Continue in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.
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4 Select Typical installation for a network printer. Click 
Next.

5 The list of printers available on the network appears. 
Select the printer you want to install from the list and then 
click Next. 

• If you do not see your printer on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your 
printer to the network. To add the printer to the 
network, enter the port name and the IP address for the 
printer.

To verify your printer’s IP address or the MAC address, 
print a Network Configuration page in machine.

• To find a shared network printer (UNC Path), select 
Shared Printer [UNC] and enter the shared name 
manually or find a shared printer by clicking the Browse 
button.

NOTE:  If you cannot find your machine in the network, please 
turn off the firewall and click Update. 
For Windows operating system, click Start → Control Panel  
and  start windows firewall, and set this option unactivated. 
For other operating system, refer to its on-line guide.

6 Click Finish.

NOTE: After setup is complete, if your printer driver does not 
work properly, reinstall the printer driver. See "Reinstalling 
Printer Software" on page 9.

Custom Installation

You can choose individual components to install and set a 
specific IP address.

1 Ensure that the printer is connected to your network and 
powered on. For details about connecting to the network, 
see the Getting started chapter.

2 Insert the Drivers and Utilities CD into your computer’s 
optical drive.
The CD should automatically run, and an installation 
window appears.

If the installation window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter which represents your drive and click OK.

If you use Windows Vista®, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista®, click 
Run Setup.exe in Install or run program field, and 
click Continue in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.
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4 Select Custom installation. Click Next.

5 The list of printers available on the network appears. 
Select the printer you want to install from the list and then 
click Next. 

• If you do not see your printer on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your 
printer to the network. To add the printer to the 
network, enter the port name and the IP address for the 
printer.

To verify your printer’s IP address or the MAC address, 
print a Network Configuration page in machine.

• To find a shared network printer (UNC Path), select 
Shared Printer [UNC] and enter the shared name 
manually or find a shared printer by clicking the Browse 
button.

NOTE: If you cannot find your machine in network, please turn 
off the firewall and click Update.
For Windows operating system, click Start → Control Panel  
and  start windows firewall, and set this option unactivated. 
For other operating system, refer to its on-line guide.

TIP: If you want to set a specific IP address on a specific 
network printer, click the Set IP Address button. The Set IP 
Address window appears. Do as follows:

a. Select a printer to be set with a specific IP address from the 
list.

b. Configure an IP address, subnet mask, and gateway for the 
printer manually and click Configure to set the specific IP 
address for the network printer.

c. Click Next.

6 Select the components to be installed. After selecting the 
components, the following window appears. You can also 
change the printer name, set the printer to be shared on 
the network, set the printer as the default printer, and 
change the port name of each printer. Click Next.

To install this software on a server, select the Setting up 
this printer on a server checkbox.

7 Click Finish.

NOTE: After setup is complete, if your printer driver does not 
work properly, reinstall the printer driver. See "Reinstalling 
Printer Software" on page 9.



Installing Printer Software in Windows
9

Reinstalling Printer Software
You can reinstall the software if installation fails.
1 Start Windows.

2 From the Start menu select Programs or All Programs 
→ your printer driver name → Maintenance.

3 Select Repair and click Next.

4 The list of printers available on the network appears. 
Select the printer you want to install from the list and then 
click Next. 

• If you do not see your printer on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your 
printer to the network. To add the printer to the 
network, enter the port name and the IP address for the 
printer.

• To find a shared network printer (UNC Path), select 
Shared Printer [UNC] and enter the shared name 
manually or find a shared printer by clicking the Browse 
button.

You will see a component list so that you can reinstall any 
item individually.

NOTE: If your printer is not already connected to the 
computer, the following window will appear.

• After connecting the printer, click Next.
• If you do not want to connect the printer at this time, click 

Next, and No on the following screen. Then the installation 
will start and a test page will not be printed at the end of the 
installation.

• The reinstallation window that appears in this User’s 
Guide may differ depending on the printer and 
interface in use.

5 Select the components you want to reinstall and click 
Next.

If you installed the printer software for local printing 
and you select your printer driver name, the window 
asking you to print a test page appears. Do as follows:

a. To print a test page, select the check box and click 
Next.

b. If the test page prints out correctly, click Yes.

If it do not, click No to reprint it.
6 When the reinstallation is done, click Finish.

Removing Printer Software

1 Start Windows.

2 From the Start menu select Programs or All Programs 
→ your printer driver name → Maintenance.

3 Select Remove and click Next.

You will see a component list so that you can remove any 
item individually.

4 Select the components you want to remove and then click 
Next.

5 When your computer asks you to confirm your selection, 
click Yes.

The selected driver and all of its components are removed 
from your computer.

After the software is removed, click Finish.
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2 Basic Printing 
This chapter explains the printing options and common printing 
tasks in Windows. 

This chapter includes:

• Printing a Document

• Printing to a file (PRN)

• Printer Settings

- Layout Tab

- Paper Tab

- Graphics Tab

- Other Options Tab

- About Tab

- Printer Tab

- Using a Favorite Setting

- Using Help

Printing a Document

NOTES: 
• Your printer driver Properties window that appears in this 

User’s Guide may differ depending on the printer in use. 
However the composition of the printer properties window is 
similar.

• Check the Operating System(s) that are compatible 
with your printer. Please refer to the OS Compatibility 
section of Printer Specifications in your Printer User’s 
Guide.

• If you need to know the exact name of your printer, you can 
check the supplied Drivers and Utilities CD.

• When you select an option in printer properties, you may see 
an exclamation mark or mark. An exclamation mark 
means you can select that certain option but it is not 
recommended, and mark means you cannot select that 
option due to the machine’s setting or environment.

The following procedure describes the general steps required 
for printing from various Windows applications. The exact steps 
for printing a document may vary depending on the application 
program you are using. See the User’s Guide of your software 
application for the exact printing procedure.
1 Open the document you want to print.

2 Select Print from the File menu. The Print window is 
displayed. It may look slightly different depending on your 
application. 

The basic print settings are selected within the Print 
window. These settings include the number of copies and 
print range.

3 Select your printer driver from the Name drop-down 
list.

To take advantage of the printer features provided by your 
printer driver, click Properties or Preferences in the 
application’s Print window. For details, see “Printer 
Settings” on page 5.

If you see Setup, Printer, or Options in your Print 
window, click it instead. Then click Properties on the next 
screen.

Click OK to close the printer properties window.
4 To start the print job, click OK or Print in the Print 

window.

Printing to a file (PRN)  
You will sometimes need to save the print data as a file for your 
purpose. 

To create a file:
1 Check the Print to file box in the Print window.

2 Click Print.

3 Enter the folder name and assign a name of the file and 
then click OK.

Ensure that your 
printer is selected.
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Printer Settings
You can use the printer properties window, which allows you to 
access all of the printer options you need when using your 
printer. When the printer properties are displayed, you can 
review and change the settings needed for your print job. 

Your printer properties window may differ, depending on your 
operating system. This Software User’s Guide shows the 
Properties window for Windows XP.

Your printer driver Properties window that appears in this 
User’s Guide may differ depending on the printer in use.

If you access printer properties through the Printers folder, you 
can view additional Windows-based tabs (refer to your 
Windows User’s Guide) and the Printer tab (see “Printer Tab” on 
page 8).

NOTES:
• Most Windows applications will override settings you specify 

in the printer driver. Change all print settings available in 
the software application first, and change any remaining 
settings using the printer driver. 

• The settings you change remain in effect only while you are 
using the current program. To make your changes 
permanent, make them in the Printers folder. 

• The following procedure is for Windows XP. For other 
Windows operating systems, see the corresponding Windows 
User's Guide or online help.
1. Click the Windows Start button.
2. Select Printers and Faxes.
3. Select your printer driver icon.
4. Right-click on the printer driver icon and select 

Printing Preferences.
5. Change the settings on each tab, click OK.

Layout Tab
The Layout tab provides options to adjust how the document 
appears on the printed page. The Layout Options includes 
Multiple Pages per Side,  Poster Printing and Booklet 
Printing. See “Printing a Document” on page 4 for more 
information on accessing printer properties.  

Paper Orientation
Paper Orientation allows you to select the direction in which 
information is printed on a page. 
• Portrait prints across the width of the page, letter style. 
• Landscape prints across the length of the page, spreadsheet 

style. 
• Rotate allows you to rotate the page the selected degrees.

Layout Options
Layout Options allows you to select advanced printing options. 
You can choose Multiple Pages per Side and Poster Printing.
• For details, see “Printing Multiple Pages on One Sheet of Paper 

(N-Up Printing)” on page 10.
• For details, see “Printing Posters” on page 11
• For details, see “Printing Booklets” on page 11

Double-sided Printing
Double-sided Printing allows you to print on both sides of 
paper. If this option does not appear, your printer does 
not have this feature.
• For details, see “Printing on Both Sides of Paper” on page 12.

 Landscape Portrait
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Paper Tab
Use the following options to set the basic paper handling 
specifications when you access the printer properties. See 
“Printing a Document” on page 4 for more information on 
accessing printer properties. 

Click the Paper tab to access various paper properties. 

Copies
Copies allows you to choose the number of copies to be printed. 
You can select 1 to 999 copies. 

Paper Options

Size
Size allows you to set the size of paper you loaded in the tray. 
If the required size is not listed in the Size box, click Custom. 
When the Custom Paper Setting window appears, set the paper 
size and click OK. The setting appears in the list so that you can 
select it. 

Source
Ensure that Source is set to the corresponding paper tray.
Use Multi-Purpose Tray when printing on special materials like 
envelopes and transparencies. You have to load one sheet at a 
time into the Manual Tray or Multi-Purpose Tray.
If the paper source is set to Auto Selection, the printer 
automatically picks up print material in the following tray order: 
Manual Tray or Multi-Purpose Tray, Tray n.

Type
Set Type to correspond to the paper loaded in the tray from 
which you want to print. This will let you get the best quality 
printout. If not, print quality may not be acheived as you want.

• Thin Paper: Less than 19 lb (70 g/m2) thin paper.

• Thick Paper: 24 lb to 32 lb (90~120 g/m2) thick paper. 
• Bond Paper: When you use the bond paper, select this 

option.

• Cotton Paper: 20 lb to 24 lb (75~90 g/m2) cotton paper such 
as Gilbert 25 % and Gilbert 100 %. 

• Archive Paper: When you need to keep print-out for a long 
period time such as archives, select this option.

• Plain Paper: Normal plain paper. Select this type if your 
printer is monochrome and printing on the 16 lb (60 g/m2) 
cotton paper. 

• Recycled Paper: 20 lb to 24 lb (75~90 g/m2) recycled paper.

• Color Paper: 20 lb to 24 lb (75~90 g/m2) color-
backgrounded paper.  

First Page 
This property allows you to print the first page using a different 
paper type from the rest of the document. You can select the 
paper source for the first page. 
For example, load thick stock for the first page into the Multi-
purpose Tray, and plain paper into Tray n. Then, select Tray n in 
the Source option and Multi-Purpose Tray in the First Page 
option. If this option does not appear, your printer does 
not have this feature.

Scaling Printing
Scaling Printing allows you to automatically or manually scale 
your print job on a page. You can choose from None, Reduce/
Enlarge, and Fit to Page. 
• For details, see “Printing a Reduced or Enlarged Document” on 

page 12.
• For details, see “Fitting Your Document to a Selected Paper 

Size” on page 12.
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Graphics Tab
Use the following Graphic options to adjust the print quality for 
your specific printing needs. See “Printing a Document” on 
page 4 for more information on accessing printer properties. 

Click the Graphic tab to display the properties shown below.

Quality
The Quality options you can select may vary depending 
on your printer model. The higher the setting, the sharper the 
clarity of printed characters and graphics. The higher setting also 
may increase the time it takes to print a document. 

Color Mode
You can choose color options. Setting to Color typically produces 
the best possible print quality for color documents. If you want to 
print a color document in grayscale, select Grayscale. If you 
want to adjust the color options manually, select Manual and 
click the Color Adjust or Color Matching button.
• Copies Setting : In order to use this option, first you need to 

set total number of copies from Paper tab. When you make 
several copies, and if you want to print some copies in color and 
some in grayscale, use this option and select the number of 
copies in grayscale. 

• Color Adjust : You can adjust the appearance of images by 
changing the settings in the Levels option.

• Color Matching : You can adjust the appearance of images by 
changing the settings in the Settings option.

Advanced Options

You can set advanced settings by clicking the Advanced 
Options button. 
• Raster Compression: This option determines the 

compression level of images for transferring data from a 
computer to a printer. If you set this option to Maximum, the 
printing speed will be high, but the printing quality will be low. 
This feature is available only when you use the PCL 6 
printer driver.

• TrueType Options: This option determines what the driver 
tells the printer about how to image the text in your document. 
Select the appropriate setting according to the status of your 
document. This feature is available only when you use 
the PCL 6  printer driver.

- Download as Outline: When this option is selected, the 
driver will download any TrueType fonts that are used in your 
document not already stored (resident) on your printer. If, 
after printing a document, you find that the fonts did not print 
correctly, choose Download as bit image and resubmit your 
print job. The Download as bit image setting is often useful 
when printing Adobe. This feature is available only 
when you use the PCL 6 printer driver.

- Download as Bitmap: When this option is selected, the    
driver will download the font data as bitmap images.    
Documents with complicated fonts, such as Korean or    
Chinese, or various other fonts, will print faster in this 
setting.This feature is available only when you use 
the PCL 6  printer driver.

- Print as Graphics: When this option is selected, the driver 
will download any fonts as graphics. When printing documents 
with high graphic content and relatively few TrueType fonts, 
printing performance (speed) may be enhanced in this 
setting. This feature is available only when you use 
the PCL 6  printer driver.

• Print all text in black: When the Print all text in black 
option is checked, all text in your document prints solid black, 
regardless of the color it appears on the screen. 

• Print All Text To Darken: When the Print All Text To 
Darken option is checked, all text in your document is allowed 
to print darker than on a normal document.

• Grayscale Enhancement: Press the Smart Color tab. It 
allows users to preserve the details of nature photos, and 
improve contrast and readability among grayscale colors, 
when printing color documents in grayscale. 

• Fine Edge: Press the Smart Color tab. It allows users to 
emphasize edges of texts and fine lines for improving 
readability and align each color channel registration in color 
printing mode.
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Other Options Tab
You can select output options for your document. See “Printing 
a Document” on page 4 for more information about accessing 
the printer properties.

Click the Other Options tab to access the following feature:  

Watermark
You can create a background text image to be printed on each 
page of your document. For details, see “Using Watermarks” on 
page 13.

Overlay
Overlays are often used to take the place of preprinted forms and 
letterhead paper. For details, see “Using Overlays” on page 14.

Output Options
• Print Subset: You can set the sequence in which the pages 

print. Select the print order from the drop-down list.
- Normal (1,2,3): Your printer prints all pages from the first 
page to the last page.

- Reverse All Pages (3,2,1): Your printer prints all pages 
from the last page to the first page.

- Print Odd Pages: Your printer prints only the odd 
numbered pages of the document.

- Print Even Pages: Your printer prints only the even 
numbered pages of the document.

• Use Printer Fonts: When Use Printer Fonts is checked, the 
printer uses the fonts that are stored in its memory (resident 
fonts) to print your document, rather than downloading the 
fonts used in your document. Because downloading fonts takes 
time, selecting this option can speed up your printing time. 
When using Printer fonts, the printer will try to match the fonts 
used in your document to those stored in its memory. If, 
however, you use fonts in your document that are very different 
from those resident in the printer, your printed output will 
appear very different from what it looks like on the screen.  
This feature is available only when you use the PCL 6 
printer driver.

• Save as Form for Overlay: Select Save as Form for Overlay to 
save the document as a form file (C:\FORMOVER\*.FOM). Once 
this option is selected, the printer driver requires the file name 
and the destination path each time you print. If you want to 
preset the file name and specify the path, click on the button in 

the Output to area, and type the file name and specify the path. 
This feature is available only when you use the PCL 6 
printer driver.

Job type
Job Setting dialog allows you to select how to print or save the 
printing file by using the optional HDD. Some printers do not 
support this feature.

Using Onscreen Help File

• For more information about  Job type, click  at the top 
right corner of the window. The Job type Help window 
opens and allows you to view onscreen help supplied on the 
Job type.

About Tab
Use the About tab to display the copyright notice and the 
version number of the driver. If you have an Internet browser, 
you can connect to the Internet by clicking on the web site icon. 
See “Printing a Document” on page 4 for more information 
about accessing printer properties.

Printer Tab
If you access printer properties through the Printers folder, 
you can view the Printer tab. You can set the printer 
configuration.

The following procedure is for Windows XP. For other Windows 
OS, refer to the corresponding Windows User's Guide or online 
help.
1 Click the Windows Start menu. 

2 Select Printers and Faxes.

3 Select your printer driver icon. 

4 Right-click on the printer driver icon and select 
Properties.

5 Click the Printer tab and set the options.  
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Using a Favorite Setting  
The Favorites option, which is visible on each properties tab, 
allows you to save the current properties settings for future 
use. 

To save a Favorites item:

1 Change the settings as needed on each tab. 

2 Enter a name for the item in the Favorites input box. 

3 Click Save. 

When you save Favorites, all current driver settings are 
saved.

To use a saved setting, select the item from the Favorites drop 
down list. The printer is now set to print according to the 
Favorites setting you selected. 

To delete a Favorites item, select it from the list and click 
Delete. 

You can also restore the printer driver’s default settings by 
selecting Printer Default from the list. 

Using Help
Your printer has a help screen that can be activated by clicking 
the Help button in the printer properties window. These help 
screens give detailed information about the printer features 
provided by the printer driver.

You can also click  from the upper right corner of the window, 
and then click on any setting. 
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3 Advanced Printing
This chapter explains printing options and advanced printing 
tasks. 

NOTE: 
• Your printer driver Properties window that appears in this 

User’s Guide may differ depending on the printer in use. 
However the composition of the printer properties window is 
similar.

• If you need to know the exact name of your printer, you can 
check the supplied Drivers and Utilities CD.

This chapter includes:

• Printing Multiple Pages on One Sheet of Paper (N-Up 
Printing)

• Printing Posters

• Printing Booklets

• Printing on Both Sides of Paper

• Printing a Reduced or Enlarged Document

• Fitting Your Document to a Selected Paper Size

• Using Watermarks

• Using Overlays

Printing Multiple Pages on One 
Sheet of Paper (N-Up Printing) 
You can select the number of pages to print on a single sheet 
of paper. To print more than one page per sheet, the pages will 
be reduced in size and arranged in the order you specify. You 
can print up to 16 pages on one sheet.  

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 4.

2 From the Layout tab, choose Multiple Pages per Side in 
the Layout Type drop-down list. 

3 Select the number of pages you want to print per sheet 
(1, 2, 4, 6, 9, or 16) in the Pages per Side drop-down 
list.

4 Select the page order from the Page Order drop-down 
list, if necessary. 

Check Print Page Border to print a border around each 
page on the sheet. 

5 Click the Paper tab, select the paper source, size, and 
type.

6 Click OK and print the document. 

1 2

3 4
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Printing Posters
This feature allows you to print a single-page document onto 4, 
9, or 16 sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 4.

2 Click the Layout tab, select Poster Printing in the 
Layout Type drop-down list.

3 Configure the poster option:

You can select the page layout from Poster<2x2>, 
Poster<3x3>, Poster<4x4> or Custom. If you select 
Poster<2x2>, the output will be automatically stretched 
to cover 4 physical pages. If the option is set to Custom, 
you can enlarge the original from 150% to 400%. 
Depending on the level of the enlargement, the page 
layout is automatically adjusted to Poster<2x2>, 
Poster<3x3>, Poster<4x4>.

Specify an overlap in millimeters or inches to make it 
easier to pasting the sheets together. 

4 Click the Paper tab, select the paper source, size, and 
type.

5 Click OK and print the document. You can complete the 
poster by pasting the sheets together. 

0.15 inches

0.15 inches

Printing Booklets 

This printer feature allows you to print your document on both 
sides of the paper and arranges the pages so that the paper can 
be folded in half after printing to produce a booklet. 
1 To change the print settings from your software 

application, access the printer properties. See “Printing a 
Document” on page 4.

2 From the Layout tab, choose Booklet Printing from the 
Layout Type drop-down list. 

NOTE: The Booklet Printing option is not available for all 
paper sizes. In order to find out the available paper size for 
this feature, select the paper size in the Size option on the 
Paper tab, then check if the Booklet Printing in a Layout 
Type drop-down list on the Layout tab is activated.

3 Click the Paper tab, and select the paper source, size, and 
type.

4 Click OK and print the document.

5 After printing, fold and staple the pages. 

8 9
8 9
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Printing on Both Sides of Paper
You can print on both sides of a sheet of paper. Before printing, 
decide how you want your document oriented.

The options are:

• Printer Setting, if you select this option, this feature is 
determined by the setting you’ve made on the control 
panel of the printer. If this option does not appear, 
your printer does not have this feature.

• None

• Long Edge, which is the conventional layout used in 
book binding.

• Short Edge, which is the type often used with calendars.

• Reverse Duplex Printing, allows you to select general 
print order compare to duplex print order. If this option 
does not appear, your printer does not have this 
feature.

NOTE: Do not print on both sides of labels, transparencies, 
envelopes, or thick paper. Paper jamming and damage to the 
printer may result. 

1 To change the print settings from your software 
application, access printer properties. “Printing a 
Document” on page 4.

2 From the Layout tab, select the paper orientation.

3 From the Double-sided Printing section, select the 
binding option you want.     

4 Click the Paper tab and select the paper source, size, and 
type.

5 Click OK and print the document.

NOTE: If your printer does not have a duplex unit, you should 
complete the printing job manually. The printer prints every 
other page of the document first. After printing the first side of 
your job, the Printing Tip window appears. Follow the on-
screen instructions to complete the printing job.

 Long Edge▲  Short Edge▲

2 5
3

2

5
3

2 5
3

2

5
3

Printing a Reduced or Enlarged 
Document 
You can change the size of a page’s content to appear larger or 
smaller on the printed page. 

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 4. 

2 From the Paper tab, select Reduce/Enlarge in the 
Output size drop-down list. 

3 Enter the scaling rate in the Percentage input box.

You can also click the  or  button.
4 Select the paper source, size, and type in Paper Options. 

5 Click OK and print the document. 

Fitting Your Document to a 
Selected Paper Size
This printer feature allows you to scale your print job to any 
selected paper size regardless of the digital document size. This 
can be useful when you want to check fine details on a small 
document. 

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 4.

2 From the Paper tab, select Fit to Page in the Output 
size drop-down list. 

3 Select the correct size from the Output size drop-down 
list.

4 Select the paper source, size, and type in Paper Options.

5 Click OK and print the document.

A
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Using Watermarks
The Watermark option allows you to print text over an existing 
document. For example, you may want to have large gray 
letters reading “DRAFT” or “CONFIDENTIAL” printed diagonally 
across the first page or all pages of a document. 

There are several predefined watermarks that come with the 
printer, and they can be modified, or you can add new ones to 
the list. 

Using an Existing Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 4. 

2 Click the Other Options tab, and select the desired 
watermark from the Watermark drop-down list. You will 
see the selected watermark in the preview image. 

3 Click OK and start printing. 

NOTE: The preview image shows how the page will look when 
it is printed.

Creating a Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 4. 

2 Click the Other Options tab, and click the Edit button in 
the Watermark section. The Edit Watermark window 
appears. 

3 Enter a text message in the Watermark Message box. 
You can enter up to 40 characters. The message displays 
in the preview window.

When the First Page Only box is checked, the watermark 
prints on the first page only.

4 Select watermark options. 

You can select the font name, style, size, or grayscale 
level from the Font Attributes section and set the angle 
of the watermark from the Message Angle section. 

5 Click Add to add a new watermark to the list.   

6 When you have finished editing, click OK and start 
printing. 

To stop printing the watermark, select (No Watermark) from 
the Watermark drop-down list. 

Editing a Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 4. 

2 Click the Other Options tab and click the Edit button in 
the Watermark section. The Edit Watermark window 
appears.

3 Select the watermark you want to edit from the Current 
Watermarks list and change the watermark message and 
options. 

4 Click Update to save the changes.

5 Click OK until you exit the Print window. 

Deleting a Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 4.

2 From the Other Options tab, click the Edit button in the 
Watermark section. The Edit Watermark window 
appears. 

3 Select the watermark you want to delete from the Current 
Watermarks list and click Delete. 

4 Click OK until you exit the Print window.
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Using Overlays

What is an Overlay?
An overlay is text and/or images stored in the computer’s hard 
disk drive (HDD) as a special file format that can be printed on 
any document. Overlays are often used to take the place of 
preprinted forms and letterhead paper. Rather than using 
preprinted letterhead, you can create an overlay containing the 
exact same information that is currently on your letterhead. To 
print a letter with your company’s letterhead, you do not need 
to load preprinted letterhead paper in the printer. You can use 
your printer to print the letterhead overlay on your document.

Creating a New Page Overlay
To use a page overlay, you must create a new page overlay 
containing your logo or image.

1 Create or open a document containing text or an image for 
use in a new page overlay. Position the items exactly as 
you wish them to appear when printed as an overlay.

2 To save the document as an overlay, access printer 
properties. See “Printing a Document” on page 4.

3 Click the Other Options tab, and click Edit button in the 
Overlay section. 

4 In the Edit Overlay window, click Create Overlay. 

5 In the Create Overlay window, type a name of up to 
eight characters in the File name box. Select the 
destination path, if necessary. (The default is 
C:\Formover).

6 Click Save. The name appears on the Overlay List box. 

7 Click OK or Yes to finish creating. 

The file is not printed. Instead it is stored on your 
computer hard disk drive. 

NOTE: The overlay document size must be the same as the 
documents you print with the overlay. Do not create an 
overlay with a watermark. 

WORLD BEST

Dear ABC

Regards

WORLD BEST

Using a Page Overlay
After an overlay has been created, it is ready to be printed with 
your document. To print an overlay with a document:

1 Create or open the document you want to print. 

2 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 4. 

3 Click the Other Options tab. 

4 Select the desired overlay from the Overlay drop-down 
list box. 

5 If the overlay file you want does not appear in the 
Overlay list, click Edit button and Load Overlay, and 
select the overlay file. 

If you have stored the overlay file you want to use in an 
external source, you can also load the file when you access 
the Load Overlay window. 

After you select the file, click Open. The file appears in the 
Overlay List box and is available for printing. Select the 
overlay from the Overlay List box. 

6 If necessary, click Confirm Page Overlay When 
Printing. If this box is checked, a message window 
appears each time you submit a document for printing, 
asking you to confirm your wish to print an overlay on 
your document. 

If this box is not checked and an overlay has been 
selected, the overlay automatically prints with your 
document. 

7 Click OK or Yes until printing begins. 

The selected overlay downloads with your print job and 
prints on your document. 

NOTE: The resolution of the overlay document must be the 
same as that of the document you will print with the overlay. 

Deleting a Page Overlay
You can delete page overlays that you no longer use. 

1 In the printer properties window, click the Other Options 
tab. 

2 Click the Edit button in the Overlay section. 

3 Select the overlay you want to delete from the Overlay 
List box. 

4 Click Delete Overlay. 

5 When a confirming message window appears, click Yes.

6 Click OK until you exit the Print window.
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4 Using Windows 
PostScript Driver
If you want to use the PostScript driver provided with your  
Drivers and Utilities CD to print a document.

PPDs, in combination with the PostScript driver, access printer 
features and allow the computer to communicate with the 
printer. An installation program for the PPDs is provided on the 
supplied Drivers and Utilities CD. 

Printer Settings
You can use the printer properties window, which allows you to 
access all of the printer options you need when using your 
printer. When the printer properties are displayed, you can 
review and change the settings needed for your print job. 

Your printer properties window may differ, depending on your 
operating system. This Software User’s Guide shows the 
Properties window for Microsoft® Windows® XP.

Your printer driver Properties window that appears in this 
User’s Guide may differ depending on the printer in use.

NOTES:
• Most Windows applications will override settings you specify 

in the printer driver. Change all print settings available in 
the software application first, and change any remaining 
settings using the printer driver. 

• The settings you change remain in effect only while you are 
using the current program. To make your changes 
permanent, make them in the Printers folder. 

• The following procedure is for Windows XP. For other 
Windows operating systems, see the corresponding Windows 
User's Guide or online help.
1. Click the Windows Start button.
2. Select Printers and Faxes.
3. Select your printer driver icon.
4. Right-click on the printer driver icon and select 

Printing Preferences.
5. Change the settings on each tab, click OK.

Advanced
You can use advanced settings by clicking the Advanced 
button. 

• Paper/Output this option allows you to select the size of the 
paper loaded in the tray.

• Graphic this option allows you to adjust the print quality for 
your specific printing needs.

• Document Options this options allow you to set the PostScript 
options or printer features.

Using Help
You can click  from the upper right corner of the window, and 
then click on any setting. 
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5 Sharing the Printer 
Locally
You can connect the printer directly to a selected computer, 
which is called “host computer,” on the network. 

The following procedure is for Microsoft® Windows® XP. For 
other Windows operating systems, see the corresponding 
Windows User's Guide or online help.

NOTE: 
• Check the Operating System(s) that are compatible with 

your printer. See the operating systems Compatibility 
section of Printer Specifications in your Printer User’s Guide.

• If you need to know the exact name of your printer, you can 
check the supplied Drivers and Utilities CD.

Setting Up a Host Computer

1 Start Windows. 

2 From the Start menu select Printers and Faxes. 

3 Double-click your printer driver icon. 

4 From the Printer menu, select Sharing. 

5 Check the Share this printer box.

6 Fill in the Shared Name field, and then click OK.

Setting Up a Client Computer 

1 Right-click the Windows Start button and select Explore.

2 Select My Network Places  and then right-click Search 
for Computers.

3 Fill in the IP address of host computer in Computer name 
field, and click Search. (In case host computer requires 
User name and Password, fill in User ID and password 
of host computer account.)

4 Double-click Printers and Faxes.

5 Right-click printer driver icon, select Connect.

6 Click Yes, if the installation confirm message appears.
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6 Scanning
Scanning with your machine lets you turn pictures and text into 
digital files on your computer. Then you can fax or e-mail the 
files, display them on your web site or use them to create 
projects that you can print using SmarThru software or the WIA 
driver.

This chapter includes:

• Smarthru Office

• Scanning Process with TWAIN-enabled Software

• Scanning Using the WIA Driver

NOTE: 
• Check the operating system(s) that are compatible 

with your printer. Please refer to the OS Compatibility 
section of Printer Specifications in your Printer User’s 
Guide.

• You can check your printer name in the supplied 
Drivers and Utilities CD.

• The maximum resolution that can be achieved 
depends upon various factors, including computer 
speed, available disk space, memory, the size of the 
image being scanned, and bit depth settings. Thus, 
depending on your system and what you are scanning, 
you may not be able to scan at certain resolutions, 
especially using enhanced dpi.

Smarthru Office
The supplied Drivers and Utilities CD provides you with 
SmarThru Office. SmarThru Office offers you convenient 
features to use with your machine. 

Starting SmarThru Office
Follow the steps below to start SmarThru Office:

1 Ensure that your printer and computer are turned on and 
properly connected to each other.

2 Once you have installed SmarThru Office, you will see 
the SmarThru Office icon on your desktop.

3 Double-click the SmarThru Office icon.

4 The SmarThru Office starts.
For more information, click Help → SmarThru Office help.

Quick Start Guide
This menu displays direct buttons for some features. The direct 
buttons include: Categories, Binder, Life Cycle, Scan and 
OCR, Fix and Enhance, and Dell Website. You can disable 
this menu by checking “Do not show this diaglog again”.

Using SmarThru Office

Scanning

1 Click scan icon.

NOTES: 

• In Microsoft® Windows® XP operating system, you can use 
SmarThru Office launcher, which is on the right end of 
taskbar, to easily open the Scan Setting window.

• In other operating systems beside Windows XP, click the 

SmarThru icon   in the tray area of the windows taskbar 
to activate the SmarThru Office launcher.
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2 Scan Setting window opens.

NOTE: Click Advanced button to set more scan options.

3 Set scan settings and click Scan. For more information, 
click Help → SmarThru Office help.

Send to

Email
You can send email while working on SmarThru Office.

NOTE: You need an email client program, such as Outlook 
Express, to send email in SmarThru Office. Procedure for 
sending email may differ depending on email client program 
you are using.

1 Select File → Send to → Send By E-mail.

2 An email client opens.

3 Type in necessary information and send your email.

1
Select 
Scanner

Allows you to select between the Local or 
Network scanner. 

2
Select 
Profile

Allows you to save settings frequently used 
for future use. Click New Profile to save the 
setting. 

3
Scan 
Settings

Allows you to customize settings for Scan 
Size and Paper Source.

4 Scan To
Allows you to customize settings for File 
Name and location to send scanned data.

Fax
You can send emails while working on SmarThru Office.

NOTE: You need an email client program, such as Outlook 
Express, to send email in SmarThru Office. Procedure for 
sending email may differ depending on email client program 
you are using.

1 Select File → Send to → Send By Fax.

2 Send Fax window opens.

3 Type in necessary information and click Send Fax.

NOTE: For more information about SmarThru Office, click 
Help → SmarThru Office help. The SmarThru Office Help 
window appears; you can view on screen help supplied on the 
SmarThru program.
Follow the steps below to uninstall SmarThru Office.  Before 
you begin the uninstall, ensure that all applications are closed 
on your computer.

a) From the Start menu, select Programs or All 
Programs.
b) Select SmarThru Office, and then select Uninstall 
SmarThru Office.
c) When your computer asks you to confirm your selection, 
read the statement and click OK.
d) Click Finish.
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Scanning Process with TWAIN-
enabled Software 
If you want to scan documents using other software, you will 
need to use TWAIN-compliant software, such as Adobe®  
Photoshop®.  The first time you scan with your machine, select 
it as your TWAIN source in the application you use. 

The basic scanning process involves a number of steps:

1 Ensure that your machine and computer are turned on and 
properly connected to each other.

2 Load the document(s) face up into the DADF.

OR

Place a single document face down on the document 
glass.

3 Open an application, such as Photoshop. 

4 Open the TWAIN window and set the scan options.

5 Scan and save your scanned image.

NOTE: You need to follow the program’s instructions for 
acquiring an image. See the user’s guide of the application.

Scanning Using the WIA Driver
Your machine also supports the Windows Image Acquisition 
(WIA) driver for scanning images. WIA is one of the standard 
components provided by Microsoft Windows XP and works 
with digital cameras and scanners. Unlike the TWAIN driver, the 
WIA driver allows you to scan and easily manipulate images 
without using additional software.

NOTE: The WIA driver works only on Windows XP/Vista with 
USB port. 

Windows XP
1 Load the document(s) face up into the DADF.

OR

Place a single document face down on the document glass.
2 From the Start menu on your desktop window, select 

Settings, Control Panel, and then Scanners and 
Cameras.

3 Double click your scanner driver icon. The Scanner and 
Camera Wizard launches.

4 Choose your scanning preferences and click Preview to 
see how your preferences affect the picture.

5 Click Next.

6 Enter a picture name, and select a file format and 
destination to save the picture.

7 Follow the on-screen instructions to edit the picture after it 
is copied to your computer.

Windows Vista

1 Load the document(s) face up into the DADF.     
OR
Place a single document face down on the document glass.

2 Click Start → Control Panel → Hardware and Sound →  
Scanners and Cameras. 

3 Click on Scan a document or picture. Then Windows 
Fax and Scan  application is opened automatically.

NOTE: 
• To view scanners, user can click on  View scanners and 

cameras. 
• If there is not Scan a document or picture, open the MS paint 

program and click From Scanner or Camera... on File menu. 

4 Click New Scan and then scan driver is opened.

5 Choose your scanning preferences and click Preview to 
see your preferences affect the picture.

6 Click Scan.

NOTE: If you want to  cancel the scan job, press the Cancel 
button on the Scanner and Camera Wizard.
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7 Using other software

Using the Dell™ Toner 
Management System
The printer status monitor displays the status of the printer 
(printer ready, printer offline, and error-check printer) and the 
toner level (100%, 50%, Toner Low) for your printer. 

Printer Status Monitor
The printer status monitor screen launches when you send a 
print job to the printer. This only appears on the computer 
screen. Depending on the remaining toner level, the launched 
printer status monitor screen is different.

If you are a Windows user, from the Start menu, select 
Programs → DELL → DELL Printers → your printer driver 
name → Printer Status Monitor.

• Printing Status: The Printer Status Monitor displays 
the current status of the printer.

• Toner Level: You can view the level of toner remaining 
in the toner cartridge.

• Order Supplies: Click to order replacement toner 
cartridges online.

• User’s Guide: Allows you to view the User’s Guide.

Printer Settings Utility
When you install the Dell software, the Printer Settings Utility 
is automatically installed. 

To open the Printer Settings Utility.

1 Click Start → Programs → DELL → DELL Printers → 
your printer driver name → Printer Settings Utility.

The Printer Settings Utility window opens.

2 The Printer Settings Utility window provides several 
features.

For more information, click the  button.

To use the default settings, click the Printer Default 
button and click Apply button.

To exit, click the Exit button at the bottom of the window.
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Dell Toner Re-order application
To order replacement toner cartridges or supplies from Dell:

1 Double-click the Dell Toner Reorder Program icon on your 
desktop. (Windows only)

OR

Click Start → Programs → DELL → DELL Printers → 
your printer driver name → Dell 2145cn MFP Toner 
Reorder.

2 The Dell 2145cn MFP Toner Reorder window opens.

Fireware Update Utility
You can printer Firmware Update Utility.

1 Click Start → Programs → DELL → DELL Printers → 
your printer driver name → Firmware Update Utility.

The Firmware Update Utility window opens.

Follow the on screen istructions to complete the firmware 
update.
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8 Using Your Printer in 
Linux 
You can use your machine in a Linux environment. 

This chapter includes:

• Getting Started

• Installing the Unified Linux Driver

• Using the Unified Driver Configurator

• Configuring Printer Properties

• Printing a Document

• Scanning a Document

Getting Started
The supplied Drivers and Utilities CD provides you with Dell’s 
Unified Linux Driver package for using your machine with a 
Linux computer.

Dell’s Unified Linux Driver package contains printer and scanner 
drivers, providing the ability to print documents and scan 
images. The package also delivers powerful applications for 
configuring your machine and further processing of the scanned 
documents.

After the driver is installed on your Linux system, the driver 
package allows you to monitor a number of machine devices via 
fast ECP parallel ports and USB simultaneously. 

The acquired documents can then be edited, printed on the 
same local or network machine devices, sent by e-mail, 
uploaded to an FTP site, or transferred to an external OCR 
system.

The Unified Linux Driver package is supplied with a smart and 
flexible installation program. You do not need to search for 
additional components that might be necessary for the Unified 
Linux Driver software: all required packages will be carried onto 
your system and installed automatically; this is possible on a 
wide set of the most popular Linux clones.

Installing the Unified Linux 
Driver

Installing the Unified Linux Driver
1 Ensure that you connect your machine to your computer. 

Turn both the computer and the machine on.
2 When the Administrator Login window appears, type in 

root in the Login field and enter the system password.

NOTE: You must log in as a super user (root) to install the 
printer software. If you are not a super user, ask your system 
administrator.

3 Insert the printer Drivers and Utilities CD. The CD will 
automatically run.

If the CD does not automatically run, click the  icon at 
the bottom of the desktop. When the Terminal screen 
appears, type in:

If the CD-ROM is secondary master and the location to 
mount is /mnt/cdrom,
[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/
cdrom
[root@localhost root]#cd /mnt/cdrom/Linux
[root@localhost root]#./install.sh 

If you still failed to run the Drivers and Utilities CD, type 
the followings in sequence:
[root@localhost root]#umount /dev/hdc
[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/
cdrom

NOTE: The installation program runs automatically if you 
have an autorun software package installed and configured.

4 When the welcome screen appears, click Next.
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5 When the installation is complete, click Finish.

The installation program has added the Unified Driver 
Configurator desktop icon and Dell Unified Driver group 
to the system menu for your convenience. If you have 
any difficulties, consult the onscreen help that is available 
through your system menu or can otherwise be called 
from the driver package windows applications, such as 
Unified Driver Configurator or Image Manager.

NOTE: Installing the driver in the text mode:

• If you do not use the graphical interface or have failed the 
driver installation, you have to use the driver in the text 
mode.

• Follow the step 1 to 3, then type [root@localhost Linux]# ./
install.sh, then follow the instruction on the terminal screen. 
Then the installation completes.

• When you wan to uninstall the driver, follow the installation 
instruction above, but type [root@localhost Linux]# ./
uninstall.sh on the terminal screen.

Uninstalling the Unified Linux Driver
1 When the Administrator Login window appears, type in 

root in the Login field and enter the system password.

NOTE: You must log in as a super user (root) to uninstall the 
printer software. If you are not a super user, ask your system 
administrator.

2 Insert the printer Drivers and Utilities CD. The CD will 
automatically run.

If the CD does not automatically run, click the  icon at 
the bottom of the desktop. When the Terminal screen 
appears, type in:

If the CD-ROM is secondary master and the location to 
mount is /mnt/cdrom,

[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/
cdrom

[root@localhost root]#cd /mnt/cdrom/Linux

[root@localhost root]#./uninstall.sh 

NOTE: The installation program runs automatically if you 
have an autorun software package installed and configured.

3 Click Uninstall.

4 Click Next. 

5 Click Finish.
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Using the Unified Driver 
Configurator
Unified Linux Driver Configurator is a tool primarily intended for 
configuring Printer or MFP devices. Since an MFP device 
combines the printer and scanner, the Unified Linux Driver 
Configurator provides options logically grouped for printer and 
scanner functions. There is also a special MFP port option 
responsible for the regulation of access to an MFP printer and 
scanner via a single I/O channel.

After installing the Unified Linux driver, the Unified Linux Driver 
Configurator icon will automatically be created on your desktop.

Opening the Unified Driver 
Configurator
1 Double-click Unified Driver Configurator on the 

desktop.

You can also click the Startup Menu icon and select Dell 
Unified Driver and then Unified Driver Configurator.

2 Press each button on the Modules pane to switch to the 
corresponding configuration window.   

Printers Configuration button

Scanners Configuration button

Ports Configuration button

You can use the onscreen help by clicking Help.
3 After changing the configurations, click Exit to close the 

Unified Driver Configurator.

Printers Configuration button

Ports Configuration button
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Printers Configuration
Printers configuration has the two tabs: Printers and Classes. 

Printers Tab
You can see the current system’s printer configuration by 
clicking on the printer icon button on the left side of the Unified 
Driver Configurator window.

You can use the following printer control buttons:

• Refresh: renews the available printers list.

• Add Printer: allows you to add a new printer.

• Remove Printer: removes the selected printer.

• Set as Default: sets the current printer as a default 
printer.

• Stop/Start: stops/starts the printer.

• Test: allows you to print a test page to check if the 
machine is working properly.

• Properties: allows you to view and change the printer 
properties. For details, see page 26.

Shows all of the 
installed printer.

Switches to Printer 
configuration.

Shows the status, 
model name and 
URI of your printer.

Classes Tab
The Classes tab shows a list of available printer classes.

• Refresh : Renews the classes list.

• Add Class... : Allows you to add a new printer class.

• Remove Class : Removes the selected printer class.

Scanners Configuration
In this window, you can monitor the activity of scanner devices, 
view a list of installed Dell MFP devices, change device 
properties, and scan images.

• Properties... : Allows you to change the scan properties 
and scan a document. See page 28.

Shows the status of the 
class and the number of 
printers in the class.

Shows all of the 
printer classes.

Switches to 
Scanners 
configuration. Shows all of the 

installed scanners.

Shows the vendor, 
model name and type 
of your scanner. 
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Ports Configuration
In this window, you can view the list of available ports, check 
the status of each port and release a port that is stalled in busy 
state when its owner is terminated for any reason.

• Refresh : Renews the available ports list.

• Release port : Releases the selected port.

Sharing Ports Between Printers and Scanners 
Your machine may be connected to a host computer via the 
parallel port or USB port. Since the MFP device contains more 
than one device (printer and scanner), it is necessary to 
organize proper access of “consumer” applications to these 
devices via the single I/O port.

The Dell Unified Linux Driver package provides an appropriate 
port sharing mechanism that is used by Dell printer and 
scanner drivers. The drivers address their devices via so-called 
MFP ports. The current status of any MFP port can be viewed 
via the Ports Configuration. The port sharing prevents you from 
accessing one functional block of the MFP device, while another 
block is in use.

When you install a new MFP device onto your system, it is 
strongly recommended you do this with the assistance of an 
Unified Driver Configurator. In this case you will be asked to 
choose I/O port for the new device. This choice will provide the 
most suitable configuration for MFP’s functionality. For MFP 
scanners I/O ports are being chosen by scanner drivers 
automatically, so proper settings are applied by default.

Switches to 
ports 
configuration.

Shows the port type, 
device connected to 
the port and status

Shows all of the 
available ports.

Configuring Printer Properties
Using the properties window provided by the Printers 
configuration, you can change the various properties for your 
machine as a printer.
1 Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.
2 Select your machine on the available printers list and click 

Properties.
3 The Printer Properties window opens.

The following five tabs display at the top of the window:
•General: allows you to change the printer location and 
name. The name entered in this tab displays on the 
printer list in Printers configuration.

•Connection: allows you to view or select another port. If 
you change the printer port from USB to parallel or vice 
versa while in use, you must re-configure the printer port 
in this tab.

•Driver: allows you to view or select another printer 
driver. By clicking Options, you can set the default 
device options.

•Jobs: shows the list of print jobs. Click Cancel job to 
cancel the selected job and select the Show completed 
jobs check box to see previous jobs on the job list.

•Classes: shows the class that your printer is in. Click 
Add to Class to add your printer to a specific class or 
click Remove from Class to remove the printer from the 
selected class.

4 Click OK to apply the changes and close the Printer 
Properties Window.
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Printing a Document

Printing from Applications
There are a lot of Linux applications that you are allowed to 
print from using Common UNIX Printing System (CUPS). You 
can print on your machine from any such application.
1 From the application you are using, select Print from the 

File menu.
2 Select Print directly using lpr.

3 In the LPR GUI window, select the model name of your 
machine from the Printer list and click Properties.

4 Change the printer and print job properties.

Click.

The following four tabs display at the top of the window.
•General - allows you to change the paper size, the paper 
type, and the orientation of the documents, enables the 
duplex feature, adds start and end banners, and changes 
the number of pages per sheet.

•Text - allows you to specify the page margins and set the 
text options, such as spacing or columns.

•Graphics - allows you to set image options that are used 
when printing images/files, such as color options, image 
size, or image position.

•Device: allows you to set the print resolution, paper 
source, and destination.

5 Click Apply to apply the changes and close the Properties 
window. 

6 Click OK in the LPR GUI window to start printing.

7 The Printing window appears, allowing you to monitor the 
status of your print job.

To abort the current job, click Cancel.

Printing Files
You can print many different types of files on the Dell machine 
device using the standard CUPS way - directly from the 
command line interface. The CUPS lpr utility allows you do that. 
But the drivers package replaces the standard lpr tool by a 
much more user-friendly LPR GUI program.

To print any document file:
1 Type lpr <file_name> from the Linux shell command 

line and press Enter. The LPR GUI window appears.

When you type only lpr and press Enter, the Select 
file(s) to print window appears first. Just select any files 
you want to print and click Open. 

2 In the LPR GUI window, select your printer from the list, 
and change the printer and print job properties.

For details about the properties window, see page 27.
3 Click OK to start printing.
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Scanning a Document
You can scan a document using the Unified Driver Configurator 
window.
1 Double-click the Unified Driver Configurator on your 

desktop.

2 Click the  button to switch to Scanners Configuration.

3 Select the scanner on the list. 

When you have only one MFP device and it is connected 
to the computer and turned on, your scanner appears on 
the list and is automatically selected.

If you have two or more scanners attached to your 
computer, you can select any scanner to work at any 
time. For example, while acquisition is in progress on the 
first scanner, you may select the second scanner, set the 
device options and start the image acquisition 
simultaneously.

4 Click Properties.

5 Load the document to be scanned face up into the ADF 
(Automatic Document Feeder) or face down on the 
document glass.

6 Click Preview in the Scanner Properties window.

Click your 
scanner.

The document is scanned and the image preview appears 
in the Preview Pane.

7 Change the scan options in the Image Quality and Scan 
Area sections.
•Image Quality: allows you to select the color 
composition and the scan resolution for the image.

•Scan Area: allows you to select the page size. The 
Advanced button enables you to set the page size 
manually.

If you want to use one of the preset scan option settings, 
select from the Job Type drop-down list. For details about 
the preset Job Type settings, see page 29.

You can restore the default setting for the scan options 
by clicking Default.

8 When you have finished, click Scan to start scanning.

The status bar appears on the bottom left of the window 
to show you the progress of the scan. To cancel scanning, 
click Cancel.

9 The scanned image appears in the new Image Manager 
tab.

If you want to edit the scanned image, use the toolbar. 
For further details about editing an image, see page 29.

Drag the pointer to 
set the image area 
to be scanned.
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10When you are finished, click Save on the toolbar.

11Select the file directory where you want to save the image 
and enter the file name. 

12Click Save.

Adding Job Type Settings
You can save your scan option settings to retrieve for a later 
scanning.

To save a new Job Type setting:
1 Change the options from the Scanner Properties window.

2 Click Save As.

3 Enter the name for your setting.

4 Click OK. 

Your setting is added to the Saved Settings drop-down 
list.

To save a Job Type setting for the next scan job:
1 Select the setting you want to use from the Job Type drop-

down list.
2 The next time you open the Scanner Properties window, 

the saved setting is automatically selected for the scan 
job.

To delete a Job Type setting:
1 Select the setting you want to delete from the Job Type 

drop-down list.
2 Click Delete.

The setting is deleted from the list

Using the Image Manager
The Image Manager application provides you with menu 
commands and tools to edit your scanned image.

Use these tools to 
edit the image.

You can use the following tools to edit the image:

For further details about the Image Manager application, refer 
to the onscreen help.

Tools Function

Saves the image.

Cancels your last action.

Restores the action you canceled.

Allows you to scroll through the image.

Crops the selected image area.

Zooms the image out.

Zooms the image in.

Allows you to scale the image size; you can 
enter the size manually, or set the rate to 
scale proportionally, vertically, or 
horizontally.

Allows you to rotate the image; you can 
select the number of degrees from the drop-
down list.

Allows you to flip the image vertically or 
horizontally. 

Allows you to adjust the brightness or 
contrast of the image, or to invert the 
image.

Shows the properties of the image.
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9 Using Your Printer with 
a Macintosh
Your printer supports Macintosh systems with a built-in USB 
interface or 10/100 Base-TX network interface card. When you 
print a file from a Macintosh computer, you can use the driver by 
installing the PPD file. 

NOTE: Some printers do not support a network 
interface. Ensure that your printer supports a network 
interface by referring to Printer Specifications in your 
Printer User’s Guide.

This chapter includes:

• Installing Software

• Uninstalling software

• Setting Up the Printer

• Printing

• Scanning

Installing Software
The Drivers and Utilities CD that came with your printer 
provides you with the PPD file that allows you to use the CUPS 
driver or Apple LaserWriter driver (only available when you 
use a printer which supports the PostScript driver), for 
printing on a Macintosh computer. 

Also, it provides you with the Twain driver for scanning on a 
Macintosh computer.

1 Ensure that you connect your printer to the computer. Turn 
on your computer and printer.

2 Insert the Drivers and Utilities CD which came with your 
printer into the computer’s optical drive.

3 Double-click CD icon that appears on your Macintosh 
desktop.

4 Double-click the MAC_Installer folder.

5 Double-click the Installer OS X icon.

6 Enter the password and click OK.

7 The Dell Installer window opens. Click Continue

8 Select Easy Install and click Install. Easy Install is 
recommended for most users. All components necessary 
for printer operations will be installed. 
If you select Custom Install, you can choose individual 
components to install.

9 The message which warns all application will close on your 
computer appears, Click Continue.

10Select Typical installation for a local printer and then 
click OK.

11After the installation is finished, click Quit.

NOTE: 

• If you have installed scan driver, click Restart.
• After the installation is finished, see “Setting Up the Printer” 

on page 31

Uninstalling software
Uninstall is required if you are upgrading the software, or if 
installation fails.
1 Ensure that you connect your printer to the computer. Turn 

on your computer and printer.
2 Insert the Drivers and Utilities CD which came with your 

printer into the computer’s optical drive.
3 Double-click CD icon that appears on your Macintosh 

desktop.
4 Double-click the MAC_Installer folder.

5 Double-click the Installer OS X icon.

6 Enter the password and click OK.

7 The Dell Installer window opens. Click Continue

8 Select Uninstall and click Uninstall. 

9 The message which warns all application will close on your 
computer appears, Click Continue.

10When the uninstallation is done, click Quit.



Using Your Printer with a Macintosh
31

Setting Up the Printer 
Set up for your printer will be different depending on which 
cable you use to connect the printer to your computer—the 
network cable or the USB cable.

For a Network-connected Macintosh

NOTE: Some printers do not support a network interface. 
Before connecting your printer, ensure that your printer 
supports a network interface by referring to Printer 
Specifications in your Printer User’s Guide.

1 Follow the instructions on “Installing Software” on page 30 
to install the PPD file on your computer.

2 Open the Applications folder → Utilities, and Print 
Setup Utility.

•For MAC OS 10.5, open System Preferences from the 
Applications folder, and click Printer & Fax.

3 Click Add on the Printer List.

• For MAC OS 10.5, press the “+” icon then a display 
window will pop up. 

4 For MAC OS 10.3, select the Rendezvous tab. 

• For MAC OS 10.4, click Default Browser and find the 
Bonjour.

• For MAC OS 10.5, click Default and find the Bonjour.

The name of your machine appears on the list. Select 
DELL000xxxxxxxxx from the printer box, where the 
xxxxxxxxx varies depending on your machine.

5 For MAC OS 10.3, if Auto Select does not work properly, 
select Dell in Printer Model and your printer name in 
Model Name. 

• For MAC OS 10.4, if Auto Select does not work properly, 
select Dell in Print Using and your printer name in 
Model. 

• For MAC OS 10.5, if Auto Select does not work properly, 
select Select a driver to use... and your printer name 
in Print Using. 

Your machine appears on the Printer List and is set as the 
default printer.

6 Click Add.

For a USB-connected

1 Follow the instructions on “Installing Software” on page 30 
to install the PPD file on your computer.

2 Open the Applications folder → Utilities, and Print 
Setup Utility.

• For MAC OS 10.5, open System Preferences from the 
Applications folder, and click Printer & Fax.

3 Click Add on the Printer List.

• For MAC OS 10.5, press the “+” icon then a display 
window will pop up. 

4 For MAC OS 10.3, select the USB tab. 

• For MAC OS 10.4, click Default Browser and find the 
USB connection.

• For MAC OS 10.5, click Default and find the USB 
connection.

5 Select your printer name.

6 For MAC OS 10.3, if Auto Select does not work properly, 
select Dell in Printer Model and your printer name in 
Model Name. 

• For MAC OS 10.4, if Auto Select does not work properly, 
select Dell in Print Using and your printer name in 
Model. 

• For MAC OS 10.5, if Auto Select does not work properly, 
select Select a driver to use... and your printer name 
in Print Using. 

Your machine appears on the Printer List and is set as the 
default printer.

7 Click Add.
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Printing 

NOTES: 
• The Macintosh printer’s properties window that appears in 

this User’s Guide may differ depending on the printer in use. 
However the composition of the printer properties window is 
similar.

• You can check your printer name in the supplied 
Drivers and Utilities CD.

Printing a Document
When you print with a Macintosh, you need to check the printer 
software setting in each application you use. Follow these steps 
to print from a Macintosh.

1 Open a Macintosh application and select the file you want 
to print.

2 Open the File menu and click Page Setup (Document 
Setup in some applications). 

3 Choose your paper size, orientation, scaling, and other 
options and click OK.

4 Open the File menu and click Print.

5 Choose the number of copies you want and indicate which 
pages you want to print. 

6 Click Print when you finish setting the options.

▲ Mac OS 10.5

Make sure that your 
printer is selected.

Changing Printer Settings
You can use advanced printing features when using your 
printer.

From your Macintosh application, select Print from the File 
menu. The printer name which appears in the printer properties 
window may differ depending on the printer in use. Except for 
the name, the composition of the printer properties window is 
similar.

NOTES: The setting options may differ depending on printers 
and Macintosh OS version.

Layout
The Layout tab provides options to adjust how the document 
appears on the printed page. You can print multiple pages on 
one sheet of paper. Select Layout from the Presets drop-down 
list to access the following features.

•Pages per Sheet: This feature determines how many 
pages printed on one page. For details, see "Printing 
Multiple Pages on One Sheet of Paper" on the next 
column.

•Layout Direction: You can select the printing direction 
on a page as like the examples on UI.

▲ Mac OS 10.5
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Graphics
The Graphics tab provides options for selecting Quality and 
Color Mode. Select Graphics form the Presets' drop-down 
list to access the graphic features.

•Quality: You can select the printing resolution. The 
higher the setting, the sharper the clarity of printed 
characters and graphics. The higher setting also may 
increase the time it takes to print a document.

•Color Mode: You can set the color options. Setting to 
Color typically produces the best possible print quality 
for color documents. If you want to print a color 
document in grayscale, select Grayscale.

Paper
Set Paper Type to correspond to the paper loaded in the tray 
from which you want to print. This will let you get the best 
quality printout. If you load a different type of print material, 
select the corresponding paper type.

▲ Mac OS 10.5

▲ Mac OS 10.5

Printing Multiple Pages on One Sheet 
of Paper
You can print more than one page on a single sheet of paper. 
This feature provides a cost-effective way to print draft pages.

1 From your Macintosh application, select Print from the 
File menu. 

2 Select Layout.

3 Select the number of pages you want to print on one sheet 
of paper on the Pages per Sheet drop-down list.

4 Select the page order from the Layout Direction option.

To print a border around each page on the sheet, select 
the option you want from the Border drop-down list.

5 Click Print, and the printer prints the selected number of 
pages on one side of each page.

▲ Mac OS 10.5
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Scanning 
You can scan docoments using Image Capture program. 
Macintosh OS offers Image Capture program.  

Scanning with USB

1 Ensure that your machine and computer are turned on and 
properly connected to each other.

2 Place a single document face down on the document glass. 
OR load the document(s) face up into the ADF (or DADF).

3 Start Applications and click Image Capture.

NOTE: If No Image Capture device connected message 
appears, disconnect the USB cable and reconnect it. If the 
problem persists, please refer to the Image Capture’s help.

4 Set the scan options on this program.

5 Scan and save your scanned image.

NOTE: 
• For more information about using Image Capture, please 

refer to the Image Capture’s help.
• If you want to scan via the DADF, use TWAIN-comliant 

softwares.
• You can also scan using TWAIN-compliant softwares, such as 

Adobe® Photoshop®.
• Scan process differ according to TWAIN-compliant 

softwares. Please refer to the user’s guide of the software.
• If scanning does not operate in Image Capture, update 

Mac OS to the latest version. Image Capture operates 
propery in Mac OS X 10.3.9 or higher and Mac OS X 10.4.7 
or higher.
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